SIEMENS

SIMATIC

S7-200

Programmable Controller

System Manual

This manual has the order number:
6ES7298-8FA24-8BHO

Edition 09/2007
AS5E00307987-03

Preface, Contents

Product Overview

Getting Started

Installing the S7-200

PLC Concepts

Programming Concepts,
Conventions and Features

S7-200 Instruction Set

Communicating over a Network

Hardware Troubleshooting Guide
and Software Debugging Tools

Open Loop Motion Control with
the S7-200

Creating a Program for the
Modem Module

Using the USS Protocol Library to
Control a MicroMaster Drive

Using the Modbus Protocol
Library

Using Recipes

Using Data Logs

PID Auto-Tune and the PID
Tuning Control Panel

Appendices

Index

0o N O b WON =

— =k -
N = © ©

—t k| -k
o~ W



Safety Guidelines

This manual contains notices which you should observe to ensure your own personal safety, as
well as to protect the product and connected equipment. These notices are highlighted in the
manual by a warning triangle and are marked as follows according to the level of danger:

Danger

' Danger indicates an imminently hazardous situation which, if not avoided, will result in death or

serious injury.

Warning

' Warning indicates a potentially hazardous situation which, if not avoided, could result in death or

serious injury.

Caution

' Caution used with the safety alert symbol indicates a potentially hazardous situation which, if not

Caution

avoided, may result in minor or moderate injury.

Caution used without the safety alert symbol indicates a potentially hazardous situation which, if

not avoided, may result in property damage.

Notice

Notice indicates a potential situation which, if not avoided, may result in an undesirable result or

state.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment. Qualified
persons are defined as persons who are authorized to commission, to ground, and to tag circuits,
equipment, and systems in accordance with established safety practices and standards.

Correct Usage
Note the following:
Warning

This device and its components may only be used for the applications described in the catalog
or the technical descriptions, and only in connection with devices or components from other

manufacturers which have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and
installed correctly, and operated and maintained as recommended.

Trademarks

SIMATIC®, SIMATIC HMI® and SIMATIC NET® are registered trademarks of SIEMENS AG.

Some of other designations used in these documents are also registered trademarks; the owner’s rights may be
violated if they are used by third parties for their own purposes.

Copyright Siemens AG 2007 All rights reserved

The reproduction, transmission or use of this document or its contents is not
permitted without express written authority. Offenders will be liable for damages.
All rights, including rights created by patent grant or registration of a utility model
or design, are reserved.

Siemens AG

Bereich Automation and Drives
Geschaeftsgebiet Industrial Automation Systems
Postfach 4848, D- 90327 Nuernberg

Disclaimer of Liability

We have checked the contents of this manual for agreement with the hardware and
software described. Since deviations cannot be precluded entirely, we cannot
guarantee full agreement. However, the data in this manual are reviewed regularly
and any necessary corrections included in subsequent editions. Suggestions for
improvement are welcomed.

© Siemens AG 2007
Technical data subject to change.

Siemens Aktiengesellschaft

6ES7298-8FA24-8BHO



Preface

Purpose of the manual

The S7-200 series is a line of micro-programmable logic controllers (Micro PLCs) that can control
a variety of automation applications. Compact design, low cost, and a powerful instruction set
make the S7-200 a perfect solution for controlling small applications. The wide variety of S7-200
models and the Windows-based programming tool give you the flexibility you need to solve your
automation problems.

This manual provides information about installing and programming the S7-200 Micro PLCs and
is designed for engineers, programmers, installers, and electricians who have a general
knowledge of programmable logic controllers.

Required Basic Knowledge

To understand this manual, it is necessary to have a general knowledge of automation and
programmable logic controllers.

Scope of the Manual

This manual is valid for STEP 7-Micro/WIN, version 4.0 and the S7-200 CPU product family. For
a complete list of the S7-200 products and order numbers described in this manual, see
Appendix A.

Changes compared to the previous version
This manual has been revised to include the following.

u
u

S7-200 CPU: New S7-200 CPU 224XPsi DC/DC/DC, 14 Inputs/10 Outputs
S7-200 expansion modules:

New Digital Expansion Modules: EM 223 24 VDC Digital Combination 32 Inputs/32 Outputs
and EM 223 24 VDC Digital Combination 32 Inputs/32 Relay Outputs

New High Density Expansion Modules: EM 232 Analog Output, 4 Outputs, EM 231 Analog
Input, 8 Inputs

STEP 7-Micro/WIN, version 4.0, programming software package for the S7-200. New and
improved tools that include:

Operating System: Microsoft Vista is now supported

LAD and FBD Program Editor Improvements: Automatic Symbol Name Completion, Drag
and Drop Symbol Names and New Shortcut Keys for Symbol Names

Communications Setup: If a USB cable is detected the first time STEP 7-Micro/WIN is
started, the USB communication is now automatically selected.

Libraries:

With Modbus RTU Master Libraries you can now create a Modbus RTU network using Port
0 or Port 1. The S7-200 acts as a Master or Slave on a Modbus RTU network.

USS Library for either Port 0 or Port 1 (CPU 22XP and CPU 226) is now available. This
allows you to use the USS communications on Port 1 and reserve Port O for PPI
communications or Freeport communications.

Password protection: There is now a level 4 password protection to provide more security
for the intellectual property of the program author.

Text Display Wizard: The Text Display wizard now supports the TD400C device.
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Certification
The SIMATIC S7-200 products have the following certification:

1 Underwriters Laboratories, Inc. UL 508 Listed (Industrial Control Equipment),
Registration number E75310

1 Canadian Standards Association: CSA C22.2 Number 142 (Process Control Equipment)

1 Factory Mutual Research: Class Number 3600, Class Number 3611, FM Class I, Division 2,
Groups A, B, C, & D Hazardous Locations, T4A and Class |, Zone 2, IIC, T4

Tip
@ The SIMATIC S7-200 series meets the CSA standard.

The cULus logo indicates that the S7-200 has been examined and certified by Underwriters
Laboratories (UL) to standards UL 508 and CSA 22.2 No. 142.

CE Labeling

The SIMATIC S7-200 products fulfill the requirements and protection guidelines of the following
EU directives:

1 EC Directive 73/23/EEC “Low-voltage directive”
1 EC Directive 89/336/EEC “EMC directive”
(1 EG Directive 94/9/EG “ATEX”

Consult your local Siemens representative regarding product compliance for the European
Community ATEX Directive 94/9/EC.

C-Tick
The SIMATIC S7-200 products are compliant with requirements of the AS/NZS 2064 (Australian)

standard.

Standards:

The SIMATIC S7-200 products fulfill the requirement and criteria of IEC 61131-2, Programmable
controllers - Equipment requirements.

Refer to Appendix A for additional compliance information.
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Place of this Documentation in the Information Environment

Product .
Family Documentation Order Number
S7-200 | S7-200 Point-to-Point Interface Communication Manual (English/German) | 6ES7 298-8GA00-8XH0

SIMATIC Text Display User Manual (included on the STEP 7-Micro/WIN
documentation CD)

HMI device OP 73micro, TP 177micro (WinCC Flexible) Operating
Instructions (English)

SIMATIC HMI WinCC flexible 2005 Micro User’s Manual (English)
SIMATIC NET CP 243-2 AS-Interface Master Manual (English)

SIMATIC NET CP 243-1 Communications processor of Industrial Ethernet
Technical Manual (English)

SIMATIC NET CP 243-1 IT Communications Processor of Industrial
Ethernet and Information Technology Technical Manual (English)

SIMATIC NET S7Beans / Applets for IT-CPs Programming Tips (English)

SIMATIC NET GPRS/GSM-Modem SINAUT MD720-3 System manual
(English)

SIMATIC NET SINAUT MICRO SC System manual (English)
SIWAREX MS Device Manual (English) (included with device)
S7-200 Programmable Controller System Manual (English)

none

6AV6 691-1DF01-0ABO

6AV6 691-1AA01-0ABO
6GK7 243-2AX00-8BA0
J31069-D0428-U001-A2-7618

J31069-D0429-U001-A2-7618

C79000-G8976-C180-02
C79000-G8976-C211

C79000-G8900-C210
none
6ES7 298-8FA24-8BHO
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Finding Your Way

If you are a first-time user of S7-200 Micro PLCs, you should read the entire S7-200
Programmable Controller System Manual. If you are an experienced user, refer to the table of
contents or index to find specific information.

The S7-200 Programmable Controller System Manual is organized according to the following
topics:

1 Chapter 1 (Product Overview) provides an overview of some of the features of the S7-200
family of Micro PLC products.

Chapter 2 (Getting Started) provides a tutorial for creating and downloading a sample
control program to an S7-200.

Chapter 3 (Installing the S7-200) provides the dimensions and basic guidelines for installing
the S7-200 CPU modules and expansion 1/O modules.

Chapter 4 (PLC Concepts) provides information about the operation of the S7-200.

Chapter 5 (Programming Concepts, Conventions, and Features) provides information about
the features of STEP 7-Micro/WIN, the program editors and types of instructions
(IEC 1131-3 or SIMATIC), S7-200 data types, and guidelines for creating programs.

Chapter 6 (S7-200 Instruction Set) provides descriptions and examples of programming
instructions supported by the S7-200.

1 Chapter 7 (Communicating over a Network) provides information for setting up the different
network configurations supported by the S7-200.

1 Chapter 8 (Hardware Troubleshooting Guide and Software Debugging Tools) provides
information for troubleshooting problems with the S7-200 hardware and about the
STEP 7-Micro/WIN features that help you debug your program.

1 Chapter 9 (Open Loop Motion Control with the S7-200) provides information about three
methods of open loop motion control: Pulse Width Modulation, Pulse Train Output, and the
EM 253 Position Control Module.

1 Chapter 10 (Creating a Program for the Modem Module) provides information about the
instructions and wizard used to create a program for the EM 241 Modem module.

Chapter 11 (Using the USS Protocol Library to Control a MicroMaster Drive) provides
information about the instructions used to create a control program for a MicroMaster drive.
It also provides information about how to configure the MicroMaster 3 and MicroMaster 4
drives.

Chapter 12 (Using the Modbus Protocol Library) provides information about the instructions
used to create a program that uses the Modbus protocol for communications.

oo o oo

U

U

Chapter 13 (Using Recipes) provides information about organizing and loading automation
program recipes in the memory cartridge.

Chapter 14 (Using Data Logs) provides information about storing process measurement
data in the memory cartridge.

Chapter 15 (PID Auto-Tune and the PID Tuning Control Panel) provides information about
using these features to greatly enhance the utility and ease of use of the PID function
provided by the S7-200.

1 Appendix A (Technical Specifications) provides the technical information and data sheets
about the S7-200 hardware.

The other appendices provide additional reference information, such as descriptions of the error
codes, descriptions of the Special Memory (SM) area, part numbers for ordering S7-200
equipment, and STL instruction execution times.

O o o o

In addition to this manual, STEP 7-Micro/WIN provides extensive online help for getting started
with programming the S7-200. Included with the purchase of the STEP 7-Micro/WIN software is a
free documentation CD. On this CD you can find application tips, an electronic version of this
manual and other information.
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Online Help

Help is only a keystroke away! Pressing F1 accesses the extensive online help for
STEP 7-Micro/WIN. The online help includes useful information about getting started with
programming the S7-200, as well as many other topics.

Electronic Manual

An electronic version of this S7-200 System Manual is available on the documentation CD. You
can install the electronic manual onto your computer so that you can easily access the information
in the manual while you are working with the STEP 7-Micro/WIN software.

Programming Tips

The documentation CD includes Programming Tips, a set of application examples with sample
programs. Reviewing or modifying these examples can help you find efficient or innovative
solutions for your own application. You can also find the most current version of Programming Tips
on the S7-200 Internet site.

Recycling and Disposal

Please contact a company certified in the disposal of electronic scrap for environmentally safe
recycling and disposal of your device.

Additional Support

Local Siemens Sales Office or Distributor

For assistance in answering any technical questions, for training on the S7-200 products, or for
ordering S7-200 products, contact your Siemens distributor or sales office. Because your sales
representatives are technically trained and have the most specific knowledge about your
operations, process and industry, as well as about the individual Siemens products that you are
using, they can provide the fastest and most efficient answers to any problems that you might
encounter.

Service & Support on the Internet
In addition to our documentation, we offer our Know-how online on the Internet at:

http://www.siemens.com/automation/service&support

where you will find the following:

O www.siemens.com/S7-200 for S7-200 product information

The S7-200 Internet site includes frequently asked questions (FAQs), Programming Tips
(application examples and sample programs), information about newly released products,
and product updates or downloads.

The newsletter, which constantly provides you with up-to-date information on your products.
The right documents via our Search function in Service & Support.

A forum, where users and experts from all over the world exchange their experiences.

I I W

Your local representative for Automation & Drives.

1 Information on field service, repairs, spare parts and more under “Services”.

Technical Services

The highly trained staff of the S7-200 Technical Services center is also available to help you solve
any problems that you might encounter. You can call on them 24 hours a day, 7 days a week.

Vii
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A&D Technical Support

Worldwide, available 24 hours a day:

Technical Support

Worldwide (Nuernberg)
Technical Support

24 hours a day, 365 days a year
Phone:  +49 (180) 5050-222
+49 (180) 5050-223
mailto:adsupport@siemens.com
GMT: +1:00

Fax:

Europe / Africa (Nuernberg)
Authorization

Local time: Mon.-Fri.
8:00 AM to 5:00 PM
+49 (180) 5050-222
+49 (180) 5050-223

mailto:adsupport@siemens.com
GMT: +1:00

Phone:
Fax:

United States (Johnson City)

Technical Support and
Authorization

Local time: Mon.-Fri.
8:00 AM to 5:00 PM

Phone:  +1 (423) 262 2522
+1 (800) 333-7421 (USA only)
Fax: +1 (423) 262 2289

mailto:simatic.hotline@sea.siemens.com
GMT: -5:00

Asia / Australia (Beijing)
Technical Support and
Authorization

Local time: Mon.-Fri.
8:00 AM to 5:00 PM

+86 1064 757575
+86 10647474 74

mailto:adsupport.asia@siemens.com
GMT: +8:00

Phone:
Fax:

The languages of the SIMATIC Hotlines and the authorization hotline are generally German and English.

viii
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Product Overview

The S7-200 series of micro-programmable logic controllers (Micro PLCs) can control a wide
variety of devices to support your automation needs.

The S7-200 monitors inputs and changes outputs as controlled by the user program, which can
include Boolean logic, counting, timing, complex math operations, and communications with other
intelligent devices. The compact design, flexible configuration, and powerful instruction set
combine to make the S7-200 a perfect solution for controlling a wide variety of applications.

In This Chapter

WAt s NeW 7
S7-200 CPU . .ot
S7-200 Expansion Modules . . ... .. ..
STEP 7-Micro/WIN Programming Package
Communications Options
Display Panels
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What’s New?

The new features of the SIMATIC S7-200 include the following.

1 S7-200 CPU: New S7-200 CPU 224XPsi DC/DC/DC, 14 Inputs/10 Outputs
1 New S7-200 Expansion modules:

New Digital Expansion Modules: EM 223 24 VDC Digital Combination 32 Inputs/32 Outputs
and EM 223 24 VDC Digital Combination 32 Inputs/32 Relay Outputs

New High Density Expansion Modules: EM 232 Analog Output, 4 Outputs, and EM 231
Analog Input, 8 Inputs

[ STEP 7-Micro/WIN, version 4.0, programming software package for the S7-200. New and
improved tools that include:

Operating System: Microsoft Vista is now supported

LAD and FBD Program Editor Improvements: Automatic Symbol Name Completion, Drag
and Drop Symbol Names and New Shortcut Keys for Symbol Names

Communications Setup: If a USB cable is detected the first time STEP 7-Micro/WIN is
started, the USB communication is now automatically selected.

Libraries:

With Modbus RTU Master Libraries you can now create a Modbus RTU network using
Port 0 or Port 1. The S7-200 acts as a Master or Slave on a Modbus RTU network.

USS Library for either Port 0 or Port 1 (CPU 22XP and CPU 226) is now available. This
allows you to use the USS communications on Port 1 and reserve Port O for PPI
communications or Freeport communications.

Password protection: There is now a level 4 password protection to provide more security
for the intellectual property of the program author.

Text Display Wizard: The Text Display wizard now supports the TD400C device.

S$7-200 CPU

The S7-200 CPU combines a microprocessor, an integrated power supply, input circuits, and
output circuits in a compact housing to create a powerful Micro PLC. See Figure 1-1. After you
have downloaded your program, the S7-200 contains the logic required to monitor and control the
input and output devices in your application.

Access door:

Status LEDs: - / Mode selector switch (RUN/STOP)

System Fault/Diagnostic Analog adjustment potentiometer(s)

gJ'QDlAG) \< \ = \ Expansion port (for most CPUs)

STOP

I/O LEDs

Terminal connector
(removable on CPU 224, CPU 224XP
and CPU 226)

Optional cartridge:
Memory Cartridge
Real-time Clock
Battery

Communications port Clip for installation on a standard (DIN) rail

Figure 1-1 S7-200 Micro PLC
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Siemens provides different S7-200 CPU models with a diversity of features and capabilities that
help you create effective solutions for your varied applications. Table 1-1 briefly compares some of
the features of the CPU. For detailed information about a specific CPU, see Appendix A.

Table 1-1 Comparison of the S7-200 CPU Models

Feature CPU 221 CPU 222 CPU 224 CPU 224XP CPU 226
Physical size (mm) 90x80x62 | 90x80x62 120.5x80x 62 | 140 x 80 x 62 190 x 80 x 62
Program memory:
with run mode edit 4096 bytes 4096 bytes 8192 bytes 12288 bytes 16384 bytes
without run mode edit | 4096 bytes 4096 bytes 12288 bytes 16384 bytes 24576 bytes
Data memory 2048 bytes 2048 bytes 8192 bytes 10240 bytes 10240 bytes
Memory backup 50 hours 50 hours 100 hours 100 hours 100 hours
typical typical typical typical typical
Local on-board 1/0
Digital 6 In/4 Out 8 In/6 Out 14 In/10 Out 14 In/10 Out 24 In/16 Out
Analog - - - 2 In/1 Out -
Expansion modules 0 modules 2 modules’ 7 modules? 7 modules? 7 modules?
High-speed counters
Single phase 4 at 30 kHz 4 at 30 kHz 6 at 30 kHz 4 at 30 kHz 6 at 30 kHz
2 at 200 kHz
Two phase 2 at 20 kHz 2 at 20 kHz 4 at 20 kHz 3 at20 kHz 4 at 20 kHz
1 at 100 kHz
Pulse outputs (DC) 2at20kHz | 2at20kHz 2 at20 kHz 2 at 100 kHz 2 at20 kHz
Analog adjustments 1 1 2 2 2
Real-time clock Cartridge Cartridge Built-in Built-in Built-in
Communications ports |1 RS-485 |1 RS-485 1 RS-485 2 RS-485 2 RS-485
Floating-point math Yes
Digital I/O image size 256 (128 in, 128 out)
Boolean execution 0.22 microseconds/instruction
speed

1 ‘You must calculate your power budget to determine how much power (or current) the S7-200 CPU can provide for your configuration. If the CPU
power budget is exceeded, you may not be able to connect the maximum number of modules. See Appendix A for CPU and expansion module
power requirements, and Appendix B to calculate your power budget.
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S$7-200 Expansion Modules

To better solve your application requirements, the S7-200 family includes a wide variety of

expansion modules. You can use these expansion modules to add additional functionality to the
S7-200 CPU. Table 1-2 provides a list of the expansion modules that are currently available. For
detailed information about a specific module, see Appendix A.

Table 1-2 S7-200 Expansion Modules
Expansion Type
Modules
Discrete modules
Input 8xDCIn 8 xAC In 16xDCIn
Output 4 x DC Out 4 x Relays 8 x Relay
8 x DC Out 8 x AC Out
Combination 4 xDC In/ 8xDC In/ 16 x DC In/ 32x DC In/
4 x DC Out 8 x DC Out 16 x DC Out 32 x DC Out
4xDCIn/ 8xDCIn/ 16 x DC In/ 32x DC In/
4 x Relay 8 x Relay 16 x Relay 32 x Relay
Analog modules
Input 4 x Analog In 8 x Analog In 4 x Thermocouple In
2xRTD In 2xRTD In
Output 2 x Analog Out | 4 x Analog Out
Combination 4 x Analog In

Intelligent modules

Other modules

4 x Analog Out

Position
Ethernet

AS-Interface

Modem
Ethernet IT

SIWAREX MS'

PROFIBUS-DP

1 Detailed information not included in Appendix A. Please refer to your module documentation.

STEP 7-Micro/WIN Programming Package

The STEP 7-Micro/WIN programming package provides a user-friendly environment to develop,
edit, and monitor the logic needed to control your application. STEP 7-Micro/WIN provides three
program editors for convenience and efficiency in developing the control program for your
application. To help you find the information you need, STEP 7-Micro/WIN provides an extensive
online help system and a documentation CD that contains an electronic version of this manual,
application tips, and other useful information.
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Computer Requirements

STEP 7-Micro/WIN runs on either a personal computer or a Siemens programming device, such
as a PG 760. Your computer or programming device should meet the following minimum
requirements:

2 GTEP 7 ranwIH 32 - Posgint]
T (i Ve PLC Doyl ks fiok

1 Operating system:

Windows 2000, Windows XP, Vista ~ 2=¢ 88 = =z@e= 8 =Es s s e
1 Atleast 350M bytes of free hard
disk space

1 Mouse (recommended)

|y I
| 7 7 e PN o
wrsem

e o | et b

Figure 1-2  STEP 7-Micro/WIN

Installing STEP 7-Micro/WIN

Insert the STEP 7-Micro/WIN CD into the CD-ROM drive of your computer. The installation wizard
starts automatically and prompts you through the installation process. Refer to the Readme file for
more information about installing STEP 7-Micro/WIN.

Tip
@ To install STEP 7-Micro/WIN on a Windows 2000, Windows XP, or Windows Vista operating
system, you must log in with Administrator privileges.

Communications Options

Siemens provides two programming options for connecting your computer to your S7-200: a direct
connection with a PPI Multi-Master cable, or a Communications Processor (CP) card with an MPI
cable.

The PPI Multi-Master programming cable is the most common and economical method of
connecting your computer to the S7-200. This cable connects the communications port of the
S7-200 to the serial communications of your computer. The PPI Multi-Master programming cable
can also be used to connect other communications devices to the S7-200.
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Display Panels

Text Display Units

The Text Display (TD) is a display device that can be connected to the S7-200. Using the Text
Display wizard, you can easily program your S7-200 to display text messages and other data
pertaining to your application.

The TD device provides a low cost interface to your application by allowing you to view, monitor,
and change the process variables pertaining to your application.

The S7-200 product family provides four TD devices:

[ TheTD100C has a 4-line text TD 100C
display with 2 font choices.

O The TD 200C has a 2-line text
display with 20 characters per line
for a total of 40 characters.

TD200C /
[d The TD 200 has a faceplate which / —— f}
¥

provides four keys with predefined, --‘Wﬂﬁﬂiﬁlﬁf

set-bit functions and allows up to
Text Display eight set-bit functions.

1 The TD400C can have a 2- or
4-line text display depending on Figure 1-3  Text Display Units
your font and character choice.

For more information about the Text Display Units, refer to the SIMATIC Text Display (TD) User
Manual on the STEP 7-Micro/WIN docuCD.

The Text Display wizard in STEP 7-Micro/WIN helps you configure Text Display messages
quickly and easily. To start the Text Display wizard, select the Tools > Text Display Wizard menu
command.

Operator and Touch Panel Displays

The OP 73micro and TP 177micro
panels are tailored to applications with

SIMATIC S7-200 Micro PLC and provide i SIATIC PAREL
operating and monitoring functions for e re———y |
small-scale machines and plants. Short p— e A
configuration and commissioning times, . - - . E -
and their configuration in WinCC flexible .

form the highlights of these panels. In
addition, these panels support up to 32
configuration languages and five online
languages, including the Asian and
Cyrillic character sets.

z
& |
o
g

TUtToEP 177A
SIMATIC PANEL 1t

TP 177micro

e [

The mounting dimensions of the
Operator Panel OP 73micro with its
graphical 3” display unit are compatible
with OP3 and TD 200.

Mok ATEMATIE

Touch Panel TP 177micro replaces the
Touch Panel TP 070/TP 170micro. It can

be mounted vertically to accommodate
additional applications. This feature
enables its use even when space is Figure 1-4 Operator and Touch Panel Displays
restricted.



Getting Started

STEP 7-Micro/WIN makes it easy for you to program your S7-200. In just a few short steps using
a simple example, you can learn how to connect, program, and run your S7-200.

All you need for this example is a PPl Multi-Master cable, an S7-200 CPU, and a programming
device running the STEP 7-Micro/WIN programming software.

In This Chapter

Connecting the S7-200 CPU ... ... i 8
Creating a Sample Program . . ... .. 10
Downloading the Sample Program . ......... .o 14
Placing the S7-200 in RUN Mode . ... ... e 14
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Connecting the S7-200 CPU

Connecting your S7-200 is easy. For this example, you only need to connect power to your
S7-200 CPU and then connect the communications cable between your programming device and
the §7-200 CPU.

Connecting Power to the S7-200 CPU

The first step is to connect the S7-200 to a power source. Figure 2-1 shows the wiring
connections for either a DC or an AC model of the S7-200 CPU.

Before you install or remove any electrical device, ensure that the power to that equipment has
been turned off. Always follow appropriate safety precautions and ensure that power to the
S7-200 is disabled before attempting to install or remove the S7-200.

Warning

' E Attempts to install or wire the S7-200 or related equipment with power applied could cause

* electric shock or faulty operation of equipment. Failure to disable all power to the S7-200 and
related equipment during installation or removal procedures could result in death or serious
injury to personnel, and/or damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200 is disabled
before attempting to install or remove the S7-200 or related equipment.

DC Installation
QOOD

F S

VDC 85 to 265 VAC
+

AC Installation

Figure 2-1 Connecting Power to the S7-200 CPU
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Connecting the RS-232/PPI Multi-Master Cable
Figure 2-2 shows an RS-232/PPI i P .
Multi-Master cable connecting the Dg/gi]éimmmg
S7-200 to the programming device. To
connect the cable:
S7-200

"

1. Connect the RS-232 connector
(marked “PC”) of the RS-232/PPI
Multi-Master cable to the
communications port of the
programming device. (For this
example, connect to COM 1.)

2. Connect the RS-485 connector
(marked “PPI") of the RS-232/PPI
Multi-Master cable to Port 0 or
Port 1 of the S7-200.

3. Ensure that the DIP switches of
the RS-232/PPI Multi-Master cable
are set as shown in Figure 2-2.

Tip

Examples in this manual use the RS-232/PPI Multi-Master cable. The RS-232/PPI Multi-Master

RS-232/PPI
Multi-Master Cable

o] Ja]u] Jufuls

123456 7 8|

™ -0n
10 - Off

Figure 2-2

cable replaces the previous PC/PPI cable. A USB/PPI Multi-Master cable is also available.

Refer to Appendix E for order numbers.

Starting STEP 7-Micro/WIN

Click on the STEP 7-Micro/WIN icon to
open a new project. Figure 2-3 shows a
new project.

Notice the navigation bar. You can use
the icons on the navigation bar to open
elements of the STEP 7-Micro/WIN
project.

Click on the Communications icon in the
navigation bar to display the
Communications dialog box. You use
this dialog box to set up the
communications for STEP 7-Micro/WIN.

Connecting the RS-232/PPI Multi-Master Cable

T L8 Vem PIE Dabg Tk weeises Hols
OF0 &0 P ERaxs L]k
bt Cllcl ABAR BE 3 2e= o)

3

Figure 2-3

New STEP 7-Micro/WIN Project
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Verifying the Communications Parameters for STEP 7-Micro/WIN

The example project uses the default settings for STEP 7-Micro/WIN and the RS-232/PPI
Multi-Master cable. To verify these settings:

1. Verify that the address of the
PC/PPI cable in the Lot " EE%PP\ cShIE[F‘PI]
Communications dialog box is set Remcte [ £ etk
t0 0. PLC Type: o Fiefresh

2. Verify that the interface for the B SromEpehms
network parameter is set for “etwork
PC/PP| cable(COM1 ) Interface: PCPPI cable(COM 1)

Protocal PRI
3. \Verify that the transmission rate is e 1o
Set tO 96 kbpS Highest Station (HSA) kil
7 Supports mutiple masters
If you need to change your A s
cc::ci]mmunications parameter settings, see 5 g T ’
apter 7.
p Set PGIPC Interface K Cancel
[ ][ e ]

Figure 2-4  Verifying the Communications Parameters

Establishing Communications with the S7-200

Use the Communications dialog box to connect with your S7-200 CPU:

1. Double-click the refresh icon in the
Communications dialog box. e . T 7 e
STEP 7-Micro/WIN searches for e o Q3 Dosbetick
the S7-200 station and displays a
CPU icon for the connected 7 Save sttngs wil prcject
S7-200 station. ~Hetwok
2. Select the S7-200 and click OK. ot e

Mode: -kt
Highesst Station (HEA) 3

If STEP 7-Micro/WIN does not find your
S§7-200 CPU, check the settings for the L
communications parameters and repeat Bowd Fote 96 kbps
these steps. ™ Search sl raes

Set PGIPC Interface o8 GCancel

7 Supports mutiple masters

After you have established
communications with the S7-200, you

are ready to create and download the Figure 2-5  Establishing Communications to the S7-200
example program.

Creating a Sample Program

10

Entering this example of a control program will help you understand how easy it is to use
STEP 7-Micro/WIN. This program uses six instructions in three networks to create a very simple,
self-starting timer that resets itself.

For this example, you use the Ladder (LAD) editor to enter the instructions for the program. The
following example shows the complete program in both LAD and Statement List (STL). The
network comments in the STL program explain the logic for each network. The timing diagram
shows the operation of the program.
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Example: Sample Program for getting started with STEP 7-Micro/WIN

Network 1 Network 1
ML 133
— ¢~ Tou
A0PT__ 10ms LDN MO0.0
TON T33,
Network 2
Network 2
T3 Q0.0
R
LDW>= T33
Network 3 = QOO
T3 MO0 Network 3
H )
LD T33
= MO0.0

Timing Diagram
current = 100

//10 ms timer T33 times out after
//(100 x 10 ms = 1 s) M0.0 pulse is
// too fast to monitor with Status view.

+100

//Comparison becomes true at a
/[rate that is visible with

//Status view. Turn on Q0.0 after
//(40x 10 ms = 0.4 s), for a

/] 40% OFF/60% ON waveform.

+40

//T33 (bit) pulse too fast to monitor with
//Status view. Reset the timer through
//IM0.0 after the (100 x 10 ms = 1 s) period.

current = 40 =
T33 (current) 0.4s; 0.6s :
T33 (bit)
MO0.0
Q0.0— | I

Opening the Program Editor

Click on the Program Block icon to open
the program editor. See Figure 2-6. QSS90

LI e

Notice the instruction tree and the
program editor. You use the instruction
tree to insert the LAD instructions into
the networks of the program editor by
dragging and dropping the instructions
from the instruction tree to the networks.

The toolbar icons provide shortcuts to
the menu commands.

After you enter and save the program,
you can download the program to the
S7-200.

T (8 Ve PC Detng Fack wiecses Hets

PRz R v RS B &L E

ABAR B2 3 -~ rall

Program editor

Instruction tree

) A1 )

Figure 2

-6

STEP 7-Micro/WIN Window

11
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12

Entering Network 1: Starting the Timer

When MO0.0 is off (0), this contact turns on and provides power flow to start the timer. To enter the
contact for M0.0:

1.

Either double-click the Bit Logic ORETTEIRC

icon orclick onthe plus sign (+)to  D#@én & ‘ma= D rEm @8
display the bit logic instructions. e

Select the Normally Closed Satonm
contact.

Hold down the left mouse button

and drag the contact onto the first

network.

Click on the “???” above the
contact and enter the following
address: M0.0 Ay [T T W

Press the Return key to enter the
address for the contact.

o ) breger Math

Figure 2-7  Network 1

To enter the timer instruction for T33:

—_

o & DN

o

Double-click the Timers icon to display the timer instructions.

Select the TON (On-Delay Timer).

Hold down the left mouse button and drag the timer onto the first network.

Click on the “???” above the timer box and enter the following timer number: T33

Press the Return key to enter the timer number and to move the focus to the preset time
(PT) parameter.

Enter the following value for the preset time: 100

Press the Return key to enter the value.

Entering Network 2: Turning the Output On

When the timer value for T33 is greater than or equal to 40 (40 times 10 milliseconds, or 0.4
seconds), the contact provides power flow to turn on output Q0.0 of the S7-200. To enter the
Compare instruction:

1.

Double-click the Compare icon to display the compare instructions. Select the >=I
instruction (Greater-Than-Or-Equal-To-Integer ).

Hold down the left mouse butt(?n L R
and drag the compare instruction  [0@@ &G &lo@E 2z B reR@ &L L6

onto the second network. Il imlonsasl o - «

Click on the “???” above the
contact and enter the address for
the timer value: T33

Press the Return key to enter the
timer number and to move the
focus to the other value to be
compared with the timer value.

Enter the following value to be s ok s———[1tn "
compared with the timer value: 40

Press the Return key to enter the Figure 2-8  Network 2
value.

To enter the instruction for turning on output Q0.0:

—_

P 0Dd

Double-click the Bit Logic icon to display the bit logic instructions and select the output coil.
Hold down the left mouse button and drag the coil onto the second network.
Click on the “???” above the coil and enter the following address: Q0.0

Press the Return key to enter the address for the coil.
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Entering Network 3: Resetting the Timer

When the timer reaches the preset value (100) and turns the timer bit on, the contact for T33 turns
on. Power flow from this contact turns on the M0.0 memory location. Because the timer is enabled
by a Normally Closed contact for M0.0, changing the state of M0.0 from off (0) to on (1) resets the
timer.

To enter the contact for the timer bit of | I

Fie Ed View AL Deteg Took Wirdken Heb
T33: NS00 =R« BwE ==t B[ e[ R e e
et L i 4T N W &
F.E

o[ s~

AP Irtedace

1. Select the Normally Open contact
from the bit logic instructions.

|

e

2. Hold down the left mouse button
and drag the contact onto the third
network.

3. Click on the “???” above the
contact and enter the address of
the timer bit: T33

4. Press the Return key to enter the ]
address for the contact. Figure 2-9  Network 3

To enter the coil for turning on M0.0:

1%
B

"
4
v
]

—_

Select the output coil from the bit logic instructions.
Hold down the left mouse button and drag the output coil onto the third network.

Double-click the “???” above the coil and enter the following address: M0.0

P Db

Press the Return key to enter the address for the coil.

Saving the Sample Project

After entering the three networks of instructions, you have finished entering the program. When
you save the program, you create a project that includes the S7-200 CPU type and other
parameters. To save the project:

1. Select the File > Save As menu Save As ]
command from the menu bar. Save i | 3 Frojects =l & & ck E-

2. Enter a name for the project in the
Save As dialog box.

3. Click OKto save the project.

After saving the project, you can

download the program to the S7-200. Flensms, [aetingslaes [
Save as ype: IPIO\ECI File [% rwp] j Cancel -
7

Figure 2-10 Saving the Example Program

13
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Downloading the Sample Program

¥

Tip

Each STEP 7-Micro/WIN project is associated with a CPU type (CPU 221, CPU 222, CPU 224,
CPU 224XP, or CPU 226). If the project type does not match the CPU to which you are
connected, STEP 7-Micro/WIN indicates a mismatch and prompts you to take an action. If this
occurs, choose “Continue Download” for this example.

1. Click the Download icon on the A
toolbar or select the - S es
File > Download menu command S =i
to download the program. See v _51.
Figure 2-11.

2. Click OK to download the elements — Euns .=
of the program to the S7-200. o he

If your S7-200 is in RUN mode, a dialog
box prompts you to place the S7-200 in
STOP mode. Click Yes to place the
S7-200 into STOP mode.

5 Chme o o s
)

Figure 2-11 Downloading the Program

Placing the S7-200 in RUN Mode

14

For STEP 7-Micro/WIN to place the S7-200 CPU in RUN mode, the mode switch of the S7-200
must be set to TERM or RUN. When you place the S7-200 in RUN mode, the S7-200 executes
the program:

1. Click the RUN icon on the toolbar RUN %]
or select the PLC > RUN menu P
command. @ Flace the PLC in RUN mode?

2. Click OK to change the operating

mode of the S7-200. Yos Ma |

When the S7-200 goes to RUN mode,
the output LED for Q0.0 turns on and off

Figure 2-12 Placing the S7-200 in RUN Mode
as the S7-200 executes the program.

Congratulations! You have just completed your first S7-200 program.
You can monitor the program by selecting the Debug > Program Status menu command.

STEP 7-Micro/WIN displays the values for the instructions. To stop the program, place the S7-200
in STOP mode by clicking the STOP icon or by selecting the PLC > STOP menu command.



Installing the S7-200

The S7-200 equipment is designed to be easy to install. You can use the mounting holes to attach
the modules to a panel, or you can use the built-in clips to mount the modules onto a standard
(DIN) rail. The small size of the S7-200 allows you to make efficient use of space.

This chapter provides guidelines for installing and wiring your S7-200 system.

In This Chapter

Guidelines for Installing S7-200 DeVIiCeS .. ... ...ttt 16
Installing and Removing the S7-200 Modules . .......... ... . i 17
Guidelines for Grounding and Wiring .. ...ttt 20

15
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Guidelines for Installing S7-200 Devices

You can install an S7-200 either on a panel or on a standard rail, and you can orient the S7-200
either horizontally or vertically.

Warning
' The SIMATIC S7-200 PLCs are Open Type Controllers. It is required that you install the S7-200
* in a housing, cabinet, or electric control room. Entry to the housing, cabinet, or electric control
room should be limited to authorized personnel.

Failure to follow these installation requirements could result in death or serious injury to
personnel, and/or damage to equipment.

Always follow these requirements when installing S7-200 PLCs.

Separate the S7-200 Devices from Heat, High Voltage, and Electrical
Noise
As a general rule for laying out the devices of your system, always separate the devices that

generate high voltage and high electrical noise from the low-voltage, logic-type devices such as
the S7-200.

When configuring the layout of the S7-200 inside your panel, consider the heat-generating
devices and locate the electronic-type devices in the cooler areas of your cabinet. Operating any
electronic device in a high-temperature environment will reduce the time to failure.

Consider also the routing of the wiring for the devices in the panel. Avoid placing low voltage
signal wires and communications cables in the same tray with AC power wiring and high-energy,
rapidly-switched DC wiring.

Provide Adequate Clearance for Cooling and Wiring

S7-200 devices are designed for natural convection cooling. For proper cooling, you must provide
a clearance of at least 25 mm above and below the devices. Also, allow at least 75 mm of depth.

Caution

For vertical mounting, the maximum allowable ambient temperature is reduced by
10 degrees C. Mount the S7-200 CPU below any expansion modules.

When planning your layout for the S7-200 system, allow enough clearance for the wiring and

communications cable connections. For additional flexibility in configuring the layout of the S7-200
system, use the I/O expansion cable.

Clearance 35 mm
R - Y

j_ 1 mm
 S—- : I e L [TF
= | N r Q 1
i E@ — nﬂi — ﬂE \ 5 | ! DIN Rail
25 mm Lo Eﬁ _ 7{ g } E E }
‘ E“:I ; ‘ 75 mm
L 1P
piEs iy
o . T Fron e Vet
= ﬂE nnnnnn - ﬂE nnnnnn HEE Vertical Panel
e P e ; Mounting
R Side View

Horizontal DIN Rail Mounting with Optional
Expansion Cable (limit one per system)

Figure 3-1 Mounting Methods, Orientation, and Clearance

16
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Power Budget

All S7-200 CPUs have an internal power supply that provides power for the CPU, the expansion
modules, and other 24 VDC user power requirements.

The S7-200 CPU provides the 5 VDC logic power needed for any expansion in your system. Pay
careful attention to your system configuration to ensure that your CPU can supply the 5V power
required by your selected expansion modules. If your configuration requires more power than the
CPU can supply, you must remove a module or select a CPU with more power capability. Refer to
Appendix A for information about the 5 VDC logic budget supplied by your S7-200 CPU and the

5 VDC power requirements of the expansion modules. Use Appendix B as a guide for determining
how much power (or current) the CPU can provide for your configuration.

All S7-200 CPUs also provide a 24 VDC sensor supply that can supply 24 VDC for input points,
for relay coil power on the expansion modules, or for other requirements. If your power
requirements exceed the budget of the sensor supply, then you must add an external 24 VDC
power supply to your system. Refer to Appendix A for the 24 VDC sensor supply power budget for
your particular S7-200 CPU.

If you require an external 24 VDC power supply, ensure that the power supply is not connected in
parallel with the sensor supply of the S7-200 CPU. For improved electrical noise protection, it is
recommended that the commons (M) of the different power supplies be connected.

Warning
' Connecting an external 24 VDC power supply in parallel with the S7-200 24 VDC sensor supply
A" can result in a conflict between the two supplies as each seeks to establish its own preferred
output voltage level.

The result of this conflict can be shortened lifetime or immediate failure of one or both power
supplies, with consequent unpredictable operation of the PLC system. Unpredictable operation
could result in death or serious injury to personnel, and/or damage to equipment.

The S7-200 DC sensor supply and any external power supply should provide power to different
points.

Installing and Removing the S7-200 Modules

The S7-200 can be easily installed on a standard DIN rail or on a panel.

Prerequisites

Before you install or remove any electrical device, ensure that the power to that equipment has
been turned off. Also, ensure that the power to any related equipment has been turned off.

Warning
' Attempts to install or remove S7-200 or related equipment with the power applied could cause
* electric shock or faulty operation of equipment.

Failure to disable all power to the S7-200 and related equipment during installation or removal
procedures could result in death or serious injury to personnel, and/or damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200 is disabled
before attempting to install or remove S7-200 CPUs or related equipment.

Always ensure that whenever you replace or install an S7-200 device you use the correct module
or equivalent device.

Warning
' E If you install an incorrect module, the program in the S7-200 could function unpredictably.
L ]

Failure to replace an S7-200 device with the same model, orientation, or order could result in
death or serious injury to personnel, and/or damage to equipment.

Replace an S7-200 device with the same model, and be sure to orient and position it correctly.

17
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Mounting Dimensions

The S7-200 CPUs and expansion modules include mounting holes to facilitate installation on
panels. Refer to Table 3-1 for the mounting dimensions.

Table 3-1 Mounting Dimensions

_.l -«—— 9.5 mm* * Minimum spacing

between modules

4 mm L A ;T when hard-mounted
T | B V|
x f = & Mounting
0 i || holes (M4
E I cooooooo ooooooon i i nooaoaoo 4 or No. 8)
96 mm 88 mm 80 mm ' -
o L |
@ 1 [={=[=]=f={=]={=]=]={=]={=]={=]=} i 1 oooaoang
U [ I
% o
I e
- T B T
| JR—— 8
4 mm e A ™

§7-200 Module WidthA  Width B

CPU 221 and CPU 222 90 mm 82 mm
CPU 224 120.5 mm | 112.5 mm
CPU 224XP 140 mm 132 mm
CPU 226 196 mm 188 mm
Expansion modules: 4- and 8-point DC and Relay 1/0O (8, 4Q, 8Q, 41/4Q) 46 mm 38 mm

and Analog Out (2 AQ)

Expansion modules: 16-point digital 1/O (161, 81/8Q), Analog 1/O (4Al, 8Al, 4AQ, 71.2mm  63.2mm

4AI/1AQ), RTD, Thermocouple, PROFIBUS, Ethernet,
Internet, AS-Interface, 8-point AC (8l and 8Q), Position, and

Modem
Expansion modules: 32-point digital 1/0 (161/16Q) 137.3 mm  129.3 mm
Expansion modules: 64-point digital 1/0 (321/32Q) 196 mm 188 mm

Installing a CPU or Expansion Module
Installing the S7-200 is easy! Just follow these steps.

Panel Mounting

1.

Locate, drill, and tap the mounting holes (M4 or American Standard number 8), using the
dimensions in Table 3-1.

Secure the module(s) to the panel, using the appropriate screws.

If you are using an expansion module, connect the expansion module ribbon cable into the
expansion port connector under the access door.

DIN Rail Mounting

1.
2.

Secure the rail to the mounting panel every 75 mm.

Snap open the DIN clip (located on the bottom of the module) and hook the back of the
module onto the DIN rail.

If you are using an expansion module, connect the expansion module ribbon cable into the
expansion port connector under the access door.

Rotate the module down to the DIN rail and snap the clip closed. Carefully check that the
clip has fastened the module securely onto the rail. To avoid damage to the module, press
on the tab of the mounting hole instead of pressing directly on the front of the module.
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Tip
@ Using DIN rail stops could be helpful if your S7-200 is in an environment with high vibration
potential or if the S7-200 has been installed vertically.

If your system is in a high-vibration environment, then panel-mounting the S7-200 will provide a
greater level of vibration protection.

Removing a CPU or Expansion Module
To remove an S7-200 CPU or expansion module, follow these steps:

1.
2.

4.
5.

Remove power from the S7-200.

Disconnect all the wiring and cabling that is attached to the module. Most S7-200 CPU and
expansion modules have removable connectors to make this job easier.

If you have expansion modules connected to the unit that you are removing, open the
access cover door and disconnect the expansion module ribbon cable from the adjacent
modules.

Unscrew the mounting screws or snap open the DIN clip.

Remove the module.

Removing and Reinstalling the Terminal Block Connector

Most S7-200 modules have removable connectors to make installing and replacing the module
easy. Refer to Appendix A to determine whether your S7-200 module has removable connectors.
You can order an optional fan-out connector for modules that do not have removable connectors.
See Appendix E for order numbers.

To Remove the Connector

1.
2.
3.

Open the connector door to gain access to the connector.
Insert a small screwdriver in the notch in the middle of the connector.

Remove the terminal connector by prying the screwdriver away from the S7-200 housing.
See Figure 3-2.

Figure 3-2 Removing the Connector

To Reinstall the Connector

1.
2.

Open the connector door.

Align the connector with the pins on the unit and align the wiring edge of the connector
inside the rim of the connector base.

Press down firmly to rotate the connector until it snaps into place. Check carefully to ensure
that the connector is properly aligned and fully engaged.
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Guidelines for Grounding and Wiring

Proper grounding and wiring of all electrical equipment is important to help ensure the optimum
operation of your system and to provide additional electrical noise protection for your application
and the S7-200.

Prerequisites

N

N

Before you ground or install wiring to any electrical device, ensure that the power to that
equipment has been turned off. Also, ensure that the power to any related equipment has been
turned off.

Ensure that you follow all applicable electrical codes when wiring the S7-200 and related
equipment. Install and operate all equipment according to all applicable national and local
standards. Contact your local authorities to determine which codes and standards apply to your
specific case.

Warning

Attempts to install or wire the S7-200 or related equipment with power applied could cause
electric shock or faulty operation of equipment. Failure to disable all power to the S7-200 and
related equipment during installation or removal procedures could result in death or serious
injury to personnel, and/or damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200 is disabled
before attempting to install or remove the S7-200 or related equipment.

Always take safety into consideration as you design the grounding and wiring of your S7-200
system. Electronic control devices, such as the S7-200, can fail and can cause unexpected
operation of the equipment that is being controlled or monitored. For this reason, you should
implement safeguards that are independent of the S7-200 to protect against possible personal
injury or equipment damage.

Warning

Control devices can fail in an unsafe condition, resulting in unexpected operation of controlled
equipment. Such unexpected operations could result in death or serious injury to personnel,
and/or damage to equipment.

Use an emergency stop function, electromechanical overrides, or other redundant safeguards
that are independent of the S7-200.

Guidelines for Isolation

N

20

S7-200 AC power supply boundaries and 1/O boundaries to AC circuits are rated 1500 VAC.
These isolation boundaries have been examined and approved as providing safe separation
between AC line and low voltage circuits.

All low voltage circuits connected to an S7-200, such as 24V power, must be supplied from an
approved source that provides safe isolation from AC line and other high voltages. Such sources
include double insulation as defined in international electrical safety standards and have outputs
that are rated as SELV, PELYV, Class 2, or Limited Power according to various standards.

Warning

Use of non-isolated or single insulation supplies to supply low voltage circuits from an AC line
can result in hazardous voltages appearing on circuits that are expected to be touch safe, such
as communications circuits and low voltage sensor wiring.

Such unexpected high voltages could result in death or serious injury to personnel, and/or
damage to equipment.

Only use high voltage to low voltage power converters that are approved as sources of touch
safe, limited voltage circuits.
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Guidelines for Grounding the S7-200

The best way to ground your application is to ensure that all the common and ground connections
of your S7-200 and related equipment are grounded to a single point. This single point should be
connected directly to the earth ground for your system.

For improved electrical noise protection, it is recommended that all DC common returns be
connected to the same single-point earth ground. Connect the 24 VDC sensor supply common
(M) to earth ground.

All ground wires should be as short as possible and should use a large wire size, such as 2 mm?2
(14 AWG).

When locating grounds, remember to consider safety grounding requirements and the proper
operation of protective interrupting devices.

Guidelines for Wiring the S7-200

When designing the wiring for your S7-200, provide a single disconnect switch that simultaneously
removes power from the S7-200 CPU power supply, from all input circuits, and from all output
circuits. Provide overcurrent protection, such as a fuse or circuit breaker, to limit fault currents on
supply wiring. You might want to provide additional protection by placing a fuse or other current
limit in each output circuit.

Install appropriate surge suppression devices for any wiring that could be subject to lightning
surges.

Avoid placing low-voltage signal wires and communications cables in the same wire tray with AC
wires and high-energy, rapidly switched DC wires. Always route wires in pairs, with the neutral or
common wire paired with the hot or signal-carrying wire.

Use the shortest wire possible and ensure that the wire is sized properly to carry the required
current. The connector accepts wire sizes from 2 mm2 to 0.3 mm?2 (14 AWG to 22 AWG). Use
shielded wires for optimum protection against electrical noise. Typically, grounding the shield at
the S7-200 gives the best results.

When wiring input circuits that are powered by an external power supply, include an overcurrent
protection device in that circuit. External protection is not necessary for circuits that are powered
by the 24 VDC sensor supply from the S7-200 because the sensor supply is already
current-limited.

Most S7-200 modules have removable connectors for user wiring. (Refer to Appendix A to
determine if your module has removable connectors.) To prevent loose connections, ensure that
the connector is seated securely and that the wire is installed securely into the connector. To avoid
damaging the connector, be careful that you do not over-tighten the screws. The maximum torque
for the connector screw is 0.56 N-m (5 inch-pounds).

To help prevent unwanted current flows in your installation, the S7-200 provides isolation
boundaries at certain points. When you plan the wiring for your system, you should consider these
isolation boundaries. Refer to Appendix A for the amount of isolation provided and the location of
the isolation boundaries. Isolation boundaries rated less than 1500 VAC must not be depended on
as safety boundaries.

Tip
@ For a communications network, the maximum length of the communications cable is 50 m
without using a repeater. The communications port on the S7-200 is non-isolated. Refer to
Chapter 7 for more information.
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Guidelines for Lamp Loads

22

Guidelines for Inductive Loads

You should equip inductive loads with suppression circuits to limit voltage rise when the control
output turns off. Suppression circuits protect your outputs from premature failure due to high
inductive switching currents. In addition, suppression circuits limit the electrical noise generated
when switching inductive loads.

Tip
The effectiveness of a given suppression circuit depends on the application, and you must verify

it for your particular use. Always ensure that all components used in your suppression circuit are
rated for use in the application.

DC Outputs and Relays That Control DC Loads

The DC outputs have internal protection that is adequate for most applications. Since the relays
can be used for either a DC or an AC load, internal protection is not provided.

Figure 3-3 shows a sample suppression A B (optional)
circuit for a DC load. In most

applications, the addition of a diode (A) A - 114001 diode or equivalent

i i i i B - 8.2V Zener for DC Outputs
across the _|ndl_Jct|ve Ioz_:ld is suitable, but Output 36V Zoner for Relay Outputs
if your application requires faster turn-off Point
times, then the addition of a Zener diode DC Inductive Load

(B) is recommended. Be sure to size

our Zener diode properly for the amount
gf current in your gutgut (\:/ircuit Figure 3-3  Suppression Circuit for a DC Load

AC Outputs and Relays That Control AC Loads

The AC outputs have internal protection that is adequate for most applications. Since the relays
can be used for either a DC or an AC load, internal protection is not provided.

Figure 3-4 shows a sample suppression duF 100t0 120 Q
circuit for an AC load. When you use a — —WW\——

relay or AC output to switch 115 V/230 MOV

VAC loads, place resistor/capacitor

networks across the AC load as shown @

in this figure. You can also use a metal

oxide varistor (MOV) to limit peak Output __FYW“F\__@_
voltage. Ensure that the working voltage Point AG Inductive Load

of the MOV is at least 20% greater than

the nominal line voltage. Figure 3-4  Suppression Circuit for an AC Load
Warning

When relay expansion modules are used to switch AC inductive loads, the external
resistor/capacitor noise suppression circuit must be placed across the AC load to prevent
unexpected machine or process operation. See Figure 3-4.

Lamp loads are damaging to relay contacts because of the high turn-on surge current. This surge
current will nominally be 10 to 15 times the steady state current for a Tungsten lamp. A
replaceable interposing relay or surge limiter is recommended for lamp loads that will be switched
a large number of times during the lifetime of the application.



PLC Concepts

The basic function of the S7-200 is to monitor field inputs and, based on your control logic, turn on
or off field output devices. This chapter explains the concepts used to execute your program, the
various types of memory used, and how that memory is retained.

In This Chapter
Understanding How the S7-200 Executes Your Control Logic .......................... 24
Accessing the Data of the S7-200 .. ... ... 26
Understanding How the S7-200 Saves and RestoresData . .............. ... ... ....... 35
Selecting the Operating Mode forthe S7-200 CPU ... ... ... .. it 39
Using the S7-200 EXPIOrer . . ... e e 40
Features of the S7-200 . ... ... 40
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Understanding How the S7-200 Executes Your Control Logic

The S7-200 continuously cycles through the control logic in your program, reading and writing

24

data.

The S7-200 Relates Your Program to the Physical Inputs and Outputs

The basic operation of the S7-200 is very simple:

1 The S7-200 reads the status of the inputs.

1 The program that is stored in the S7-200 uses
these inputs to evaluate the control logic. As
the program runs, the S7-200 updates the
data.

1 The S7-200 writes the data to the outputs.

Figure 4-1 shows a simple diagram of how an

electrical relay diagram relates to the S7-200. In this N

example, the state of the switch for starting the
motor is combined with the states of other inputs.
The calculations of these states then determine the
state for the output that goes to the actuator which
starts the motor.

Start_PB E_Stop M_Starter

SO

IM_starter _ - Motor
| ~
| P

Motor Starter

Start / Stop Switch

Figure 4-1  Controlling Inputs and Outputs

The S7-200 Executes Its Tasks in a Scan Cycle

The S7-200 executes a series of tasks repetitively. This cyclical execution of tasks is called the

scan cycle. As shown in Figure 4-2, the S7-200 performs most or all of the following tasks during a

scan cycle:

1 Reading the inputs: The S7-200 copies the
state of the physical inputs to the
process-image input register.

1 Executing the control logic in the program:
The S7-200 executes the instructions of the
program and stores the values in the various
memory areas.

1 Processing any communications requests:
The S7-200 performs any tasks required for
communications.

1 Executing the CPU self-test diagnostics: The
S7-200 ensures that the firmware, the
program memory, and any expansion
modules are working properly.

O Writing to the outputs: The values stored in
the process-image output register are written
to the physical outputs.

Writes to the outputs %

NNNNNNNN
7
Communications Requests \ }

Execute the Program Scan cyc’|e
SOOI

AN "1 ~,1

| Reads the inputs | @I ®I

Figure 4-2  S7-200 Scan Cycle

The execution of the user program is dependent upon whether the S7-200 is in STOP mode or in
RUN mode. In RUN mode, your program is executed; in STOP mode, your program is not

executed.
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Reading the Inputs

Digital inputs: Each scan cycle begins by reading the current value of the digital inputs and then
writing these values to the process-image input register.

Analog inputs: The S7-200 does not update analog inputs from expansion modules as part of the
normal scan cycle unless filtering of analog inputs is enabled. An analog filter is provided to allow
you to have a more stable signal. You can enable the analog filter for each analog input point.

When analog input filtering is enabled for an analog input, the S7-200 updates that analog input
once per scan cycle, performs the filtering function, and stores the filtered value internally. The
filtered value is then supplied each time your program accesses the analog input.

When analog filtering is not enabled, the S7-200 reads the value of the analog input from
expansion modules each time your program accesses the analog input.

Analog inputs AIW0 and AIW2 included on the CPU 224XP are updated every scan with the most
recent result from the analog-to-digital converter. This converter is an averaging type (sigma-delta)
and those values will usually not need software filtering.

Tip
Analog input filtering is provided to allow you to have a more stable analog value. Use the

analog input filter for applications where the input signal varies slowly with time. If the signal is a
high-speed signal, then you should not enable the analog filter.

Do not use the analog filter with modules that pass digital information or alarm indications in the
analog words. Always disable analog filtering for RTD, Thermocouple, and AS-Interface Master
modules.

Executing the Program

During the execution phase of the scan cycle, the S7-200 executes your program, starting with the
first instruction and proceeding to the end instruction. The immediate I/O instructions give you
immediate access to inputs and outputs during the execution of either the program or an interrupt
routine.

If you use interrupts in your program, the interrupt routines that are associated with the interrupt
events are stored as part of the program. The interrupt routines are not executed as part of the
normal scan cycle, but are executed when the interrupt event occurs (which could be at any point
in the scan cycle).

Processing Any Communications Requests

During the message-processing phase of the scan cycle, the S7-200 processes any messages
that were received from the communications port or intelligent I/O modules.

Executing the CPU Self-test Diagnostics

During this phase of the scan cycle, the S7-200 checks for proper operation of the CPU and for
the status of any expansion modules.

Writing to the Digital Outputs

At the end of every scan cycle, the S7-200 writes the values stored in the process-image output
register to the digital outputs. (Analog outputs are updated immediately, independently from the
scan cycle.)

25
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Accessing the Data of the S7-200

26

The S7-200 stores information in different memory locations that have unique addresses. You can
explicitly identify the memory address that you want to access. This allows your program to have
direct access to the information. Table 4-1 shows the range of integer values that can be
represented by the different sizes of data.

Table 4-1 Decimal and Hexadecimal Ranges for the Different Sizes of Data

Representation Byte (B) Word (W) Double Word (D)
Unsigned Integer 0to 255 0 to 65,535 0 to 4,294,967,295
Oto FF 0 to FFFF 0 to FFFF FFFF
Signed Integer -1281to0 +127 | -32,768 to +32,767 -2,147,483,648 to +2,147,483,647
80to 7F 8000 to 7FFF 8000 0000 to 7FFF FFFF
Real Not applicable | Not applicable +1.175495E-38 to +3.402823E+38 (positive)
IEEE 32-bit -1.175495E-38 to -3.402823E+38 (negative)

Floating Point

To access a bit in a memory area, you specify the address, which includes the memory area
identifier, the byte address, and the bit number. Figure 4-3 shows an example of accessing a bit
(which is also called “byte.bit” addressing). In this example, the memory area and byte address

(I = input, and 3 = byte 3) are followed by a period (“.”) to separate the bit address (bit 4).

1 3 .4 .

Process-image Input (I) Memory Area

L Bitof byte, or bit number: ge Input () Y

bit 4 of 8 (0 to 7) 76543210
Period separates the Byte 0
byte address from the bit Byte 1
number Byte 2

Byte address: byte 3 (the Byte 3 .

fourth byte) Byte 4
Byte 5

Memory area identifier

Figure 4-3 Byte.Bit Addressing

You can access data in most memory areas (V, I, Q, M, S, L, and SM) as bytes, words, or double
words by using the byte-address format. To access a byte, word, or double word of data in the
memory, you must specify the address in a way similar to specifying the address for a bit. This
includes an area identifier, data size designation, and the starting byte address of the byte, word,
or double-word value, as shown in Figure 4-4.
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Data in other memory areas (such as T, C, HC, and the accumulators) are accessed by using an
address format that includes an area identifier and a device number.

V B 100 vV w100 VvV D 100
L Byte address L Byte address L Byte address
Access to a byte size Access to a word size Access to a double word size
Area identifier Area identifier Area identifier
MSB LSB

vB100 |7 vBioo  ©|

MSB = most significant bit
LSB = least significant bit
Most significant byte Least significant byte
MSB LSB
VW100 |15 VB100 8|7 vBi01 0]
Most significant byte Least significant byte
MSB LSB

VD100 |31 vB100 24|28 vB1p1  16[15 vBio2  8[7 vB103 O

Figure 4-4  Comparing Byte, Word, and Double-Word Access to the Same Address

Accessing Data in the Memory Areas

Process-Image Input Register: |

The S7-200 samples the physical input points at the beginning of each scan cycle and writes
these values to the process-image input register. You can access the process-image input register
in bits, bytes, words, or double words:

Bit: I[byte address].[bit address] 10.1
Byte, Word, or Double Word: I[size][starting byte address] B4

Process-Image Output Register: Q

At the end of the scan cycle, the S7-200 copies the values stored in the process-image output
register to the physical output points. You can access the process-image output register in bits,
bytes, words, or double words:

Bit: Q[byte address].[bit address] Q1.1
Byte, Word, or Double Word: Q[size][starting byte address] QB5

Variable Memory Area: V

You can use V memory to store intermediate results of operations being performed by the control
logic in your program. You can also use V memory to store other data pertaining to your process
or task. You can access the V memory area in bits, bytes, words, or double words:

Bit: V[byte address].[bit address] V10.2
Byte, Word, or Double Word: V[size][starting byte address] VW100

Bit Memory Area: M

You can use the bit memory area (M memory) as control relays to store the intermediate status of
an operation or other control information. You can access the bit memory area in bits, bytes,
words, or double words:

Bit: M/byte address].[bit address] M26.7
Byte, Word, or Double Word: M[size][starting byte address] MD20
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Timer Memory Area: T

The S7-200 provides timers that count increments of time in resolutions (time-base increments) of
1 ms, 10 ms, or 100 ms. Two variables are associated with a timer:

1 Current value: this 16-bit signed integer stores the amount of time counted by the timer.

1 Timer bit: this bit is set or cleared as a result of comparing the current and the preset value.
The preset value is entered as part of the timer instruction.

You access both of these variables by using the timer address (T + timer number). Access to
either the timer bit or the current value is dependent on the instruction used: instructions with bit
operands access the timer bit, while instructions with word operands access the current value. As
shown in Figure 4-5, the Normally Open Contact instruction accesses the timer bit, while the Move
Word instruction accesses the current value of the timer.

Format: T[timer number] T24
21 ENM\C,’VV— Current Value Timer Bits | |T3|
TO TO ‘ b
T3 —IN  OUT |— VW200 = T
| T2 T2
~ |15 (MmsB) T3 0 (LSB) T3

Accesses the current value Accesses the timer bit

Figure 4-5

Accessing the Timer Bit or the Current Value of a Timer

Counter Memory Area: C

The S7-200 provides three types of counters that count each low-to-high transition event on the
counter input(s): one type counts up only, one type counts down only, and one type counts both
up and down. Two variables are associated with a counter:

[ Current value: this 16-bit signed integer stores the accumulated count.

1 Counter bit: this bit is set or cleared as a result of comparing the current and the preset
value. The preset value is entered as part of the counter instruction.

You access both of these variables by using the counter address (C + counter number). Access to
either the counter bit or the current value is dependent on the instruction used: instructions with bit
operands access the counter bit, while instructions with word operands access the current value.
As shown in Figure 4-6, the Normally Open Contact instruction accesses the counter bit, while the
Move Word instruction accesses the current value of the counter.

Format: Clcounter number] C24
12.1

E’ZAOV—W Current Value Counter Bits | |C3|
co co ‘ b

c3— IN OUT |— VW200 c1 c1

| C2 C2

15 (MSB) C3 0 (LSB) C3

Accesses the current value Accesses the counter bit
Figure 4-6 Accessing the Counter Bit or the Current Value of a Counter
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High-Speed Counters: HC

The high-speed counters count high-speed events independent of the CPU scan. High-speed
counters have a signed, 32-bit integer counting value (or current value). To access the count
value for the high-speed counter, you specify the address of the high-speed counter, using the
memory type (HC) and the counter number (such as HCO). The current value of the high-speed
counter is a read-only value and can be addressed only as a double word (32 bits).

Format: HC[high-speed counter number] HC1

Accumulators: AC

The accumulators are read/write devices that can be used like memory. For example, you can use
accumulators to pass parameters to and from subroutines and to store intermediate values used
in a calculation. The S7-200 provides four 32-bit accumulators (ACO, AC1, AC2, and AC3). You
can access the data in the accumulators as bytes, words, or double words.

The size of the data being accessed is determined by the instruction that is used to access the
accumulator. As shown in Figure 4-7, you use the least significant 8 or 16 bits of the value that is
stored in the accumulator to access the accumulator as bytes or words. To access the
accumulator as a double word, you use all 32 bits.

For information about how to use the accumulators within interrupt subroutines, refer to the
Interrupt Instructions in Chapter 6.

Format: AC[accumulator number] ACO

Network 1
M0.0 MOY_E AC2 (accessed as a byte) MSB LSB

— p——fn Eeno— | ! g

ACZ24IN OUTFwE200

Metwork 2
AC1 (accessed as a word) MSB LSB
M0 DEC_W i 8 7 o
_| | BN ENO )I | | Most significant Least significant
ac1dn outhvwioo Byte 1 Byte 0
Network 3 AC3 (accessed as a double word)
IOy MSB LSB
MO.2 - 31 24 23 16 15 8 7 0
_| | BN ENO >| | Most significant | Least significant
acadin outhvposo Byte 3 Byte 2 Byte 1 Byte 0

Figure 4-7 Accessing the Accumulators
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Special Memory: SM

The SM bits provide a means for communicating information between the CPU and your program.
You can use these bits to select and control some of the special functions of the S7-200 CPU,
such as: a bit that turns on for the first scan cycle, a bit that toggles at a fixed rate, or a bit that
shows the status of math or operational instructions. (For more information about the SM bits, see
Appendix D.) You can access the SM bits as bits, bytes, words, or double words:

Bit: SM/byte address].[bit address] SMO0.1
Byte, Word, or Double Word: SM[size][starting byte address] SMB86

Local Memory Area: L

The S7-200 provides 64 bytes of local memory of which 60 can be used as scratchpad memory or
for passing formal parameters to subroutines.

Tip
If you are programming in either LAD or FBD, STEP 7-Micro/WIN reserves the last four bytes of
local memory for its own use.

Local memory is similar to V memory with one major exception. V. memory has a global scope
while L memory has a local scope. The term global scope means that the same memory location
can be accessed from any program entity (main program, subroutines, or interrupt routines). The
term local scope means that the memory allocation is associated with a particular program entity.
The S7-200 allocates 64 bytes of L memory for the main program, 64 bytes for each subroutine
nesting level, and 64 bytes for interrupt routines.

The allocation of L memory for the main program cannot be accessed from subroutines or from
interrupt routines. A subroutine cannot access the L memory allocation of the main program, an
interrupt routine, or another subroutine. Likewise, an interrupt routine cannot access the L memory
allocation of the main program or of a subroutine.

The allocation of L memory is made by the S7-200 on an as-needed basis. This means that while
the main portion of the program is being executed, the L memory allocations for subroutines and
interrupt routines do not exist. At the time that an interrupt occurs or a subroutine is called, local
memory is allocated as required. The new allocation of L memory might reuse the same L
memory locations of a different subroutine or interrupt routine.

The L memory is not initialized by the S7-200 at the time of allocation and might contain any
value. When you pass formal parameters in a subroutine call, the values of the parameters being
passed are placed by the S7-200 in the appropriate L memory locations of the called subroutine. L
memory locations, which do not receive a value as a result of the formal parameter passing step,
will not be initialized and might contain any value at the time of allocation.

Bit: L/byte address].[bit address] L0.0
Byte, Word, or Double Word: L/size] [starting byte address] LB33

Analog Inputs: Al

The S7-200 converts an analog value (such as temperature or voltage) into a word-length (16-bit)
digital value. You access these values by the area identifier (Al), size of the data (W), and the
starting byte address. Since analog inputs are words and always start on even-number bytes
(such as 0, 2, or 4), you access them with even-number byte addresses (such as AIW0, AIW2, or
AIW4). Analog input values are read-only values.

Format: AlW([starting byte address] AlW4
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Analog Outputs: AQ

The S7-200 converts a word-length (16-bit) digital value into a current or voltage, proportional to
the digital value (such as for a current or voltage). You write these values by the area identifier
(AQ), size of the data (W), and the starting byte address. Since analog outputs are words and
always start on even-number bytes (such as 0, 2, or 4), you write them with even-number byte
addresses (such as AQWO0, AQW2, or AQW4). Analog output values are write-only values.

Format: AQW/starting byte address] AQW4

Sequence Control Relay (SCR) Memory Area: S

SCRs or S bits are used to organize machine operations or steps into equivalent program
segments. SCRs allow logical segmentation of the control program. You can access the S bits as
bits, bytes, words, or double words.

Bit: S[byte address].[bit address] S3.1
Byte, Word, or Double Word: S[size][starting byte address] SB4

Format for Real Numbers

Real (or floating-point) numbers are represented as 32-bit, single-precision numbers, whose
format is described in the ANSI/IEEE 754-1985 standard. See Figure 4-8. Real numbers are
accessed in double-word lengths.

For the S7-200, floating point numbers are MsB LSB
accurate up to 6 decimal places. Therefore, 81 %0 28 22 , 0
you can specify a maximum of 6 decimal [s] Exponent Mantissa

places when entering a floating-point Sign

constant. Figure 4-8  Format of a Real Number

Accuracy when Calculating Real Numbers

Calculations that involve a long series of values including very large and very small numbers can
produce inaccurate results. This can occur if the numbers differ by 10 to the power of x,
where x > 6.

For example: 100 000 000 + 1 = 100 000 000

Format for Strings

A string is a sequence of characters, with each character being stored as a byte. The first byte of
the string defines the length of the string, which is the number of characters. Figure 4-9 shows the
format for a string. A string can have a length of 0 to 254 characters, plus the length byte, so the
maximum length for a string is 255 bytes. A string constant is limited to 126 bytes.

| Length | Character 1 | Character 2 | Character 3 | Character 4 | - | Character 254

Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 254

Figure 4-9 Format for Strings
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Specifying a Constant Value for S7-200 Instructions

%

You can use a constant value in many of the S7-200 instructions. Constants can be bytes, words,
or double words. The S7-200 stores all constants as binary numbers, which can then be
represented in decimal, hexadecimal, ASCII, or real number (floating point) formats. See

Table 4-2.

Table 4-2 Representation of Constant Values

Representation Format Sample

Decimal [decimal value] 20047

Hexadecimal 16#[hexadecimal value] 16#4E4F

Binary 2#[binary number] 2#1010_0101_1010_0101

ASCII 'TASCII text]’ ’ABCD’

Real ANSVI/IEEE 754-1985 +1.175495E-38 (positive) -1.175495E-38 (negative)
String “[stringtext]” “ABCDE”

Tip

The S7-200 CPU does not support “data typing” or data checking (such as specifying that the
constant is stored as an integer, a signed integer, or a double integer). For example, an Add
instruction can use the value in VW100 as a signed integer value, while an Exclusive Or
instruction can use the same value in VW100 as an unsigned binary value.

Addressing the Local and Expansion 1/O

The local I/O provided by the CPU provides a fixed set of I/O addresses. You can add 1/O points to
the S7-200 CPU by connecting expansion I/O modules to the right side of the CPU, forming an I/O
chain. The addresses of the points of the module are determined by the type of I/O and the
position of the module in the chain, with respect to the preceding input or output module of the
same type. For example, an output module does not affect the addresses of the points on an input
module, and vice versa. Likewise, analog modules do not affect the addressing of digital modules,
and vice versa.

Tip

Process-image register space for digital I/O is always reserved in increments of eight bits (one
byte). If a module does not provide a physical point for each bit of each reserved byte, these
unused bits cannot be assigned to subsequent modules in the 1/O chain. For input modules, the
unused bits are set to zero with each input update cycle.

Analog I/O points are always allocated in increments of two points. If a module does not provide
physical I/O for each of these points, these 1/O points are lost and are not available for
assignment to subsequent modules in the 1/O chain.
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Figure 4-10 provides an example of the I/O numbering for a particular hardware configuration. The
gaps in the addressing (shown as gray italic text) cannot be used by your program.

4 Analog In 4 Analog In
CPU 224XP ‘ 4In/40Out ‘ 8In 1 Analog Out B 1 Analog Out

10.0 Q0.0 Module 0 Module 1 Module 2 Module 3 Module 4

101 Q0.1 20 Q20 13.0 AlWa AQW4 Q3.0 AW12  AQWS
10.2 Q0.2 21 Q21 13.1 AIW6 AQW6E Q3.1 AW14  AQW10
0.3 Q0.3 22 Q22 13.2 AlWS Q3.2 AIW16

0.4 Q0.4 23 Q23 13.3 AIW10 Q3.3 AIW18

10.5 Q0.5 124 Q2.4 13.4 Q3.4

10.6 Q0.6 125 Q25 13.5 Q3.5

0.7 Q0.7 126 Q2.6 13.6 Q3.6

1.0 at.0 127 Q7 13.7 Q3.7

1.1 at.1

n.2 Q1.2 ;

na ors Expansion 1/0

.4 Q1.4

.5 a1.s

1.6 Q1.6

n.z Q1.7

AlWo AQWo

AlW2 AQw2
Local I/0

Figure 4-10 Sample 1/0O Addresses for Local and Expansion I/O (CPU 224XP)

Using Pointers for Indirect Addressing of the S7-200 Memory Areas

Indirect addressing uses a pointer to access the data in memory. Pointers are double word
memory locations that contain the address of another memory location. You can only use

V memory locations, L memory locations, or accumulator registers (AC1, AC2, AC3) as pointers.
To create a pointer, you must use the Move Double Word instruction to move the address of the
indirectly addressed memory location to the pointer location. Pointers can also be passed to a
subroutine as a parameter.

The S7-200 allows pointers to access the following memory areas: |, Q, V, M, S, Al, AQ, SM,
T (current value only), and C (current value only). You cannot use indirect addressing to access
an individual bit or to access HC or L memory areas.

To indirectly access the data in a memory address, you create a pointer to that location by
entering an ampersand (&) and the memory location to be addressed. The input operand of the
instruction must be preceded with an ampersand (&) to signify that the address of a memory
location, instead of its contents, is to be moved into the location identified in the output operand of
the instruction (the pointer).

Entering an asterisk (*) in front of an operand for an instruction specifies that the operand is a
pointer. As shown in Figure 4-11, entering *AC1 specifies that AC1 is a pointer to the word-length
value being referenced by the Move Word (MOVW) instruction. In this example, the values stored
in both VB200 and VB201 are moved to accumulator ACO.

ACt
V199 | address of VW200 |<—— MOVD &VW200, AC1

V200 12 N Creates the pointer by moving the address of VB200
V201 34 (address of the initial byte for VW200) to AC1.

V202 56 ACO

vas |78 | | | 1234 |<——MOvW *AC1, ACO

Moves the word value pointed to by AC1 to ACO.

Figure 4-11  Creating and Using a Pointer
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As shown in Figure 4-12, you can change the value of a pointer. Since pointers are 32-bit values,
use double-word instructions to modify pointer values. Simple mathematical operations, such as
adding or incrementing, can be used to modify pointer values.

AC1
Ve | address of VW200 |«—— MOVD &VW200, ACT
V200 12 Creates the pointer by moving the address of
V201 34 P Aco l VB200 (address of VW200's initial byte) to AC1.
V202 56 | | 1234 | MOVW *AC1, ACO
V203 78 Moves the word value pointed to by
AC1 (VW200) to ACO.
v AC1
* | address of VWW202 [«—— +D +2,ACt

V200 12 ACO Adds 2 to the accumulator to point to the
V201 34 next word location.
V202 56 | | s678 | MOVW *AC1, ACO

M f Moves the word value pointed to by
V203 78 AC1 (VW202) to ACO.

Figure 4-12  Modifying a Pointer

Tip

@ Remember to adjust for the size of the data that you are accessing: to access a byte, increment
the pointer value by 1; to access a word or a current value for a timer or counter, add or
increment the pointer value by 2; and to access a double word, add or increment the pointer
value by 4.

Sample Program for Using an Offset to Access Data in V Memory

This example uses LD10 as a pointer to the address VBO. You then increment the pointer by an offset stored in VD1004.
LD10 then points to another address in V memory (VBO + offset). The value stored in the V. memory address pointed to
by LD10 is then copied to VB1900. By changing the value in VD1004, you can access any V memory location.

Network 1 Network 1 //How to use an offset to read the value
SMO 0 MOV DWW Zof any VB location:
| EN  Eno—)
_| ! /1. Load the starting address of the
//N memory to a pointer.
//2. Add the offset value to the pointer.
//3. Copy the value from the V memory

/location (offset) to VB1900.
ADD_DI /l

EN ENO %
LD SM0.0

MOVD &VBO, LD10
+D VD1004, LD10
MOVB *LD10, VB1900

EWBO4IN__ OUTELD10

YD10044IM1T - QUTELDO
LD1041M32

MOV_B

EN  ENO H

*LD104iM QUTEWE1500
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Sample Program for Using a Pointer to Access Data in a Table

This example uses LD14 as a pointer to a recipe stored in a table of recipes that begins at VB100. In this example,
VW1008 stores the index to a specific recipe in the table. If each recipe in the table is 50 bytes long, you multiply the
index by 50 to obtain the offset for the starting address of a specific recipe. By adding the offset to the pointer, you can
access the individual recipe from the table. In this example, the recipe is copied to the 50 bytes that start at VB1500.

Hetwork 1 Network 1 //How to transfer a recipe from a table of recipes:
SM0.0 MOY_D /I - Each recipe is 50 bytes long.
— | EN  ENO—) // - The index parameter (VW1008) identifies
/I the recipe to be loaded.
&vB1004IN QUTHLDT4 Il

/[1. Create a pointer to the starting address
/I of the recipe table.

] //2. Convert the index of the recipe to a
EN  ENOF—) /I double-word value.
/3. Multiply the offset to accommodate
Wn10084IN__ oUThLDY8 /I the size of each recipe.

//4. Add the adjusted offset to the pointer.
/5. Transfer the selected recipe to
MUL_DI /l VB1500 through VB1549.

EN  ENO—) LD SM0.0

MOVD &VB100, LD14

+a04 1M1 QUTFLE S ITD VW1 008‘ LD18
LO1 842 *D +50, LD18
m— +D LD18, LD14
| BMB *LD14, VB1
ool % , 500, 50
LD184IN1  OUTFLD14
LD144INzZ
BLKMOY_B

EN  ENO—)

*LO144IN OUTFVB1500
04N

Understanding How the S7-200 Saves and Restores Data

The S7-200 provides a variety of features to ensure that your user program and data are properly
retained in the S7-200.

1 Retentive Data Memory - Areas of data memory the user selects to remain unchanged
over a power cycle, as long as the super capacitor and the optional battery cartridge have
not been discharged. V, M, Timer Currents, and Counter Currents are the only data memory
areas that are configurable to be retentive.

1 Permanent Memory - Non-volatile memory used to store the program block, data block,
system block, forced values, M memory configured to be saved on loss of power, and
selected values written under user program control

1 Memory Cartridge - Removable non-volatile memory used to store the program block, data
block, system block, recipes, data logs, and forced values

You can use the S7-200 Explorer to store documentation files (doc, text, pdf, etc.) into the
cartridge. You can also use the S7-200 Explorer to perform general file maintenance on the
memory cartridge (copy, delete, directory and launch).

To install a memory cartridge, remove the plastic slot cover from the S7-200 CPU and insert the
memory cartridge in the slot. The memory cartridge is keyed for proper installation.

Caution
Electrostatic discharge can damage the memory cartridge or the receptacle on the S7-200 CPU.

Make contact with a grounded conductive pad and/or wear a grounded wrist strap when you
handle the cartridge. Store the cartridge in a conductive container.
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Downloading and Uploading the Elements of Your Project

Your project consists of different elements:

1 Program block

1 Data block (optional)

1 System block (optional)
1 Recipes (optional)

1 Data log configurations (optional)

When you download a project, the program block, data block and system block are stored in
permanent memory for safekeeping. Recipes and data log configurations are stored in the
memory cartridge, and replace any existing recipes and data logs. Any program elements not
included in the download operation are left unchanged in permanent memory and the memory

cartridge.

If a project download includes recipes or
data log configurations, the memory
cartridge must remain installed for proper
program operation.

To download your project to an S7-200
CPU:

1. Select the File > Download menu
command.

2. Click each project element you
wish to download.

3. Click the Download Button.

Download ]

PP1 Connection

Use the Options button to select blocks to download.

Remote Addiess: 2 CPU 224%P REL 02.00

\i) Click Download to begin.

lg

Options £ Download | Cancel |

Op
% Program Block To:PLC
¥ DataBlock To:PLC
[ System Block To:PLC
™ Recipes

I™ Data Log Configurations

¥ Close dislag an success

@ Click for Help and Support ¥ Prompt on RUN to STOP

Figure 4-13 Download a Project to S7-200 CPU

When you upload a project to your computer using STEP 7-Micro/WIN, the S7-200 uploads the
program block, data block and system block from permanent memory. The recipes and data log
configurations are uploaded from the memory cartridge. The data from the data logs is not

uploaded to your computer using STEP7-Micro/WIN. The S7-200 Explorer is used to upload the

data from the data logs (see Chapter 14).

To upload your project from an S7-200
CPU:

1. Select the File > Upload menu
command.

2. Click each project element that you
wish to upload.

3. Click the Upload Button.

Upload x|
PPl Connection
Use the options button to select blocks 1o upload
Flemote Addiess: 2 CPU 224 REL 02,00

to the uploaded program. To avoid using esisting symbols or comments, upload your program to S,

i Click Upload ta begin. Any symbols or comments that exist in the current project will be applied
e
a new project. = |

Opions £ Upload | Cancel |
i
I Program Block From: PLC
[ DataBlock From: PLC
[ System Block From: PLC
™ Recipes
I™ Data Log Configurations

|¥ Close dialog on sucoess

© Click for Help and Support

Figure 4-14 Upload a Project to the S7-200
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Storing your Program on a Memory Cartridge

The S7-200 allows you to copy your user program from one CPU to another using a memory
cartridge. You can also distribute updates for any of the following blocks in your S7-200: the
program block, system block or data block.

Before copying any program elements to the memory cartridge, STEP 7-Micro/WIN deletes all
program elements (including recipes and data logs) except for user files on the memory cartridge.
If your program will not fit because of the size of your files, you can do one of two things to create
enough storage space for your program. You can either erase the memory cartridge using the
PLC > Erase Memory Cartridge menu command. Or, you can open the S7-200 Explorer and
remove user files that are no longer needed.

The PLC must be in STOP mode to program the memory cartridge.

To store your program in the memory Progran Memory Gortridge
cartridge: son o e Coretigh R 1 pragr e ey
Famote Address 2 CPU 2203 REL 02 00
1. Selectthe PLC > Program > oy i sl o
Memory Cartridge menu g e e b IR S '
command.
2. Click each project element you
wish to copy to the memory et )| I
cartridge (all program elements e — o
. . . F Progras Blod rom: PLC
that exist in your project are  Dandid Fiom: FLC
selected by default). If the system iy e e

I Dnin Log Configurations

block is selected the force values
will be copied as well.

3. Click the Program Button

F Close dhalog on peccess

@ Click for Help and Support F Promgt on FUN 1 STOP

Figure 4-15 Store a Program on a Memory Cartridge

The program block, system block, data block, and any forced values are copied from permanent
memory in the S7-200 to the memory cartridge. The recipes and data log configurations are
copied from STEP 7-Micro/WIN to the memory cartridge.

Restoring a Program from a Memory Cartridge

To transfer the program from a memory cartridge to the S7-200, you must apply power to the
S7-200 with the memory cartridge installed. If any of the blocks or force values present in the
memory cartridge are different from the blocks or force values in the S7-200, then all blocks
present in the memory cartridge are copied to the S7-200.

1 [Ifaprogram block was transferred from the memory cartridge, the program block in
permanent memory is replaced.

1 [If adata block was transferred from the memory cartridge, the data block in permanent
memory is replaced, all of V memory is cleared, and V memory is initialized with the
contents of the data block.

1 If a system block was transferred from the memory cartridge, the system block and force
values in the permanent memory are replaced and all retentive memory is cleared.

Once the transferred program has been stored to permanent memory you can remove the
memory cartridge. However, if recipes or data logs are present in the cartridge, you must leave
the memory cartridge installed. Leaving the memory cartridge installed will delay entry to RUN
mode on subsequent power cycles.

Notice

Powering on an S7-200 CPU with an installed memory cartridge that was programmed by a
different model of S7-200 CPU can cause an error. Memory cartridges that are programmed by
a lower model number CPU can be read by a higher model number CPU. However, the
opposite is not true. For example, memory cartridges that are programmed by a CPU 221 or
CPU 222 can be read by a CPU 224, but memory cartridges that are programmed by a

CPU 224 are rejected by a CPU 221 or CPU 222.

For a complete list of memory cartridge usage restrictions, see Optional Cartridges (Memory
Cartridge) in Appendix A.
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Saving the Retentive M Memory Area on Power Loss

If you configured any of the first 14 bytes of bit memory (MBO to MB13) to be retentive, these
bytes are saved to permanent memory when the S7-200 loses power. By default, the first 14
bytes of M memory are selected to be non-retentive.

Restoring Data after Power On

When power is applied, the S7-200 restores the program block and the system block from
permanent memory. The S7-200 then verifies that the super capacitor and optional battery
cartridge, if installed, has successfully maintained the data stored in RAM memory. If the data was
successfully maintained, the retentive areas of user data memory are left unchanged. The
non-retentive portions of V. memory are restored from the contents of the data block in permanent
memory. The non-retentive portions of other memory areas are cleared.

If the contents of RAM were not maintained (such as after an extended power failure), the S7-200
clears all user data areas, sets the Retentive Data Lost memory bit (SMO0.2), restores V memory
from the contents of the data block in permanent memory, and restores the first 14 bytes of

M memory from permanent memory if these bytes were previously configured as retentive.

Using Your Program to Save V Memory to Permanent Memory

You can save a value (byte, word, or double word) stored in any location of the V. memory area to
permanent memory. A save to permanent memory operation typically increases the scan time by
10 to 15 ms. The value written by the Save operation overwrites any previous value stored in the
V memory area of permanent memory.

The save to permanent memory operation does not update the data in the memory cartridge.

Tip

@ Since the number of save operations to the permanent memory (EEPROM) is limited (100,000
minimum, and 1,000,000 typical), you should ensure that only necessary values are saved.
Otherwise, the EEPROM can wear out and the CPU can fail. Typically, you should perform save
operations at the occurrence of specific events that occur rather infrequently.

For example, if the scan time of the S7-200 is 50 ms and a value was saved once per scan, the
EEPROM would last a minimum of 5,000 seconds, which is less than an hour and a half. On the
other hand, if a value were saved once an hour, the EEPROM would last a minimum of 11
years.

Copying V Memory to Permanent Memory

Special Memory Byte 31 (SMB31) commands the S7-200 to copy a value in V memory to the
V memory area of permanent memory. Special Memory Word 32 (SMW32) stores the address
location of the value that is to be copied. Figure 4-16 shows the format of SMB31 and SMW32.

Use the following steps to program the S7-200 to SMB31

. g A 7 o Size of value to be
save or write a specific value in V. memory: saved:
|sv | 0|0| 0| 0| 0 |s1 |sol 00 - byte
01 - byt

1. Load the V memory address of the value to | 10 - vord

be saved in SMW32. Save to permanent memory: 11 - double word

. . 0=No

2. Load the size of the data in SM31.0 and 1=Yes ™ TheCPUressts

SM31.1, as shown in Figure 4-16. SM31.7 after each

save operation.

3. SetSM31.7to 1.
SMWw32
At the end of every scan cycle, the S7-200 checks 15 V memory address o]
SM31.7; if SM31.7 equals 1, the specified value is
saved to permanent memory. The operation is
complete when the S7-200 resets SM31.7 to 0.

Specify the V memory address as an offset from V0.

Do not change the value in V memory until the Figure 4-16  SMB31 and SMW32
save operation is complete.
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Tip
@ Copying V Memory to permanent memory can be used to save values that are created from an
HMI and stored from the program to the internal EEPROM.

To include the values saved to the internal EEPROM in your STEP 7-Micro/WIN project, you
must upload the DB. However, this upload is only possible if the DB (which included a variable
that was at an equal or higher address than the V Memory address saved in SMW32) was
previously downloaded from STEP 7-Micro/WIN.

Sample Program: Copying V Memory to the Permanent Memory

This example transfers VB100 to permanent memory. On a rising edge of 10.0, if another transfer is not in progress, it
loads the address of the V memory location to be transferred to SMW32. It selects the amount of V memory to transfer
(1=Byte; 2=Word; 3=Double Word or Real). It then sets SM31.7 to have the S7-200 transfer the data at the end of the
scan.

The S7-200 automatically resets SM31.7 when the transfer is complete.

Hetwork 1 Network 1 /[Transfer a V memory
10.0 SM31.7 MOV_WY /Nlocation (VB100) to
I | » | { | EN eno—) /[permanent memory
100N outh swwaz LD 10.0
EU
AN SM31.7
Mov_B MOVW  +100, SMW32
= mo—  MOVB 1, SMBS
1B 1Y) OUTEEMB31 S SM317’ 1
SMaT
—( )

Selecting the Operating Mode for the S7-200 CPU

The S7-200 has two modes of operation: STOP mode and RUN mode. The status LEDs on the
front of the CPU indicates the current mode of operation. In STOP mode, the S7-200 is not
executing the program, and you can download a program or the CPU configuration. In RUN
mode, the S7-200 is running the program.

1 The S7-200 provides a mode switch for changing the mode of operation. You can use the
mode switch (located under the front access door of the S7-200) to manually select the
operating mode: setting the mode switch to STOP mode stops the execution of the
program; setting the mode switch to RUN mode starts the execution of the program; and
setting the mode switch to TERM (terminal) mode does not change the operating mode.

If a power cycle occurs when the mode switch is set to either STOP or TERM, the S7-200
goes automatically to STOP mode when power is restored. If a power cycle occurs when
the mode switch is set to RUN, the S7-200 goes to RUN mode when power is restored.

1 STEP 7-Micro/WIN allows you to change the operating mode of the online S7-200. To
enable the software to change the operating mode, you must manually set the mode switch
on the S7-200 to either TERM or RUN. You can use the PLC > STOP or PLC > RUN menu
commands or the associated buttons on the toolbar to change the operating mode.

1 You can insert the STOP instruction in your program to change the S7-200 to STOP mode.
This allows you to halt the execution of your program based on the program logic. For more
information about the STOP instruction, see Chapter 6.
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Using the S7-200 Explorer

The S7-200 Explorer is an extension to
the Windows Explorer application that
provides access to S7-200 PLCs and
allows the contents of each connected
PLC to be explored. The different blocks
that may reside in either the PLC or the
memory cartridge can be determined.
Properties are available for each block.

Since the S7-200 Explorer is an
extension to the Windows Explorer
application, standard Windows Figure 4-17  S7-200 Explorer
navigation and behaviors are supported.

The S7-200 Explorer is the mechanism used to read data log data stored within the memory
cartridge. Refer to Chapter 14 for more information about data logs.

The S7-200 Explorer can also be used to read or write user files to the memory cartridge. These
can be any type of files, Word documents, bitmap files, jpeg files, or STEP 7-Micro/WIN projects.

Features of the S7-200

40

The S7-200 provides several special features that allow you to customize how the S7-200
functions to better fit your application.

The S7-200 Allows Your Program to Immediately Read or Write the 1/O

The S7-200 instruction set provides instructions that immediately read from or write to the physical
1/0. These immediate I/O instructions allow direct access to the actual input or output point, even
though the image registers are normally used as either the source or the destination for 1/0O
accesses.

The corresponding process-image input register location is not modified when you use an
immediate instruction to access an input point. The corresponding process-image output register
location is updated simultaneously when you use an immediate instruction to access an output
point.

Tip
The S7-200 handles reads of analog inputs as immediate data, unless you enable analog input
filtering. When you write a value to an analog output, the output is updated immediately.

It is usually advantageous to use the process-image register rather than to directly access inputs
or outputs during the execution of your program. There are three reasons for using the image
registers:

1 The sampling of all inputs at the start of the scan synchronizes and freezes the values of
the inputs for the program execution phase of the scan cycle. The outputs are updated from
the image register after the execution of the program is complete. This provides a stabilizing
effect on the system.

[ Your program can access the image register much more quickly than it can access 1/O
points, allowing faster execution of the program.

1 /O points are bit entities and must be accessed as bits or bytes, but you can access the
image register as bits, bytes, words, or double words. Thus, the image registers provide
additional flexibility.
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The S7-200 Allows Your Program to Interrupt the Scan Cycle

If you use interrupts, the routines associated with each interrupt event are stored as part of the
program. The interrupt routines are not executed as part of the normal scan cycle, but are
executed when the interrupt event occurs (which could be at any point in the scan cycle).

Interrupts are serviced by the S7-200 on a first-come-first-served basis within their respective
priority assignments. See the Interrupt instructions in Chapter 6 for more information.

The S7-200 Allows You to Allocate Processing Time for Run Mode Edit
and Execution Status

You can configure a percentage of the scan cycle to be dedicated for processing a run mode edit
compilation or execution status. (Run mode edit and execution status are options provided by
STEP 7-Micro/WIN to make debugging your program easier.) As you increase the percentage of
time that is dedicated to these two tasks, you increase the scan time, which makes your control
process run more slowly.

The default percentage of the scan dedicated to processing run mode edits and execution status
is setto 10%. This setting was chosen to provide a reasonable compromise for processing the
compilation and status operations while minimizing the impact to your control process. You can
adjust this value by 5% increments up to a maximum of 50%. To set the scan cycle time-slice for
background communications:

1. Select the View > Component > System Block
system Block menu command na.T::sl_Bn‘il::t:r:\:'n':jeT\me selection permits canliguration of the amount of tine the PLC wil dedicale to background m
d S e I ect Backg ro u n d TI m e azllwlt'\jas ::unng RUN made. This feature is primarily used to control the scan impact during execution status amd mntine
an . edit operations.
System Block Background Time
2. Inthe Backg round tab, use the Ey gammumc;t\on Parts ’
etentive Ranges efaults
drop down box to select the S et ook |
- . o Tabks -
communications background time. | = et
3. Click OK to save your selection. bt e
-4 Corfigure LED =
4. Download the modified system  Inere Memery
block to the S7-200.
Canfiguration parameters must be: downlaaded befare they take effect
@) Click for Help and Support Ok | Concsl | Detaral

Figure 4-18 Communications Background Time
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The S7-200 Allows You to Set the States of Digital Outputs for Stop

Mode

The output table of the S7-200 allows you to determine whether to set the state of the digital
output points to known values upon a transition to the STOP mode, or to leave the outputs in the
state they were in before the transition to the STOP mode. The output table is part of the system
block that is downloaded and stored in the S7-200.

1.

Select the View > Component >
System Block menu command
and select Output Table. Click on
the Digital tab.

To freeze the outputs in their last
state, select the Freeze Outputs
checkbox.

To copy the table values to the
outputs, enter the output table
values by clicking the checkbox for
each output bit you want to set to
On (1) after a run-to-stop transition.
The default values of the table are
all zeroes.

Click OK to save your selections.

Download the modified system
block to the S7-200.

System Block
Digital Output Table

The Digital Output Table permits you to configure the ON and OFF states of each digital output on 2 RUM to STOP
C

tansition of the Pl

System Block
T Conmurication Ports
T Retentive Ranges
-4k Password

Digital | Analog |

I™ Freees Dulputs in last state:

Defaults

BSY Ouiput Tables ~States on Transifon from Fun to Stop
) g ‘;;:;FE":; s Marked oulputs will be DN when the PLE iansitions fiom RUN to STOP mode
L Background Time 7EE43210 76543210
£+ EM Configurations
- Canfigue LED qox | CCCC O nex |[COCCCOCT
T Increase Memony ol | CCCCCCCT gax (CCOCCCCCC
nzx | CCCCCCCT o CCCCCCCE
x| CCCCCCCC x| CCOCCCCCE
gdx | OO gi2x | C OO
o5 | OO x| C OO DO Cr
oex | CCCCCCCT oz CCCCCOC T
x| CCCCCCrrC gsx|CCCCCCCr
Configuration parameters must be downloaded before they take effect
€ Click for Help and Support 0K | Concel | Defautdl |

Figure 4-19 Digital Output Table

The S7-200 Allows You to Configure the Value of Analog Outputs

The Analog Output Table allows you to set analog output points to known values after a

RUN-to-STOP transition, or to preserve the output values that existed before the transition to
STOP mode. The Analog Output table is part of the system block that is downloaded and stored in
the S7-200 CPU.

1.

Select the View > Component >
System Block menu command
and select Output Table. Click on
the Analog tab.

To freeze the outputs in their last
state, select the Freeze Outputs
check box.

The Freeze Values table allows
you to set the analog outputs to a
known value (-32768 to 37262),
on a RUN-to-STOP transition.

Click OK to save your selections.

Download the modified system
block to the S7-200.

System Block ]
Analog Output Table
The fAnalog Output Table permits youto configure the value of s3ch analog output on a RUN to STOP hianshion of the
L
System Block Digital Analog
£ Communication Parts
-4 RAetenlive Ranges ™ Freeze Dutputsin last state: Defaults
o3 Password
{F Output Tables - Freeze
T Input Fikers
-4 Pube Caieh Bits
& g Tine w0 Agw1E[0 agwaz [0 Agw4g[0
£+ EM Configurations sawz [0 ATwE [0 AT [0 AQwSE[D
+i2 Lonfigue LED it [0 agwzn [0 2w o saws2[0
T Increase Memary
w0 Agwzz[o ARWEE [0 AQwSE[0
sawe: [0 Agwze[o ATwaD [0 AQwSE[D
AR [0 AQw2E[0 ARwaz [0 AQwsE[D
Agwi2 [0 AQw2s [0 ATwia [0 AQWEE[D
amwid o agwafo | agwasfo | smwez[o
Conliguration parameters must be downioaded before they take aifect
©) Click for Help and Support 0K | Cancel Default All

Figure 4-20 Analog Output Table

The S7-200 Allows You to Define Memory to Be Retained on Loss of

Power

You can define up to six retentive ranges to select the areas of memory you want to retain through
power cycles. You can define ranges of addresses in the following memory areas to be retentive:

V, M, C, and T. For timers, only the retentive timers (TONR) can be retained. The default setting for
the first 14 bytes of M Memory is to be non-retentive.

Only the current values for timers and counters can be retained: the timer and counter bits are not
retentive.
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Tip
Changing the range MBO0 to MB13 to be retentive enables a special feature that automatically
saves these locations to the permanent memory on power down.

To define the retentive memory: System Black B
Re;iee:.:nﬁenﬂa;gg:: allow you to define memory that will be mairtained in the event of a power cycle.
1. Select the View > Component >
System Block menu command g (=
and select Retentive Ranges. - RIS Betats
2. Select the ranges of memory tobe | & masiee e o e
. . -4k Pulze Catch Bits 33 Area sel umber of Elements
retained following loss of power = Barurc e Rage0 [0 =] b = Fim = | Cea
. arfigurations
and click OK. s EunhguvegLED Range1 [vB =l o = = Cleat
. £ Increase Memory — 0 j |32 :’ =
3. Download the modified system Forge :T j : S —e |
Range3 [T A 2] < 32 < Clear
block to the S7-200. e |
Aangz5  [mE = e = e = Clear
Configuration parameters must be downloaded before they take effect
&) Click for Help and Support [1]3 I Cancel Default &1

Figure 4-21 Retentive Memory

The S7-200 Allows You to Filter the Digital Inputs

The S7-200 allows you to select an input filter that defines a delay time (selectable from 0.2 ms to
12.8 ms) for some or all of the local digital input points. This delay helps to filter noise on the input
wiring that could cause inadvertent changes to the states of the inputs.

The input filter is part of the system block =TT 5
that is downloaded and stored in the "'?L‘Z;S‘"g‘?t!c"{;'ifémanc.ww oottt th st st i et bl 2 o e
. . . the
S7-200. The default filter time is 6.4 ms. ’
As shown in Figure 4-22, each delay et D |
spgmﬁcatnon applies to groups of input 2 P rs Defauts
pomts. T Output Tables ~Input Fiker Deley
EWY ot Fileers |
~{F Pulse Catch Bits
To configure the delay times for the input | & teurarine o 0 [se =] oe
ﬁ|ter: - EunhguvegLED 04-107 {640 =] ms
£ Increase Memory
no-113 [ean 7] ms
1. Select the View > Component > i 1 | EETZ
System Block menu command
and select Input Filters. Click on
the Digital tab.
Configuration parameters must be downloaded before they take effect
2. Enter the amount of delay for each
. . y &) Click for Help and Support 0K I Cancel Default &1
group of inputs and click OK.

3. Download the modified system

Figure 4-22 Digital Input Filter
block to the S7-200. 9 aratine

Tip
The digital input filter affects the input value as seen by instruction reads, input interrupts, and

pulse catches. Depending on your filter selection, your program could miss an interrupt event or
pulse catch. The high speed counters count the events on the unfiltered inputs.
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The S7-200 Allows You to Filter the Analog Inputs

¥

The S7-200 allows you to select software filtering on individual analog inputs. The filtered value is
the average value of a preselected number of samples of the analog input. The filter specification
(number of samples and deadband) is the same for all analog inputs for which filtering is enabled.

The filter has a fast response feature to allow large changes to be quickly reflected in the filter
value. The filter makes a step function change to the latest analog input value when the input
exceeds a specified change from the current value. This change, called the deadband, is
specified in counts of the digital value of the analog input.

The default configuration is to enable System Block ]
filtering for all analog inputs eXCGpt AIWO0 An:::gnlaz‘:;ng:;\’npm Filer s selected, the analog value used by the PLE is the average of the number of samples
taken, If the actual analog value excesds the average value by tore than the deacband. then the averags wil be reset
and AIW2 on CPU 224XP.
System Block Dighal Anslag
. £ Communication Parts
1. Select the View > Component > G e Nusoer o senples | ERL=] Defauks
svstem Block menu Command g \Dutﬁuélahles Deadband (16 - 4020, 0 = Disabled) [320 =]
. . npul Fiters - Select which Anslog Inputs t fter
and select Input Filters. Click on B P et s
sekareuns ime ¥ A0 ¥ awis ¥ Anwaz ¥ alw4g
the Analog tab. D Eoaore = AW W a3 7 Awa " Aws0
. nercase Meman P anwa 7 awz0 I A  Aws2
2. Selectthe analog mputs that you = e ¥ AWE v Alwzz v Alwae ¥ Alwsd
- ® awe = Az I aiwaa ¥ Awse
want to filter, the number of a0 ¥ Alw2E ¥ Az ¥ Alwsa
Samp|es and the deadband. = Az ¥ awas 7 Ahwad ¥ awed
’ A4 ¥ A0 ¥ Alwis ¥ Alwe2
3. Click OK. Select Al Clear All
4. Download the modified System Corfiquation parameters must be downloaded before they Lake sffect
block to the S7-200. © Click for Help and Support 0K || Cencel | Defaual

Figure 4-23 Analog Input Filter

Tip
Do not use the analog filter with modules that pass digital information or alarm indications in the

analog words. Always disable analog filtering for RTD, Thermocouple, and AS-Interface Master
modules.

Tip
AIWO0 and AIW2 on the CPU 224XP are filtered by the analog to digital converter, and usually
will not need the additional software filter.

The S7-200 Allows You to Catch Pulses of Short Duration

44

The S7-200 provides a pulse catch feature which can be used for some or all of the local digital
input points. The pulse catch feature allows you to capture high-going pulses or low-going pulses
that are of such a short duration that they would not always be seen when the S7-200 reads the
digital inputs at the beginning of the scan cycle. When pulse catch is enabled for an input, a
change in state of the input is latched and held until the next input cycle update. This ensures that
a pulse which lasts for a short period of time is caught and held until the S7-200 reads the inputs.

You can individually enable the pulse Sysien Block
catch operation for each of the local e Pkt Bt sy i it ot v st sinl s, Ui, s o
. . the input will be lached until read by the PLC scan.
digital inputs.
sstem Block ulee Catch Bits
To access the pulse catch configuration Bl
p g {TF Retentive Ranges Defauls
. - Password
Screen . g Output Tables I
Input Filters
. g F'LEE.I\:h Bits I 100 rna J= 20
1. Select the View > Component > G tekgandTine ot i o2
System Block menu command =feat F s F o
and select Pulse Catch Bits. e e il
I ios 15 =25
2. Click the corresponding check box r s i |76
and Cllck OK o7 | il =27
. Select All Clear All
3. Download the modified system s | o]
blOCk to the S7'200 i Canfiguration parameters must be downloaded before they take effect.
) Click for Help and Suppart 0K | Cencel | Defaurdl

Figure 4-24 Pulse Catch
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Figure 4-25 shows the basic operation of the S7-200 with and without pulse catch enabled.

Scan cycle ‘ Next scan cycle

[

Physical Input

The S7-200 misses this pulse because the input
turned on and off before the S7-200 updated the
process-image input register

Output from
pulse catch ‘

Disabled |

\
Enabled

T Input update T Input update
\ \
| \
\ \
\
\
\

The S7-200 catches the pulse on the physical input

Figure 4-25 Operation of the S7-200 with the Pulse Catch Feature Enabled and Disabled

Because the pulse catch function operates on the input after it passes through the input filter, you
must adjust the input filter time so that the pulse is not removed by the filter. Figure 4-26 shows a

block diagram of the digital input circuit.

, — e ———— ]
( ) Optical Digital Input Pulse
Isolation Filter ' Catch —={ Inputto 37-200J|

External ﬁ
Digital Input Pulse Catch Enable

Figure 4-26  Digital Input Circuit

Figure 4-27 shows the response of an enabled pulse catch function to various input conditions. If

you have more than one pulse in a given scan, only the first pulse is read. If you have multiple
pulses in a given scan, you should use the rising/falling edge interrupt events. (For a listing of
interrupt events, see Table 6-46.)

Scan cycle Next scan cycle
Input update Input update
Input to pulse catch J I
\
Output from pulse catch
|
Input to pulse catch LI ‘

i

\ \

Outputfrompulsecatch T |
\

Input to pulse catch ‘ I_;_l
i

Output from pulse catch

Figure 4-27 Responses of the Pulse Catch Function to Various Input Conditions
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The S7-200 Provides a User-Controlled LED

The S7-200 provides an LED (SF/DIAG) that can indicate red (system fault LED) or yellow
(diagnostic LED). The diagnostic LED can be illuminated under user program control, or can
automatically illuminate under certain conditions: when an 1/O point or data value is forced, or

when a module has an I/O error.

To configure the automatic selections for
the diagnostic LED:

1. Select the View > Component >
System Block menu command
and select Configure LED.

2. Click each item to either enable or
disable turning on the LED when
an I/O point or data value is forced,
or when a module has an /O error.

3. Download the modified system
block to the S7-200.

To control the state of the diagnostic LED
with your user program, use the
Diagnostic LED instruction in Chapter 6.

System Block

Configure LED

enor oceurs. This LED can alsa be controlled by using the DLED instruction.

System Block
T Conmurication Ports

Configure LED:

T Retentive Ranges
- Password

4O Output Tables

4 Input Fiters
- Pulse Catch Bits
3 Background Time
i E

The LED labeled SF/DIAG [System Fault / Diagnostics) can be configured ta bun on when a value is forced or an /0
Defaults

- LED Dptio

The LED labeled SF/DIAG (Spstem Fault / Diagonstic] can be configured to tun yellow
for diagnostic when certain events occur. The LED labeled SF/DIAG (System Faul /
Diagonstic] can be configured to tum yellow for diagnostic when certain events occur

¥ Tum onLED when an item s forced in the PLC

™ TumonLED when a module has an 140 enar

Configuation parameters must be downloaded before they take effect

The S7-200 Maintains a History Log of Major CPU Events

The S7-200 maintains a log that contains
a time-stamped history of major CPU
events, such as when power is applied,
when the CPU enters RUN mode, and
when fatal errors occur. Your time-of-day
clock must be configured in order to get
valid time and date stamps on the log
entries.

To view the Event History log, select the
PLC > Information menu command and
select Event History.

) Click for Help and Support 0K | Cencel Defaul Al
Figure 4-28 Diagnostic LED
Date | Time | Tppe | Errar |
04/05/04 (02:26:43 Transition to RUM
04405404 02:26:43 Paower up
04/05/04 (02:26:25 Transition to RUN
04/05/04 02:26:24 Paower up

Clase

Figure 4-29 Viewing the Event History Log

The S7-200 Allows You to Increase Your Available User Program

Memory

The S7-200 allows you to disable the run
mode edit feature in the CPU 224,

CPU 224XP, and CPU 226 in order to
increase the amount of program memory
available for your use. Refer to Table 1-1
to see the amount of program memory
for each CPU model.

To disable the run mode edit feature,
follow these steps

1. Select the View > System Block
menu command and select
Increase Program Memory.

2. Click the Increase Memory item to
disable the run mode edit feature.

3. Download the modified system
block to the S7-200.

46

System Block
Program Edit in Run
By disabling AL Made Ed, you can increase the available memon i your Program Black, Na addional Data Block
ey i avaieble
System Block, Increase Wemary
42F Conmurication Ports
L ftontive Ranges W Dissble Edtin Fun to Increase Memory Defauts
£ Pessword
42F Output Tables emory Avalab
o Input Filers
42 Pulse Calch Bis
o Background Tine Inceasing avaible memory in the program block il dsable RUN Moda eck
£F EM Configraliors:
42 Conligure LED
3 Incresse Memany Wit Run Mads Edic 8192 byles
Without Fun bode Edi 12288 bytes
Corfigustion paramezers must be downloaded before they take effect
) Click for Help and Support 0K | Cencel Deefault Al

Figure 4-30 Disable Run Mode Edit
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The S7-200 Provides Password Protection
All models of the S7-200 provide password protection for restricting access to specific functions.

¥

A password authorizes access to the functions and memory: without a password, the S7-200
provides unrestricted access. When it is password protected, the S7-200 limits all restricted
operations according to the configuration provided when the password was installed

The password is not case-sensitive.

As shown in Table 4-3, the S7-200 provides four levels of access restriction. Each level allows
certain functions to be accessible without a password. For the four levels of access, entering the
correct password provides access to the functions as noted below. The default condition for the

S7-200 is level 1 (no restriction).

Entering the password over a network does not compromise the password protection for the

S7-200.

You can in effect, disable the password by changing the password level 4, 3, or 2 to Level 1, since

Level 1 allows all unrestricted CPU access.

Table 4-3 Restricting Access to the S7-200

CPU Function Level 1 Level 2

Level 3

Level 4

Read and write user data

Start, Stop, and Power-Up Reset
of the CPU

Read and write the time-of-day
Clock

Upload the user program, data,
and the CPU configuration

Download of Program Block, Data
Block or System Block

Runtime Edits

Delete of Program Block, Data

Block, or System Data Block Access allowed

Copy of Program Block, Data
Block, or System Data Block to the
memory cartridge

Password
required
Force data in status chart

Execute the single or multiple scan

Writing of output in STOP mode

Reset of scan rates in PLC
information

Execution status

Project compare

Access allowed

Access allowed

Password
required

Access allowed

Never allowed

Password
required (Never
allowed for
System Block)

Never allowed

Password
required (Never
allowed for
System Block)

Password
required

Never allowed

Having one user authorized to access restricted functions Reset of Scan Rates in PLC information
does not authorize other users to access those functions. Only one user is allowed unrestricted

access to the S7-200 at a time.

Tip

After you enter the password, the authorization level for that password remains effective for up
to one minute after the programming device has been disconnected from the S7-200. Always
exit STEP 7-Micro/WIN before disconnecting the cable to prevent another user from accessing

the privileges of the programming device.
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Configuring a Password for the S7-200

The System Block dialog box (Figure 4-31) allows you to configure a password for the S7-200.
The default condition for the S7-200 is set at Full (Level 1), no restriction.

1. Select the View > Component > ptemuede

System Block menu command to pMH’o‘::’:IimdIheI"a:s»otdpti'iewsaiows|mla(:vwolncce:nnd-wicsionbolhr‘i.
display the System Block dialog
box and select Password. O e |
¥ Retendive Rages s
2. Select the appropriate level of o _ ———
access for the S7-200. Do © e
. O Background T T Postial [Level 2§
3. Enter and verify the password for oo BliooienE)
Partial (Level 2) or Minimum s Hosory _
(Level 3). | ]
4. Click OK. Pl Privisgas. A PLE hanctioess 6 &valdable withoud radtichon.
5. Download the modified system
block to the S7-200. P— = pE———
) Click for Help and Suppart N Deima s |

Figure 4-31 Creating a Password

Recovering from a Lost Password

If you forget the password, you must clear the memory of the S7-200 and reload your program.
Clearing the memory puts the S7-200 in STOP mode and resets the S7-200 to the factory-set
defaults, except for the network address, baud rate, and the time-of-day clock. To clear your
program in the S7-200:

1. Selectthe PLC > Clear menu command to display the Clear dialog box.
2. Select all three blocks and confirm your action by clicking OK.

3. Ifa password had been configured, STEP 7-Micro/WIN displays a password-authorization
dialog box. To clear the password, enter CLEARPLC in the password-authorization dialog
box to continue the Clear All operation. (The CLEARPLC password is not case sensitive.)

The Clear All operation does not remove the program from a memory cartridge. Since the memory
cartridge stores the password along with the program, you must also reprogram the memory
cartridge to remove the lost password.

Warning
' Clearing the S7-200 memory causes the outputs to turn off (or in the case of an analog output,
* to be frozen at a specific value).

If the S7-200 is connected to equipment when you clear the memory, changes in the state of the
outputs can be transmitted to the equipment. If you had configured the “safe state” for the
outputs to be different from the factory settings, changes in the outputs could cause
unpredictable operation of your equipment, which in turn could cause death or serious injury to
personnel, and/or damage to equipment.

Always follow appropriate safety precautions and ensure that your process is in a safe state
before clearing the S7-200 memory.
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The S7-200 Provides Analog Adjustment Potentiometers

The analog adjustment potentiometers are located under the front access cover of the module.
You can adjust these potentiometers to increase or decrease values that are stored in bytes of
Special Memory (SMB). These read-only values can be used by the program for a variety of
functions, such as updating the current value for a timer or a counter, entering or changing the
preset values, or setting limits. Use a small screwdriver to make the adjustments: turn the
potentiometer clockwise (to the right) to increase the value, and counterclockwise (to the left) to
decrease the value.

SMB28 holds the digital value that represents the position of analog adjustment 0. SMB29 holds
the digital value that represents the position of analog adjustment 1. The analog adjustment has a
nominal range of 0 to 255 and a repeatability of +2 counts.

Sample Program for Referencing the Value Entered with the Analog Adjustment Potentiometers

Network 1 Network 1 //Read analog adjustment 0 (SMB28).
10 Bl //Save the value as an integer in VW100.

—en  Eenol—3y LD 10.0

BTI SMB28, VW100

SMB284IM QUT w100

Network 2 //Use the integer value (VW100) as
/la preset for a timer.

LDN Q0.0

Metwork 2
Q0o 14 TON  T33, VW100
— + |—~ 7w
Network 3 /[Turn on Q0.0 when T33 reaches
W 004PT__ 10ms /[the preset value.
LD T33
= Q0.0
Metwork 3
733 oo.o

The S7-200 Provides High-speed 1/O

High-Speed Counters

The S7-200 provides integrated high-speed counter functions that count high speed external
events without degrading the performance of the S7-200. See Appendix A for the rates supported
by your CPU model. Each counter has dedicated inputs for clocks, direction control, reset, and
start, where these functions are supported. You can select different quadrature modes for varying
the counting rate. For more information on high-speed counters, see Chapter 6.

High-Speed Pulse Output

The S7-200 supports high-speed pulse outputs, with outputs Q0.0 and Q0.1 generating either a
high-speed pulse train output (PTO) or pulse width modulation (PWM).

The PTO function provides a square wave (50% duty cycle) output for a specified number of
pulses (from 1 to 4,294,967,295 pulses) and a specified cycle time (in either microsecond or
millisecond increments. You can program the PTO function to produce either one train of pulses or
a pulse profile consisting of multiple trains of pulses. For example, you can use a pulse profile to
control a stepper motor through a simple ramp up, run, and ramp down sequence or more
complicated sequences.

The PWM function provides a fixed cycle time with a variable duty cycle output, with the cycle time
and the pulse width specified in either microsecond or millisecond increments. When the pulse
width is equal to the cycle time, the duty cycle is 100 percent and the output is turned on
continuously. When the pulse width is zero, the duty cycle is 0 percent and the output is turned off.

For more information on the high-speed pulse output instruction, see Chapter 6. For more
information about using PTO in open loop motion control, see Chapter 9.
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Programming Concepts, Conventions,

and Features

The S7-200 continuously executes your program to control a task or process. You use

STEP 7-Micro/WIN to create this program and download it to the S7-200. STEP 7-Micro/WIN

provides a variety of tools and features for designing, implementing, and debugging your program.

In This Chapter

Guidelines for Designing a Micro PLC System . ... i

Basic Elements of a Program ........

Using STEP 7-Micro/WIN to Create Your Programs ..............ccoiiiiiiniennnann..
Choosing Between the SIMATIC and IEC 1131-3 Instruction Sets ......................
Understanding the Conventions Used by the Program Editors ..........................
Using Wizards To Help You Create Your Control Program . ............... ... ... ......

Handling Errors in the S7-200 .......

Assigning Addresses and Initial Values in the Data Block Editor ........................
Using the Symbol Table for Symbolic Addressing of Variables ..........................

Using Local Variables ..............

Using the Status Chart to Monitor Your Program . ... ...

Creating an Instruction Library .......

Features for Debugging Your Program
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Guidelines for Designing a Micro PLC System

There are many methods for designing a Micro PLC system. The following general guidelines can
apply to many design projects. Of course, you must follow the directives of your own company’s
procedures and the accepted practices of your own training and location.

Partition Your Process or Machine

Divide your process or machine into sections that have a level of independence from each other.
These partitions determine the boundaries between controllers and influence the functional
description specifications and the assignment of resources.

Create the Functional Specifications

Write the descriptions of operation for each section of the process or machine. Include the
following topics: 1/O points, functional description of the operation, states that must be achieved
before allowing action for each actuator (such as solenoids, motors, and drives), description of the
operator interface, and any interfaces with other sections of the process or machine.

Design the Safety Circuits

Identify equipment requiring hard-wired logic for safety. Control devices can fail in an unsafe
manner, producing unexpected startup or change in the operation of machinery. Where
unexpected or incorrect operation of the machinery could result in physical injury to people or
significant property damage, consideration should be given to the use of electro-mechanical
overrides which operate independently of the S7-200 to prevent unsafe operations. The following
tasks should be included in the design of safety circuits:

1 Identify improper or unexpected operation of actuators that could be hazardous.

1 Identify the conditions that would assure the operation is not hazardous, and determine how
to detect these conditions independently of the S7-200.

1 Identify how the S7-200 CPU and I/O affect the process when power is applied and
removed, and when errors are detected. This information should only be used for designing
for the normal and expected abnormal operation, and should not be relied on for safety
purposes.

1 Design manual or electro-mechanical safety overrides that block the hazardous operation
independent of the S7-200.

1 Provide appropriate status information from the independent circuits to the S7-200 so that
the program and any operator interfaces have necessary information.

1 Identify any other safety-related requirements for safe operation of the process.

Specify the Operator Stations

Based on the requirements of the functional specifications, create drawings of the operator
stations. Include the following items:

1 Overview showing the location of each operator station in relation to the process or
machine

1 Mechanical layout of the devices, such as display, switches, and lights, for the operator
station

1 Electrical drawings with the associated 1/O of the S7-200 CPU or expansion module
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Create the Configuration Drawings

Based on the requirements of the functional specification, create configuration drawings of the

control equipment. Include the following items:

1 Overview showing the location of each S7-200 in relation to the process or machine

1 Mechanical layout of the S7-200 and expansion 1/0 modules (including cabinets and other

equipment)

1 Electrical drawings for each S7-200 and expansion I/O module (including the device model
numbers, communications addresses, and 1/0O addresses)

Create a List of Symbolic Names (optional)

If you choose to use symbolic names for addressing, create a list of symbolic names for the
absolute addresses. Include not only the physical I/O signals, but also the other elements to be

used in your program.

Basic Elements of a Program

A program block is composed of executable code and comments. The executable code consists
of a main program and any subroutines or interrupt routines. The code is compiled and
downloaded to the S7-200; the program comments are not. You can use the organizational
elements (main program, subroutines, and interrupt routines) to structure your control program.

The following example shows a program that includes a subroutine and an interrupt routine. This
sample program uses a timed interrupt for reading the value of an analog input every 100 ms.

Example:Basic Elements of a Program

Main Program

M || network 1
A SM0 1 ERET
(] —
N
S Network 1
B SO0 MOV_B
I
(F)l — | EN ENOH
10041K QUTFSMBS4
ATCH
EN ENO%
NT_0qinT
104EVhT
—( eni)
| Network 1
N 5M0.0 MOV_W
T H B———An enop—y
0
Al 1IN QUTEY 100

Network 1 //On first scan, call subroutine 0.

LD SMO.1
CALL SBR_0

Network 1 //Set the interval to 100 ms
/[for the timed interrupt.
//[Enable interrupt 0.

LD SMO0.0

MOVB 100, SMB34

ATCH INT_O, 10

ENI

Network 1 //Sample the Analog Input 4.

LD SMo0.0
MOVW  AlwW4,VW100

The main body of the program contains the instructions that control your application. The S7-200
executes these instructions sequentially, once per scan cycle. The main program is also referred

to as OB1.
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Subroutines

These optional elements of your program are executed only when called: by the main program, by
an interrupt routine, or by another subroutine. Subroutines are useful in cases where you want to
execute a function repeatedly. Rather than rewriting the logic for each place in the main program
where you want the function to occur, you can write the logic once in a subroutine and call the
subroutine as many times as needed during the main program. Subroutines provide several
benefits:

[ Using subroutines reduces the overall size of your program.

1 Using subroutines decreases your scan time because you have moved the code out of the
main program. The S7-200 evaluates the code in the main program every scan cycle,
whether the code is executed or not, but the S7-200 evaluates the code in the subroutine
only when you call the subroutine, and does not evaluate the code during the scans in
which the subroutine is not called.

1 Using subroutines creates code that is portable. You can isolate the code for a function in a
subroutine, and then copy that subroutine into other programs with little or no rework.

Tip

@ Using V memory addresses can limit the portability of your subroutine, because it is possible for
V memory address assignment from one program to conflict with an assignment in another
program. Subroutines that use the local variable table (L memory) for all address assignments,
by contrast, are highly portable because there is no concern about address conflicts between
the subroutine and another part of the program when using local variables.

Interrupt Routines

These optional elements of your program react to specific interrupt events. You design an interrupt
routine to handle a pre-defined interrupt event. Whenever the specified event occurs, the S7-200
executes the interrupt routine.

The interrupt routines are not called by your main program. You associate an interrupt routine with
an interrupt event, and the S7-200 executes the instructions in the interrupt routine only on each
occurrence of the interrupt event.

Tip

@ Because it is not possible to predict when the S7-200 might generate an interrupt, it is desirable
to limit the number of variables that are used both by the interrupt routine and elsewhere in the
program.

Use the local variable table of the interrupt routine to ensure that your interrupt routine uses only
the temporary memory and does not overwrite data used somewhere else in your program.

There are a number of programming techniques you can use to ensure that data is correctly
shared between your main program and the interrupt routines. These techniques are described
in Chapter 6 with the Interrupt instructions.

Other Elements of the Program

Other blocks contain information for the S7-200. You can choose to download these blocks when
you download your program.

System Block
The system block allows you to configure different hardware options for the S7-200.

Data Block

The data block stores the values for different variables (V memory) used by your program. You
can use the data block to enter initial values for the data.
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Using STEP 7-Micro/WIN to Create Your Programs

Program
Editor

To open STEP 7-Micro/WIN, double-click on the STEP 7-Micro/WIN icon, or select the Start >
SIMATIC > STEP 7 MicroWIN V4.0 menu command. As shown in Figure 5-1, the

STEP 7-Micro/WIN project window provides a convenient working space for creating your control
program.

The toolbars provide buttons for shortcuts to frequently used menu commands. You can view or
hide any of the toolbars.

The navigation bar presents groups of e 228

Fia [t Vs PAC Debig Tooh ‘wirckes b

icons for accessing different R T I DO - A A

programming features of = T A XA K B> o e lueon
STEP 7-Micro/WIN. T —————

7 3 D T D 5 D 3
Syt [ Vslwe | Gwatpee | )
e

The instruction tree displays all of the
project objects and the instructions for
creating your control program. You can
drag and drop individual instructions
from the tree into your program, or you
can double-click an instruction to insert it
at the current location of the cursor in the
program editor.

Program Editor I

Instruction tree I

Navigation bar I

The program editor contains the program
logic and a local variable table where
you can assign symbolic names for
temporary local variables. Subroutines _ L
and interrupt routines appear as tabs at

the bottom of the program editor window.

Click on the tabs to move between the Figure 5-1  STEP 7-Micro/WIN

subroutines, interrupts, and the main

program.

STEP 7-Micro/WIN provides three editors for creating your program: Ladder Logic (LAD),
Statement List (STL), and Function Block Diagram (FBD). With some restrictions, programs
written in any of these program editors can be viewed and edited with the other program editors.

Features of the STL Editor

The STL editor displays the program as a text-based language. The STL editor allows you to
create control programs by entering the instruction mnemonics. The STL editor also allows you to
create programs that you could not otherwise create with the LAD or FBD editors. This is because
you are programming in the native language of the S7-200, rather than in a graphical editor where
some restrictions must be applied in order to draw the diagrams correctly. As shown in Figure 5-2,
this text-based concept is very similar to assembly language programming.

The S7-200 executes each instruction in
the order dictated by the program, from

LD 10.0 //Read one input
top t
tgg 0 bottom, and then restarts at the A 0.1 J/AND with another input
’ = Q1.0 //Write value to output 1
STL uses a logic stack to resolve the
control logic. You insert the STL
instructions for handling the stack Figure 5-2 Sample STL Program

operations.
Consider these main points when you select the STL editor:

[ STL is most appropriate for experienced programmers.

STL sometimes allows you to solve problems that you cannot solve very easily with the
LAD or FBD editor.

|
1 You can only use the STL editor with the SIMATIC instruction set.
|

While you can always use the STL editor to view or edit a program that was created with the
LAD or FBD editors, the reverse is not always true. You cannot always use the LAD or FBD
editors to display a program that was written with the STL editor.
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Features of the LAD Editor

The LAD editor displays the program as a graphical representation similar to electrical wiring
diagrams. Ladder programs allow the program to emulate the flow of electric current from a power
source through a series of logical input conditions that in turn enable logical output conditions. A
LAD program includes a left power rail that is energized. Contacts that are closed allow energy to
flow through them to the next element, and contacts that are open block that energy flow.

The logic is separated into networks.
The program is executed one network at
a time, from left to right and then top to
bottom as dictated by the program.
Figure 5-3 shows an example of a LAD
program. The various instructions are
represented by graphic symbols and
include three basic forms.

Contacts represent logic input conditions
such as switches, buttons, or internal
conditions.

Hetwork 1
0.0

Hetwork 2

12.1

H

MOV_B

EM  EMNO

EMN

SWAP

ENO—)|
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M OUTEACO ACOqIN

Coils usually represent logic output
results such as lamps, motor starters,
interposing relays, or internal output
conditions.

Figure 5-3  Sample LAD Program

Boxes represent additional instructions, such as timers, counters, or math instructions.
Consider these main points when you select the LAD editor:

Ladder logic is easy for beginning programmers to use.
Graphical representation is easy to understand and is popular around the world.
The LAD editor can be used with both the SIMATIC and IEC 1131-3 instruction sets.

You can always use the STL editor to display a program created with the SIMATIC LAD
editor.

Uooo

Features of the FBD Editor

The FBD editor displays the program as a graphical representation that resembles common logic
gate diagrams. There are no contacts and coils as found in the LAD editor, but there are
equivalent instructions that appear as box instructions.

Figure 5-4 shows an example of an FBD
program.

21 AND  —IN TOM
FBD does not use the concept of left and ¥50.0

right power rails; therefore, the term ACO—{PT
“power flow” is used to express the

analogous concept of control flow Fiqure5-4  Sample FBD Program

through the FBD logic blocks.

The logic “1” path through FBD elements is called power flow. The origin of a power flow input and
the destination of a power flow output can be assigned directly to an operand.

The program logic is derived from the connections between these box instructions. That is, the
output from one instruction (such as an AND box) can be used to enable another instruction (such
as a timer) to create the necessary control logic. This connection concept allows you to solve a
wide variety of logic problems.

Consider these main points when you select the FBD editor:
O The graphical logic gate style of representation is good for following program flow.
1 The FBD editor can be used with both the SIMATIC and IEC 1131-3 instruction sets.

1 You can always use the STL editor to display a program created with the SIMATIC FBD
editor.
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Choosing Between the SIMATIC and IEC 1131-3 Instruction Sets

Most PLCs offer similar basic instructions, but there are usually small differences from vendor to
vendor in appearance, operation, and so forth. Over the last several years, the International
Electrotechnical Commission (IEC) has developed an emerging global standard that specifically
relates to many aspects of PLC programming. This standard encourages different PLC
manufacturers to offer instructions that are the same in both appearance and operation.

Your S7-200 offers two instruction sets that allow you to solve a wide variety of automation tasks.
The IEC instruction set complies with the IEC 1131-3 standard for PLC programming, and the
SIMATIC instruction set is designed specifically for the S7-200.

Tip
@ When STEP 7-Micro/WIN is set to the IEC mode, it displays a red diamond (#) in the Instruction
Tree beside the instructions that are not defined by the IEC 1131-3 standard.

There are a few key differences between the SIMATIC instruction set and the IEC instruction set:

1 The IEC instruction set is restricted to those instructions that are standard among PLC
vendors. Some instructions that are normally included in the SIMATIC set are not standard
instructions in the IEC 1131-3 specification. These are still available for use as
non-standard instructions, but if you use them, the program is no longer strictly IEC 1131-3
compatible.

1 Some IEC box instructions accept multiple data formats. This practice is often referred to as
overloading. For example, rather than have separate ADD_I (Add Integer) and ADD_R (Add
Real), math boxes, the IEC ADD instruction examines the format of the data being added
and automatically chooses the correct instruction in the S7-200. This can save valuable
program design time.

1 When you use the IEC instructions, the instruction parameters are automatically checked
for the proper data format, such as a signed integer versus an unsigned integer. For
example, an error results if you try to enter an integer value for an instruction that expected
a bit value (on/off). This feature helps to minimize programming syntax errors.

Consider these points when you select either the SIMATIC or the IEC instruction set:

1 SIMATIC instructions usually have the shortest execution times. Some IEC instructions
might have longer execution times.

1 Some IEC instructions, such as timers, counters, multiply, and divide, operate differently
than their SIMATIC counterparts.

1 You can use all three program editors (LAD, STL, FBD) with the SIMATIC instruction set.
You can use only the LAD and FBD program editors for IEC instructions.

1 The operation of the IEC instructions is standard for different brands of PLCs, and the
knowledge about creating an IEC-compliant program can be leveraged across PLC
platforms.

1 While the IEC standard defines fewer instructions than are available in the SIMATIC
instruction set, you can always include SIMATIC instructions in your IEC program.

1 |EC 1131-3 specifies that variables must be declared with a type, and supports system
checking of data type.
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Understanding the Conventions Used by the Program Editors

STEP 7-Micro/WIN uses the following conventions in all of the program editors:

O A#infront of a symbol name (#var1) indicates that the symbol is of local scope.
1 ForIEC instructions, the % symbol indicates a direct address.
1 The operand symbol “?.?” or “????” indicates that an operand configuration is required.

LAD programs are divided into segments called networks. A network is an ordered arrangement
of contacts, coils, and boxes that are all connected to form a complete circuit: no short circuits, no
open circuits, and no reverse power flow conditions exist. STEP 7-Micro/WIN allows you to create
comments for your LAD program on a network-by-network basis. FBD programming uses the
network concept for segmenting and commenting your program.

STL programs do not use networks; however, you can use the NETWORK keyword to segment
your program.

Conventions Specific to the LAD Editor

In the LAD editor, you can use the F4, F6, and F9 keys on your keyboard to access contact, box,
and coil instructions. The LAD editor uses the following conventions:

1 The symbol “--->>"is an open circuit or a required power flow connection.

[J The symbol “¥” indicates that the output is an optional power flow for an instruction that
can be cascaded or connected in series.

1 The symbol “>>” indicates that you can use power flow.

Conventions Specific to the FBD Editor

In the FBD editor, you can use the F4, F6, and F9 keys on your keyboard to access AND, OR,
and box instructions. The FBD editor uses the following conventions:

1 The symbol “--->>" on an EN operand is a power flow or operand indicator. It can also
depict an open circuit or a required power flow connection.

[J The symbol “—¥” indicates that the output is an optional power flow for an instruction that
can be cascaded or connected in series.

1 The symbols “<<” and “>>” indicate that you

can use either a value or power flow. é%%gﬁilo':o-r :ng AND =@00
1O Negation bubbles: The logical NOT condition

or inverted condition of the operand or power Immediate moH AND aoo

flow is shown by the small circle on the input. Condition 01—

In Figure 5-5, Q0.0 is equal to the NOT of 10.0
AND 10.1. Negation bubbles are only valid for
Boolean signals, which can be specified as Figure 55 FBD Conventions
parameters or power flow.

1 Immediate indicators: As shown in Figure 5-5, the FBD editor displays an immediate
condition of a Boolean operand with a vertical line on the input to an FBD instruction. The
immediate indicator causes an immediate read from the specified physical input. Immediate
operators are only valid for physical inputs.

1 Box with no input or output: A box with no input indicates an instruction that is independent
of power flow.

Tip
@ The number of operands can be expanded up to 32 inputs for AND and OR instructions. To add

or subtract operand tics, use the “+” and “-” keys on your keyboard.
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General Conventions of Programming for an S7-200

EN/ENO Definition

EN (Enable IN) is a Boolean input for boxes in LAD and FBD. Power flow must be present at this
input for the box instruction to be executed. In STL, the instructions do not have an EN input, but
the top of stack value must be a logic “1” for the corresponding STL instruction to be executed.

ENO (Enable Out) is a Boolean output for boxes in LAD and FBD. If the box has power flow at the
EN input and the box executes its function without error, then the ENO output passes power flow
to the next element. If an error is detected in the execution of the box, then power flow is
terminated at the box that generated the error.

In STL, there is no ENO output, but the STL instructions that correspond to the LAD and FBD
instructions with ENO outputs do set a special ENO bit. This bit is accessible with the AND ENO
(AENO) instruction and can be used to generate the same effect as the ENO bit of a box.

Tip
@ The EN/ENO operands and data types are not shown in the valid operands table for each
instruction because the operands are the same for all LAD and FBD instructions. Table 5-1 lists
these operands and data types for LAD and FBD. These operands apply to all LAD and FBD
instructions shown in this manual.

Table 5-1 EN/ENO Operands and Data Types for LAD and FBD

Program Editor  Inputs/Outputs Operands Data Types
LAD EN, ENO Power Flow BOOL
FBD EN, ENO ,Q,V,M,SM,S, T,C, L BOOL

Conditional/Unconditional Inputs

In LAD and FBD, a box or a coil that is dependent upon power flow is shown with a connection to
any element on the left side. A coil or box that is independent of power flow is shown with a
connection directly to the left power rail. Table 5-2 shows an example of both a conditional and an
unconditional input.

Table 5-2 Representation of Conditional and Unconditional Inputs

Power Flow LAD FBD
Instruction that is dependent on power flow (conditional) 1
—{ Jwr)

Instruction that is independent of power flow (unconditional) | :NE XW)

JiP

MEXT

Instructions without Outputs

Boxes that cannot cascade are drawn with no Boolean outputs. These include the Subroutine
Call, Jump, and Conditional Return instructions. There are also ladder coils that can only be
placed on the left power rail. These include the Label, Next, Load SCR, Conditional SCR End, and
SCR End instructions. These are shown in FBD as boxes and are distinguished with unlabeled
power inputs and no outputs.

Compare Instructions

The compare instruction is executed regardless of the state of power flow. If power flow is false,
the output is false. If power flow is true, the output is set depending upon the result of the
compare. SIMATIC FBD, IEC Ladder, and IEC FBD compare instructions are shown as boxes,
although the operation is performed as a contact.
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Using Wizards To Help You Create Your Control Program

STEP 7-Micro/WIN provides wizards to make aspects of your programming easier and more
automatic. In Chapter 6, instructions that have an associated wizard are identified by the following
Instruction Wizard icon:

Instruction
Wizard

Handling Errors in the S7-200
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The S7-200 classifies errors as either fatal errors or non-fatal errors. You can view the error codes
that were generated by an error by selecting the PLC > Information menu command.

Figure 5-6 shows the PLC Information
dialog box tha_t d_isplays the error code Dperating Mode [ siop
and the description of the error. ~ersion Scan Rates (ms)
PLC: CPU 222 EXP 0103 REL 01.11 Last: a
The Last Fatal field shows the previous Fimpare: 011 Minimum: o
fatal error code generated by the ASIC: 01.00 Masimm: o
S7-200. This value is retained over -
pOWGI‘ CyCleS |f the RAM |S retalned ThIS Fatal 1] ‘Nufalal enors present.
location is cleared either whenever all Mo Fatal [0 Nonondatal erors present
memory of the S7-200 is cleared or if the
RAM is not retained after a prolonged Lt Faal [0 Wafatal snors present
power Outage. Total Fatak i]
The Total Fatal field is the count of fatal e
. Mumber of Erors [0
errors generated by the S7-200 since the | [ _
) rors Reported: INo 1/0 emars present. j

last time the S7-200 had all memory
areas cleared. This value is retained ——— 0 R T e T
over power cycles if the RAM is retained. LT ER R o e

. . . 1] Mot present
This location is cleared whenever all 1 Nt present
memory of the S7-200 is cleared, or : o e
when the RAM is not retained after a : o et
prolonged power outage. 8 Not presert

Appendlx C ||Sts the 87'200 error COdeSs Ebd InfGrmation... | Reset Scan Rates |
and Appendix D describes the special

memory (SM) bits, which can be used for _ ! .
monitoring errors. Figure 5-6  PLC Information Dialog Box

Non-Fatal Errors

Non-fatal errors are those indicating problems with the construction of the user program, with the
execution of an instruction in the user program, and with expansion 1/O modules. You can use
STEP 7-Micro/WIN to view the error codes that were generated by the non-fatal error. There are
three basic categories of non-fatal errors.

Program-compile errors

The S7-200 compiles the program as it downloads. If the S7-200 detects that the program violates
a compilation rule, the download is aborted and an error code is generated. (A program that was
already downloaded to the S7-200 would still exist in the permanent memory and would not be
lost.) After you correct your program, you can download it again. Refer to Appendix C for a list of
compile rule violations.

I/O errors

At startup, the S7-200 reads the I/O configuration from each module. During normal operation, the
S7-200 periodically checks the status of each module and compares it against the configuration
obtained during startup. If the S7-200 detects a difference, the S7-200 sets the configuration error
bit in the module error register. The S7-200 does not read input data from or write output data to
that module until the module configuration again matches the one obtained at startup.
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The module status information is stored in special memory (SM) bits. Your program can monitor
and evaluate these bits. Refer to Appendix D for more information about the SM bits used for
reporting 1/O errors. SM5.0 is the global I/O error bit and remains set while an error condition
exists on an expansion module.

Program execution errors

Your program can create error conditions while being executed. These errors can result from
improper use of an instruction or from the processing of invalid data by an instruction. For
example, an indirect-address pointer that was valid when the program compiled could be modified
during the execution of the program to point to an out-of-range address. This is an example of a
run-time programming problem. SM4.3 is set upon the occurrence of a run-time programming
problem and remains set while the S7-200 is in RUN mode. (Refer to Appendix C for the list of
run-time programming problems). Program execution error information is stored in special memory
(SM) bits. Your program can monitor and evaluate these bits. Refer to Appendix D for more
information about the SM bits used for reporting program execution errors.

The S7-200 does not change to STOP mode when it detects a non-fatal error. It only logs the
event in SM memory and continues with the execution of your program. However, you can design
your program to force the S7-200 to STOP mode when a non-fatal error is detected. The following
sample program shows a network of a program that is monitoring two of the global non-fatal error
bits and changes the S7-200 to STOP whenever either of these bits turns on.

Sample Program: Logic for Detecting a Non-Fatal Error Condition

Network 1 Network 1 //When an 1/O error or a run-time error occurs,
SM5.0 //go to STOP mode
STOR) LD SM5.0
0] SM4.3
Shi4 3 STOP

Fatal Errors

Fatal errors cause the S7-200 to stop the execution of your program. Depending upon the severity
of the fatal error, it can render the S7-200 incapable of performing any or all functions. The
objective for handling fatal errors is to bring the S7-200 to a safe state from which the S7-200 can
respond to interrogations about the existing error conditions. When a fatal error is detected, the
S7-200 changes to STOP mode, turns on the SF/DIAG (Red) and the STOP LED, overrides the
output table, and turns off the outputs. The S7-200 remains in this condition until the fatal error
condition is corrected.

Once you have made the changes to correct the fatal error condition, use one of the following
methods to restart the S7-200:

[ Turn the power off and then on.
1 Change the mode switch from RUN or TERM to STOP.

1 Selectthe PLC > Power-Up Reset menu command from STEP 7-Micro/WIN to restart the
S7-200. This forces the S7-200 to restart and clear any fatal errors.

Restarting the S7-200 clears the fatal error condition and performs power-up diagnostic testing to
verify that the fatal error has been corrected. If another fatal error condition is found, the S7-200
again sets the fault LED, indicating that an error still exists. Otherwise, the S7-200 begins normal
operation.

Some error conditions can render the S7-200 incapable of communication. In these cases, you
cannot view the error code from the S7-200. These types of errors indicate hardware failures that
require the S7-200 to be repaired; they cannot be fixed by changes to the program or clearing the
memory of the S7-200.
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Assigning Addresses and Initial Values in the Data Block Editor

The data block editor allows you to make initial data assignments to V memory (variable memory)
only. You can make assignments to bytes, words, or double words of V memory. Comments are
optional.

The data block editor is a free-form text
editor; that is, no specific fields are _ — -
defined for particular types of
information. After you finish typing a line
and press the Enter key, the data block
editor formats the line (aligns columns of
addresses, data, comments; capitalizes
V memory addresses) and redisplays it.
Pressing CTRL-ENTER, after
completing an assignment line,

auto-increments the address to the next
available address. Figure 5-7  Data Block Editor

The data block editor assigns an appropriate amount of V memory based on your previous
address allocations and the size (byte, word, or double word) of the data value(s).

The first line of the data block must have an explicit address assignment. Subsequent lines can
have explicit or implicit address assignments. An implicit address assignment is made by the
editor when you type multiple data values after a single address assignment, or type a line that
contains only data values.

The data block editor accepts uppercase or lowercase letters and allows commas, tabs, or spaces
to serve as separators between addresses and data values.

Using the Symbol Table for Symbolic Addressing of Variables

=
'\-‘-”

Symbol
Table
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The symbol table allows you to define and edit the symbols that can be accessed by the symbolic
name anywhere in your program. You can create multiple symbol tables. There is also a tab in the
symbol table for system-defined symbols that you can use in your program. The symbol table is
also referred to as the global variable table.

You can identify the operands of the instructions in your program absolutely or symbolically. An
absolute reference uses the memory area and bit or byte location to identify the address. A
symbolic reference uses a combination of alphanumeric characters to identify the address.

For SIMATIC programs, you makeglobal V7o i 7?0 700 7 oo 0 0 0 0 2 0 8
symbol assignments by using the =)
symbol table. For IEC programs, you
make global symbol assignments by
using the global variable table.

Spmbol Address Comment
AlwapsOn SMo.0 Always on contact
Pumpl 023 Pumnp 1 on/off
Purnp1Limit 11.1 Purnp 1 pressure limit switch
PumplPFiessure VD100 Pump 1 curnent pressure [real]
Purmp1Rpm V200 Purnp1 PRMs (integer)

OIORCEOR0D

o= o] =

To assign a symbol to an address:
gnasy Figure 58  Symbol Table

1. Click on the Symbol Table icon in the navigation bar to open the symbol table.

2. Enter the symbol name (for example, Input1) in the Symbol Name column. The maximum
symbol length is 23 characters.

Enter the address (for example, 10.0) in the Address column.

For an IEC global variable table, enter a value in the Data Type column or select one from
the listbox.

You can create multiple symbol tables; however, you cannot use the same string more than once
as a global symbol assignment, neither within a single table nor among several tables.
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Using Local Variables

You can use the_z local var.iable ta}ble of B SIMATIC LAD o]
the program editor to assign variables S IS R S R SRR S
that are unique to an individual Hame VarTope | Diota Tope Ee, =
subroutine or interrupt routine. See EN i DL :
. L0.0 FirstPass IN BOOL First pass flag
Figure 5-9. LB1 Addr IN BYTE Address of slave device
L2 Data IN INT [Data bo wirite o slave ]
1 LE4 Status IN_OUT BYTE Statuz of write
Local variables can be used_as == St o oo Don g
parameters that are passed In tO a LWE Erron ouT WORD Ermror number [if an) ﬂ
subroutine and they increase the [T T ma psBR_0 LNT 07 | 3]

portability or reuse of a subroutine. Figure 5-0 Local Variable Table

Using the Status Chart to Monitor Your Program

Status
Chart

¥

A status chart allows you to monitor or modify the values of the process variables as your S7-200
runs the control program. You can track the status of program inputs, outputs, or variables by
displaying the current values. The status chart also allows you to force or change the values of the
process variables.

You can create multiple status charts in order to view elements from different portions of your
program.

To access the status chart, select the View > Component > Status Chart menu command or
click the Status Chart icon in the navigation bar.

When you create a status chart, you @ status Chart BEE
enter addresses of process variables for ||~ [ o R i s E
monitoring. You cannot view the status of s —fond e oo -

Pump! Limit |git 240
Pump1 Pressure |Egned +0
Fumgi Rpm Signet! +0

1

constants, accumulators, or local 2

variables. You can display a timer or E

counter value either as a bit or as a E

word. Displaying the value as a bit — o —— =
shows the status of the timer or counter ~ [ELhouri/ K1 [T
bit; displaying the value as a word shows
the timer or counter value.

M37 Bit Z#0
B100 Hexadecimal 1600

Figure 5-10 Status Chart

To build a status chart and monitor the variables:

1. Enter the address for each desired value in the Address field.
Select the data type in the Format column.

To view the status of the process variables in your S7-200, select the Debug > Chart
Status menu command.

4. To continuously sample the values, or to perform a single read of the status, click the button
on the toolbar. The Status Chart also allows you to modify or force values for the different
process variables.

You can insert additional rows in your Status Chart by selecting the Edit > Insert > Row menu
command.

Tip

You can create multiple status charts to divide the variables into logical groups so that each
group can be viewed in a shorter and separate status chart.
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Creating an Instruction Library

STEP 7-Micro/WIN allows you either to create a custom library of instructions, or to use a library
created by someone else. See Figure 5-11.

To create a library of instructions, you create standard STEP 7-Micro/WIN subroutine and
interrupt routines and group them together. You can hide the code in these routines to prevent
accidental changes or to protect the technology (know-how) of the author.

To create an instruction library, perform the following
tasks:

1. Write the program as a standard
STEP 7-Micro/WIN project and put the
function to be included in the library into
subroutines or interrupt routines.

2. Ensure that all V. memory locations in the
subroutines or interrupt routines have been
assigned a symbolic name. To minimize the
amount of V. memory that the library requires,
use sequential V memory locations.

3. Rename the subroutines or interrupt routines
to the names that you want to appear in the
I %

instruction library.

-E;IE'.HM .11

4. Select the File > Create Library menu

. . . I Cruln | Io A
command to compile the new instruction i T Sceke A A
library. I L;|:|' Ecsla A |
For more information about creating libraries, refer il £ Col Jubmire=

to the online help for STEP 7-Micro/WIN.

Use the following procedure to access an instruction Figure 5-11  Instruction Tree with Libraries
in an instruction library:

1. Add the Libraries directory to the instruction tree by selecting the File > Add Libraries
menu command.

2. Select the specific instruction and insert it into your program (as you would any standard
instruction).

If the library routine requires any V memory, STEP 7-Micro/WIN prompts you when the
project is compiled to assign a block of memory. Use the Library Memory Allocation dialog
box to assign blocks of memory.

Features for Debugging Your Program

STEP 7-Micro/WIN provides the following features to help you debug your program:

1 Bookmarks in your program to make it easy to move back and forth between lines of a long
program.

1 Cross Reference table allow you to check the references used in your program.

O RUN-mode editing allows you to make small changes to your program with minimal
disturbance to the process controlled by the program. You can also download the program
block when you are editing in RUN mode.

For more information about debugging your program, refer to Chapter 8.
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This chapter describes the SIMATIC and IEC 1131 instruction set for the S7-200 Micro PLCs.
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Chapter 6

Conventions Used to Describe the Instructions

Figure 6-1 shows a typical description for an instruction and points to the different areas used to
describe the instruction and its operation. The illustration of the instruction shows the format in

LAD, FBD, and STL. The operand table lists the operands for the instruction and shows the valid
data types, memory areas and sizes for each operand.

EN/ENO operands and data types are not shown in the instruction operand table because the
operands are the same for all LAD and FBD instructions.

[ ForLAD: EN and ENO are power flow and are BOOL data types.
1 ForFBD:ENand ENOarel, Q,V, M, SM, S, T, C, L, or power flow and are BOOL data

types.

Description of the instruction
and operands

I STL instruction LAD and FBD instructions
|

Transmit and Receive Instructions

\The Transtnit instucton XMT) is used in Frespon mode \ fransmit

data by means of the corntmuni cation pos) . AMRIL 7 BT ]

List of the error conditions
that affect ENO and any SM
bits affected

Tha Reczive insruction (RCY) infistes oF tzainates the Ree\ive Lz e
Message cerice. You rust specify o start and an end conditic\ for T

the Receive boy to operste. Messages rocaivad tirough the EL R
specified port (PORT) are stored in the dats. buffer (TEL). The fin\ T Pcﬂ;‘_

ariry i the dats buffer specifies the nurmber of bybes received,

Operands for the ||
instruction

SELEND = 0
m SMEES OF SMTGR.6 error kil et (ROW parameter etror) e L5
\- 0005 {indiect auress) \ ;
Q003 (simultaneous BMTIRCW on pott 01 it ]
= O00E [SiMuitanecus KMTIRCY an port 1) L o TH Fee
®E7-E00 CPU not in Fraeport mods kX TELFURT
Table 6=11  Valid Opserands for the Transmit and Receive nstructions
INpuUREDUtp uts Data Type opeiands
TEL EYTE B IE, QE, ME, $E, $ME. VD, "AC, TLD
/PDFET NTE Congfint for CBUANY, SRAN LR AN ]
SO DO 208 A DL N [T

Using Pseeport Mode to Control/he Serial Communication Port
Yo Zan select the Fresport ode toZortrol the serisl cormunication port of the S7-200 by rmeans of the

seoaesrr. When you select Fré/aport mode, your prograrn controls the operation of the communication
the wse of the receive Anterpts, the transmit irte mapts, the Transmit instruction, and te

Valid data types ruction. The corrmi/ication protocol §s entirely controlled by the ladder program while in

wfe. SMESD ifor por/ 00 and SME1E0 (for port 1| if your S7-Z00 has twe ports) are vsed to
puad rade and parity,

The Freeport rode is disabl/Ad and monmsl ication

hed For exarnphe, prograrn ening

Valid memory areas and sizes for

the operands 2k, & weighing scals, and & welder. In
is Wsed by the device with which the

Freepert commmunicaton is possible only when the S7-200 is in the RWN moede, Enakle the Fregport mods
by setiing a walue of 01 in the protocol select field of SKWIB30 (Port 0) or SMEB130 (Port 1. While in Freeport
rode, comrmunicstion with the prograrmming device is not possible.

Tip

@ Ertsting Freeport mode can be controlled using spacial memorg bit SWI0.F, which reflects the cumrent
position of the opersting mode switch, When SM0.T is equal to O, the switch is in TERM position; when
SMO.7 = 1, the operating rode switch is in RUM position. Kyou enakle Freeport mode only when the
switch is in AWM pesition, you can wse the programming device o monier of contrel the $7-200
operation by changing the switch to any other position,

Figure 6-1 Instruction Descriptions
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S$7-200 Memory Ranges and Features

Table 6-1 Memory Ranges and Features for the S7-200 CPUs
Description CPU 221 CPU 222 CPU 224 CPU 224XP CPU 226
User program size
with run mode edit 4096 bytes 4096 bytes 8192 bytes 12288 bytes 16384 bytes
without run mode edit 4096 bytes 4096 bytes 12288 bytes 16384 bytes 24576 bytes
User data size 2048 bytes 2048 bytes 8192 bytes 10240 bytes 10240 bytes
Process-image input register 10.0 to 115.7 10.0to 115.7 10.0to 115.7 10.0to 115.7 10.0to 115.7
Process-image output register | Q0.0 to Q15.7 Q0.0to Q15.7 Q0.0to Q15.7 Q0.0to Q15.7 Q0.0to Q15.7
Analog inputs (read only) AIWO0 to AIW30 AIWO0 to AIW30 AIWO0 to AIW62 AIWO0 to AIW62 AIWO0 to AIW62
Analog outputs (write only) AQWO to AQW30 | AQWO to AQW30 | AQWO to AQW62 | AQWO to AQW62 | AQWO to AQW62
Variable memory (V) VBO to VB2047 VBO to VB2047 VBO to VB8191 VBO to VB10239 VBO to VB10239
Local memory (L)1 LBO to LB63 LBO to LB63 LBO to LB63 LBO to LB63 LBO to LB63
Bit memory (M) MO0.0 to M31.7 MO0.0 to M31.7 MO0.0 to M31.7 MO0.0 to M31.7 MO0.0 to M31.7
Special Memory (SM) SM0.0 to SM179.7 | SM0.0 to SM299.7 | SMO0.0 to SM549.7 = SM0.0 to SM549.7 | SMO0.0 to SM549.7
Read only SMO0.0 to SM29.7 SMO0.0 to SM29.7 SMO0.0 to SM29.7 SMO0.0 to SM29.7 SMO0.0 to SM29.7
Timers 256 (TOto T255) | 256 (TOto T255) | 256 (TOto T255) | 256 (TOto T255) | 256 (TO to T255)
Retentive on-delay 1 ms TO, T64 TO, T64 TO, T64 TO, T64 TO, T64
10 ms T1to T4, and T1to T4, and T1to T4, and T1to T4, and T1to T4, and
T65 to T68 T65 to T68 T65 to T68 T65 to T68 T65 to T68
100ms | T5to T31, and T5to T31, and T5to T31, and T5to T31, and T5to T31, and
T69 to T95 T69 to T95 T69 to T95 T69 to T95 T69 to T95
On/Off delay 1ms T32, T96 T32, T96 T32, T96 T32, T96 T32, T96
10 ms T33 to T36, and T33 to T36, and T33 to T36, and T33 to T36, and T33 to T36, and
T97 to T100 T97 to T100 T97 to T100 T97 to T100 T97 to T100
100 ms | T37 to T63, and T37 to T63, and T37 to T63, and T37 to T63, and T37 to T63, and
T101 to T255 T101 to T255 T101 to T255 T101 to T255 T101 to T255
Counters CO0 to C255 CO0 to C255 CO0 to C255 CO0 to C255 CO0 to C255
High-speed counters HCO to HC5 HCO to HC5 HCO to HC5 HCO to HC5 HCO to HC5
Sequential control relays (S) S0.0 to S31.7 S0.0 to S31.7 S0.0 to S31.7 S0.0 to S31.7 S0.0to S31.7
Accumulator registers ACO to AC3 ACO to AC3 ACO0 to AC3 ACO0 to AC3 ACO0 to AC3
Jumps/Labels 0to 255 0to 255 0to 255 0to 255 0to 255
Call/Subroutine Oto 63 Oto 63 Oto 63 Oto 63 Oto 127
Interrupt routines Oto 127 Oto 127 Oto 127 Oto 127 Oto 127
Positive/negative transitions 256 256 256 256 256
PID loops Oto7 Oto7 Oto7 Oto7 Oto7
Ports Port 0 Port 0 Port 0 Port 0, Port 1 Port 0, Port 1

1 LB60 to LB63 are reserved by STEP 7-Micro/WIN, version 3.0 or later.
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Table 6-2 Operand Ranges for the S7-200 CPUs
Access Method CPU 221 CPU 222 CPU 224 CPU 224 XP CPU 226
Bit access (byte.bit) | 0.0to15.7 0.0to 15.7 0.0to 15.7 0.0to 15.7 0.0to 15.7
Q 0.0to15.7 0.0to 15.7 0.0to 15.7 0.0to 15.7 0.0to 15.7
V | 0.0 to 2047.7 0.0 to 2047.7 0.0to 8191.7 0.0 to 10239.7 0.0 to 10239.7
M | 0.0to0 31.7 0.0t0 31.7 0.0t0 31.7 0.0t0 31.7 0.0t0 31.7
SM 0.0to 165.7 0.0 to 299.7 0.0 to 549.7 0.0 to 549.7 0.0 to 549.7
S 0.0to31.7 0.0t0 31.7 0.0t0 31.7 0.0t0 31.7 0.0t0 31.7
T O0to255 0to 255 0to 255 0to 255 0to 255
C | 0to255 0to 255 0to 255 0to 255 0to 255
L | 0.0t0 63.7 0.0 to 63.7 0.0 to 63.7 0.0 to 63.7 0.0 to 63.7
Byte access IB 0to15 Oto 15 Oto 15 Oto 15 Oto 15
QB |0to 15 Oto 15 Oto 15 Oto 15 Oto 15
VB | 0to 2047 0 to 2047 0to 8191 0to 10239 0to 10239
MB  0to 31 0to 31 0to 31 0to 31 0to 31
SMB 0to 165 0 to 299 0 to 549 0 to 549 0 to 549
SB  0to 31 0 to 31 0 to 31 0 to 31 0 to 31
LB 0to 63 0to 63 0to 63 0to 63 0to 63
AC O0to3 0to3 0to3 0to 255 0to 255
KB (Constant) = KB (Constant) KB (Constant) KB (Constant) KB (Constant) KB (Constant)
Word access IW Oto 14 Oto 14 Oto 14 Oto 14 Oto 14
QW 0to 14 Oto 14 Oto 14 Oto 14 Oto 14
VW | 0to 2046 0 to 2046 0to 8190 0to 10238 0to 10238
MW | 0to 30 0to 30 0to 30 0to 30 0to 30
SMW | 0to 164 0to 298 0 to 548 0 to 548 0 to 548
SW  0to 30 0to 30 0to 30 0to 30 0to 30
T O0to255 0to 255 0to 255 0to 255 0to 255
C | 0to 255 0to 255 0to 255 0to 255 0to 255
LW 0to 62 0 to 62 0 to 62 0 to 62 0 to 62
AC 0to3 Oto3 Oto3 Oto3 Oto3
AIW | 0to 30 0to 30 0 to 62 0 to 62 0 to 62
AQW | 0to 30 0to 30 0 to 62 0 to 62 0 to 62
KW (Constant) | KW (Constant) KW (Constant) KW (Constant) KW (Constant) KW (Constant)
Double word access ID |0to12 Oto 12 Oto 12 Oto 12 Oto 12
QD O0to12 Oto12 Oto12 Oto12 Oto12
VD | 0to 2044 0 to 2044 0Oto 8188 0to 10236 0to 10236
MD 0to28 Oto 28 Oto 28 Oto28 Oto28
SMD 0Oto 162 0 to 296 0 to 546 0 to 546 0 to 546
SD 0to28 0to 28 0to 28 0to 28 0to 28
LD | 0to 60 0 to 60 0to 60 0to 60 0to 60
AC O0to3 Oto3 Oto3 Oto3 Oto3
HC Oto5 Oto5 Oto5 Oto5 Oto5

KD (Constant)

KD (Constant)

KD (Constant)

KD (Constant)

KD (Constant)

KD (Constant)
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Bit Logic Instructions

70

Contacts

Standard Contacts

The Normally Open contact instructions (LD, A, and O) and
Normally Closed contact instructions (LDN, AN, ON) obtain
the referenced value from the memory or from the
process-image register. The standard contact instructions
obtain the referenced value from the memory (or
process-image register if the data type is | or Q).

The Normally Open contact is closed (on) when the bit is
equal to 1, and the Normally Closed contact is closed (on)
when the bit is equal to 0. In FBD, inputs to both the And
and Or boxes can be expanded to a maximum of 32 inputs.
In STL, the Normally Open instructions Load, AND, or OR
the bit value of the address bit to the top of the stack, and
the Normally Closed instructions Load, AND, or OR the
logical NOT of the bit value to the top of the stack.

Immediate Contacts

An immediate contact does not rely on the S7-200 scan
cycle to update; it updates immediately. The Normally Open
Immediate contact instructions (LDI, Al, and Ol) and
Normally Closed Immediate contact instructions (LDNI, ANI,
and ONI) obtain the physical input value when the
instruction is executed, but the process-image register is
not updated.

The Normally Open Immediate contact is closed (on) when
the physical input point (bit) is 1, and the Normally Closed
Immediate contact is closed (on) when the physical input
point (bit) is 0. The Normally Open instructions immediately
Load, AND, or OR the physical input value to the top of the
stack, and the Normally Closed instructions immediately
Load, AND, or OR the logical NOT of the value of the
physical input point to the top of the stack.

NOT Instruction

The Not instruction (NOT) changes the state of power flow
input (that is, it changes the value on the top of the stack
from 0 to 1 or from 1 to 0).

SIMATIC ¢ IEC1131]

LAD

=
=

=
=

1000000,

=
=

[i]

SIMATIC l
STL

L  Eit LDl Eit
il Eit Al Eit
Q Eit ol Eit
LDM  Eit LDMI  Eit
AM  Eit AMl Eit
oM EBit OMl Bt
MOT

EU

ED
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Positive and Negative Transition Instructions

The Positive Transition contact instruction (EU) allows power to flow for one scan for each
off-to-on transition. The Negative Transition contact instruction (ED) allows power to flow for one
scan for each on-to-off transition. For the Positive Transition instruction, detection of a 0-to-1
transition in the value on the top of the stack sets the top of the stack value to 1; otherwise, it is set
to 0. For a Negative Transition instruction, detection of a 1-to-0 transition in the value on the top of
the stack sets the top of the stack value to 1; otherwise, it is set to 0.

For run mode editing (when you edit your program in RUN mode), you must enter a parameter for

the Positive Transition and Negative Transition instructions. Refer to Chapter 5 for more
information about editing in RUN mode.

Table 6-3 Valid Operands for the Bit Logic Input Instructions

Inputs/Outputs Data Type Operands
Bit BOOL 1,Q,V, M, SM, S, T, C, L, Power Flow
Bit (immediate) BOOL |

As shown in Figure 6-2, the S7-200 uses a logic stack to resolve the control logic. In these
examples, “iv0” to “iv7” identify the initial values of the logic stack, “nv” identifies a new value
provided by the instruction, and “S0” identifies the calculated value that is stored in the logic stack.

Load (LD, LDI, Before aiter | And (A, Al, AN,  Before After Or (0, Ol, ON, Before After
LDN, LDNI) 0 ANI) 0 sot | |OND v0 so'
Loads a new !V \ .nv ANDs a new !V - ORs a new !V -
value (nv) onto ivi \ VO | | value (nv) with v1 v1 value (nv) with v1 v1
the stack. iv2 ivi the initial value iv2 iv2 the initial value iv2 iv2
- \ ,2 (iv) at the top of v v (iv) at the top of v v
v3 \ i the stack. i i the stack. i i
iv4 \ iv3 S0=ivO AND nv iv4 iv4 S0=iv0 OR nv iv4 iv4
ivh \ iv4 ivh ivh ivh ivh
ive \ ivh ive ive ive ive
iv7 ive iv7 iv7 iv7 iv7
ivg2 \ iv7 iv8 iv8 iv8 iv8

1

SO0 identifies the calculated value that is stored in the logic stack.

2 After the execution of a Load, the value iv8 is lost.

Figure 6-2

%

Operations of the Contact Instructions.

Tip

Because the Positive Transition and Negative Transition instructions require an on-to-off or an
off-to-on transition, you cannot detect an edge-up or edge-down transition on the first scan.
During the first scan, the S7-200 sets the state of the bit specified by these instructions. On
subsequent scans, these instructions can then detect transitions for the specified bit.
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Example: Contact Instructions

Network 1 Network 1 //N.O. contacts 10.0 AND 10.1 must be on
00 //(closed) to activate Q0.0. The NOT

0.1 Qo0
_| ) //instruction acts as an inverter. In RUN
| | // mode, Q0.0 and Q0.1 have opposite logic states.
Q01
noT—( )

LD 10.0
A 10.1
= Q0.0
NOT
= Q0.1
Network 2 Network 2  //N.O. contact 10.2 must be on or N.C.
Iz Qo2 //contact 10.3 must be off to activate Q0.2.
_| ) // One or more parallel LAD branches
//(OR logic inputs) must be true to make
10.3 /the output active.
— LD 102
ON 10.3
= Q0.2
Network 3 Network 3  //A positive Edge Up input on a P contact
04 Qo3 /lor a negative Edge Down input on a N contact

// pulse in Q0.3 and make the state

_| P 5 ) /loutputs a pulse with a 1 scan cycle
1 //duration. In RUN mode, the pulsed state
//changes of Q0.4 and Q0.5 are too fast to
Q0.4 AN .
// be visible in program status view.
) /[The Set and Reset outputs latch the
M

Q0.3 //change visible in program status view.
R) LD  10.4
! LPS
(O] 1R] EU
) S Q0.3, 1
= Q0.4
LPP
ED
R Q0.3, 1
= Q0.5

Timing Diagram Network 1
oo — L 1

0.1 | L |
Q0.0 h
Q0.1 '
Network 2
10.2 ‘
10.3 ‘ |
Q0.2 L 'I—
Network 3
10.4 —!—!
Q0.3 1
Q04 < On for one sc:an
Q05 e On for one scan
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Coils
Output SIMATIC # IECT131 ]
The Output instruction (=) writes the new value for the
output bit to the process-image register. When the Output LAD Gi 6 FED
instruction is executed, the S7-200 turns the output bit in the it L
process-image register on or off. For LAD and FBD, the _( :I —|I|
specified bit is set equal to power flow. For STL, the value it it
on the top of the stack is copied to the specified bit. _(
1) ]

Output Immediate it Eit
The Output Immediate instruction (=1) writes the new value _( g :| T 3
to both the physical output and the corresponding M gl _
process-image register location when the instruction is Eit it
executed. _( ar :I 1 s

N
When the Output Immediate instruction is executed, the N Bit
physical output point (Bit) is immediately set equal to power Bit i R
flow. For STL, the instruction immediately copies the value _( R :| 4N
on the top of the stack to the specified physical output bit N Eit
(STL). The “I” indicates an immediate reference; the new Eit | Rl
value is written to both the physical output and the —|I RI :| dn
corresponding process-image register location when the N
instruction is executed. This differs from the non-immediate
references, which write the new value to the process-image
register only. SIMATIC ]
Set and Reset ST, -1 i
The Set (S) and Reset (R) instructions set (turn on) or reset o Al EEa
(turn off) the specified number of points (N), starting at the e e

specified address (Bit). You can set or reset from 1 to 255

points.

If the Reset instruction specifies either a timer bit (T) or counter bit (C), the instruction resets the
timer or counter bit and clears the current value of the timer or counter.

Error conditions that set ENO = 0

m 0006 (indirect address)

= 0091 (operand out of range)

Set Immediate and Reset Immediate

The Set Immediate and Reset Immediate instructions immediately set (turn on) or immediately
reset (turn off) the number of points (N), starting at specified address (Bit). You can set or reset
from 1 to 128 points immediately.

The “I” indicates an immediate reference; when the instruction is executed, the new value is
written to both the physical output point and the corresponding process-image register location.
This differs from the non-immediate references, which write the new value to the process-image
register only.

Error conditions that set ENO =0

m 0006 (indirect address)

= 0091 (operand out of range)

Table 6-4 Valid Operands for the Bit Logic Output Instructions

Inputs/Outputs Data Type Operands

Bit BOOL ,Q,V,M,SM, S, T,C, L

Bit (immediate) BOOL Q

N BYTE 1B, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant
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Example: Coil Instructions

Network 1
0.0 Q0.0
— )
Qo
)
0.0
)
Network 2
10.1 Qo2

— I—(E)

Network 3
0.2 Qo2

— (")

Network 4
0.3 |

Network 5
0.6 oo

— - )

Timing Diagram

74

Network 1 //Output instructions assign bit values to external I/O (I, Q)
/fand internal memory (M, SM, T, C, V, S, L).

LD 10.0

= Q0.0
= Q0.1
= V0.0

Network 2  //Set a sequential group of 6 bits to a value of 1. Specify a
/[starting bit address and how many bits to set. The program
//status indicator for Set is ON when the value of the first bit
//(Q0.2) is 1.

LD 10.1
S Q0.2,6

Network 3  //Reset a sequential group of 6 bits to a value of 0.
//Specify a starting bit address and how many bits to reset.
/[The program status indicator for Reset is ON when the value
/fof the first bit (Q0.2) is 0.

LD 10.2

R Q0.2,6

Network 4  //Sets and resets 8 output bits (Q1.0 to Q1.7) as a group.
LD 10.3

LPS

A 10.4

S Q1.0,8

Qilo LPP

R Q1.0,8
a0 Network 5  //The Set and Reset instructions perform the function of a latched

0.4
— — s) A 10.5
8
0.5
|_( R /Irelay. To isolate the Set/Reset bits, make sure they are not
5

/loverwritten by another assignment instruction. In this example,
/INetwork 4 sets and resets eight output bits (Q1.0 to Q1.7)

//as a group. In RUN mode, Network 5 can overwrite

/fthe Q1.0 bit value and control the Set/Reset program

/[status indicators in Network 4.

LD 10.6
= Q1.0
Network 1
10.0
Q0.0, Q0.1, V0.0 ]
Networks 2 and 3
10.1 (Set) ]
10.2 (Reset) 1
1
'
1
Reset to 0 overwrites Set to 1 because the program scan
executes the Network 3 Reset after the Network 2 Set e
Networks 4 and 5
10.3
10.4 (Set) ] |—|
10.5 (Reset) —
10.6
Q1.0 — L
1
i
T T
v Vv v Vv v Vv

Network 5 Output bit (=) instruction overwrites the first bit (Q1.0) Set/Reset in
Network 4 because the program scan executes the Network 5 assignment last
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Logic Stack Instructions

AND Load SIMATIC
The AND Load instruction (ALD) combines the values in the
first and second levels of the stack using a logical AND STL
operation. The result is loaded in the top of stack. After the HO']_%
ALD is executed, the stack depth is decreased by one. LPS

LRD
OR Load LFF
The OR Load instruction (OLD) combines the values in the EEEO M
first and second levels of the stack, using a logical OR

operation. The result is loaded in the top of the stack. After
the OLD is executed, the stack depth is decreased by one.

Logic Push

The Logic Push instruction (LPS) duplicates the top value on the stack and pushes this value onto
the stack. The bottom of the stack is pushed off and lost.

Logic Read

The Logic Read instruction (LRD) copies the second stack value to the top of stack. The stack is
not pushed or popped, but the old top-of-stack value is destroyed by the copy.

Logic Pop
The Logic Pop instruction (LPP) pops one value off of the stack. The second stack value becomes
the new top of stack value.

AND ENO

The AND ENO instruction (AENO) performs a logical AND of the ENO bit with the top of the stack
to generate the same effect as the ENO bit of a box in LAD or FBD. The result of the AND
operation is the new top of stack.

ENO is a Boolean output for boxes in LAD and FBD. If a box has power flow at the EN input and
is executed without error, the ENO output passes power flow to the next element. You can use the
ENO as an enable bit that indicates the successful completion of an instruction. The ENO bit is
used with the top of stack to affect power flow for execution of subsequent instructions. STL
instructions do not have an EN input. The top of the stack must be a logic 1 for conditional
instructions to be executed. In STL there is also no ENO output. However, the STL instructions
that correspond to LAD and FBD instructions with ENO outputs set a special ENO bit. This bit is
accessible with the AENO instruction.

Load Stack

The Load Stack instruction (LDS) duplicates the stack bit (N) on the stack and places this value
on top of the stack. The bottom of the stack is pushed off and lost.

Table 6-5 Valid Operands for the Load Stack Instruction
Inputs/Outputs Data Type Operands

N BYTE Constant (0 to 8)
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As shown in Figure 6-3, the S7-200 uses a logic stack to resolve the control logic. In these
examples, “iv0” to “iv7” identify the initial values of the logic stack, “nv” identifies a new value
provided by the instruction, and “S0” identifies the calculated value that is stored in the logic stack.

ALD Before After OoLD Before After LDS Before After
AND the top ivo S0 OR the top two ivo S0 Load Stack | ivo iv3
two stack v 2 | | stack values iv1 v2 iv1 \ VO
values iv2 / iv3 iv2 / iv3 iv2 \ iv1
v3 / iva v3 / iva v3 \ v2
iva / iv5 iva / iv5 iva \ iv3
iv5 / ive iv / ive iv5 \ iv4
v6 / v7 iv6 / v7 v6 a v5
v7 / v8 v7 / v8 v7 > v6
S0 = iv0 AND iv1 iv8 / x! S0 =iv0 ORiv1 iv8 / x! iv2 \ iv7
LPS Before Atter | LRD Before Atter | LPP Before After
Logic Push VO ivo | | Logic Read VO iv1 Logic Pop [ ivo iv1
iv1 \ iv0 iv1 / iv1 iv1 / iv2
v2 \ v v2 v2 v2 / v3
v3 \ v2 v3 v3 v3 / iva
iva \ iv3 iva iva iva / iv5
iv5 \ iv4 iv5 iv5 iv5 / ive
iv6 \ iv5 iv6 iv6 iv6 / v7
iv7 \ ive iv7 iv7 iv7 / iv8
iv2 \ iv7 iv8 iv8 iv8 / X1

1 The value is unknown (it could be either a 0 or a 1).
2 After the execution of a Logic Push or a Load Stack instruction, value iv8 is lost.

Figure 6-3 Operations of the Logic Stack Instructions

Example: Logic Stack Instructions

Network 1 Network 1
0.0 0.1 mso (LD 100
| l | | I3 ) LD 10.1
| | | | \ LD 12.0
A 12.1
12.0 12.1 oLD
| |
1 1 ALD
= Q5.0
Network 2
Metwork 2 LD 10.0
0.0 0.5 Q7.0 LPS
l | /
— | . () ('-)D :8-2
0.6 ALD
| | = Q7.0
o LRD
LD 12.1
12.1 Q6.0 0 13
I I () ALD
= Q6.0
1.3 LPP
} } A 11.0
= Q3.0
1.0 Q3.0
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Set and Reset Dominant Bistable Instructions

The Set Dominant Bistable is a latch where the set

dominates. If the set (S1) and reset (R) signals are both SIMATIC £ (ECTTST

true, the output (OUT) is true. LAD FED
Bit Bit

The Reset Dominant Bistable is a latch where the reset Iz ouTE | =1 ouTE

dominates. If the set (S) and reset (R1) signals are both R -k SR

true, the output (OUT) is false. A

The Bit parameter specifies the Boolean parameter that is

set or reset. The optional output reflects the signal state of it Eit

the Bit parameter. aE OUTE | A= QUT 1=
RS —{r1 RS

Table 6-7 shows the truth tables for the sample program. 1Ry

Table 6-6 Valid Operands for the Set Dominant Bistable and Reset Dominant Bistable

Instructions
Inputs/Outputs Data Types Operands
S1,R BOOL 1,Q,V,M, SM, S, T, C, Power Flow
S, R1, OUT BOOL 1,Q,V,M, SM, S, T, C, L, Power Flow
Bit BOOL ,LQ,V,M S

Example: Set and Reset Dominant Bistable Instructions

Network 1
0.0 Q0.0

— s SROUT —)
_||n.1

a

Network 2
0.0 Qo

H ——F

R3
0.1

— | S

[l

Timing Diagram

Set  10.0 [ ] [ ]

Reset 10.1 _|

SR Q0.0 L]

RS Q0.1 |

Table 6-7 Truth Table for the Set and Reset Dominant Bistable Instructions

Instruction S1 R Out (Bit)
Set Dominant Bistable instruction 0 0 Previous state
(SR 1 0

1 0 1

1 1 1
Instruction S R1 Out (Bit)
Reset Dominant Bistable instruction 0 0 Previous state
(RS) 0 1 0

1 0 1

1 1 0
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Clock Instructions

78

Read Real-Time Clock and Set Real-Time
Clock

SIMATIC £ IEC1131

LA FED
The Read Real-Time Clock (TODR) instruction reads the READ_RTE READ_RTE
current time and date from the hardware clock and loads it e EMO - | {EM EMGC
in an 8-byte Time buffer starting at address T. The Set At all
Real-Time Clock (TODW) instruction writes the current time
and date to the hardware clock, beginning at the 8-byte READ_RTC SET_RTC
Time buffer address specified by T. RERD_RTCH SET_RT&H
You must code all date and time values in BCD format (for
example, 16#97 for the year 1997). Figure 6-4 shows the BNIIE
format of the 8-Byte Time buffer (T). =

TODR T

The time-of-day (TOD) clock initializes the following date TODRH T
and time after extended power outages or when memory Lo
has been lost:

Date: 01-Jan-90

Time: 00:00:00
Day of Week: Sunday
Error conditions that set ENO = 0
m 0006 (indirect address)

m 0007 (TOD data error) Set Real-Time Clock only
m  000C (clock not present)

Table 6-8 Valid Operands for the Clock Instructions
Inputs/Outputs Data Types Operands
T BYTE 1B, QB, VB, MB, SMB, SB, LB, *VD, *LD, *AC

T T+1 T+2 T+3 T+4 T+5 T+6 T+7
Year: Month: Day: Hours: Minutes: Seconds: 0 Day of Week:
00 to 99 01to12 01 to 31 00 to 23 00 to 59 00 to 59 0to 7*

*T+7

1=Sunday, 7=Saturday
0 disables the day of week.

Figure 6-4 Format of the 8-Byte Time Buffer (T)
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Tip
@ The S7-200 CPU does not perform a check to verify that the day of week is correct based upon
the date. Invalid dates, such as February 30, could be accepted. You should ensure that the
date you enter is correct.

Do not use the TODR/TODW instruction in both the main program and in an interrupt routine. A
TODR/TODW instruction in an interrupt routine that attempts to execute while another
TODR/TODW instruction is in process cannot be executed. SM4.3 is set indicating that two
simultaneous accesses to the clock were attempted (non-fatal error 0007).

The time-of-day clock in the S7-200 uses only the least significant two digits for the year, so for
the year 2000, the year is represented as 00. The S7-200 PLC does not use the year
information in any way. However, user programs that use arithmetic or compares with the year’s
value must take into account the two-digit representation and the change in century.

Leap year is correctly handled through year 2096.

Read Real Time ClOCk Extended Error conditions that set ENO =0

The Read Real Time Clock Extended (TODRX) instruction ~ © U000 (ndirect address)

reads the current time, date, and daylight savings ®  000C (clock cartridge not present)
configuration from the PLC and loads it in a 19-byte buffer = 0091 (range error)

beginning at the address specified by T.

Set Real Time C|OCk Extended Error conditions that set ENO =0

indirect
The Set Real Time Clock (TODWX) instruction writes the 0000 (ndirect address)
current time, date, and daylight savings configuration to the ~® 0007 (TOD data error)
PLC beginning at the 19-byte buffer address specified by T.  u 000C (clock cartridge not present)

You must code all date and time values in BCD format (for m 0091 (range error)
example, 16#02 for the year 2002). Table 6-9 shows the
format of the 19-Byte Time Buffer (T).

. Date: 01-Jan-90
The time-of-day clock initializes the following date and time Ti?ni 00:00:00

after extended power outages or memory has been lost: Day of Week: Sunday

Tip
@ The only time the S7-200 CPU uses bytes 9 to18 is when the “User Specified” mode is selected
in byte 8. Otherwise, the last value written to these bytes by STEP 7-Micro/WIN or the
SET_RTCX instruction is returned.
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Table 6-9

Format of the 19-Byte Time Buffer (TI)

T Byte Description Byte Data
0 year (0-99) current year (BCD value)
1 month (1-12) current month (BCD value)
2 day (1-31) current day (BCD value
3 hour (0-23) current hour (BCD value)
4 minute (0-59) current minute (BCD value)
5 second (0-59) current second (BCD value)
6 00 reserved - always set to 00
7 day of week (1-7) current day of the week, 1=Sunday (BCD value)
8 mode (00H-03H, 08H, correction mode:
10H-13H, FFH) 00H = correction disabled
01H = EU (time zone offset from UTC = 0 hrs) 1
02H = EU (time zone offset from UTC = +1 hrs) 1
03H = EU (time zone offset from UTC = +2 hrs) 1
04H-07H = reserved
08H = EU (time zone offset from UTC = -1 hrs) 1
09H-0FH = reserved
10H = US 2
11H = Australia 3
12H = Australia (Tasmania) 4
13H = New Zealand °
14H-FEH = reserved
FFH = user specified (using values in bytes 9-18)
9 correction hours (0-23) correction amount, hours (BCD value)
10 correction minutes (0-59) correction amount, minutes (BCD value)
11 beginning month (1-12) beginning month of daylight saving time (BCD value)
12 beginning day (1-31) beginning day of daylight saving time (BCD value)
13 beginning hour (0-23) beginning hour of daylight saving time (BCD value)
14 beginning minute (0-59) beginning minute of daylight saving time (BCD value)
15 ending month (1-12) ending month of daylight saving time (BCD value)
16 ending day (1-31) ending day of daylight saving time (BCD value)
17 ending hour (0-23) ending hour of daylight saving time (BCD value
18 ending minute (0-59) ending minute of daylight saving time (BCD value)

1 EU convention: Adjusttime ahead one hour on last Sunday in March at 1:00 a.m. UTC. Adjust time back one hour on last Sunday
in October at 2:00 a.m UTC. (The local time when the correction is made depends upon the time zone offset from UTC).

2 US convention: Adjust time ahead one hour on first Sunday in April at 2:00 a.m local time. Adjust time back one hour on last

Sunday in October at 2:00 a.m local time.

Australia convention: Adjust time ahead one hour on last Sunday in October at 2:00 a.m. local time. Adjust time back one hour

on last Sunday in March at 3:00 a.m. local time.

Australia (Tasmania) convention: Adjusttime ahead one hour on first Sunday in October at 2:00 a.m. local time. Adjust time back

one hour on last Sunday in March at 3:00 a.m. local time

5 New Zealand convention: Adjust time ahead one hour on first Sunday in October at 2:00 a.m. local time. Adjust time back one
hour on first Sunday on or after March 15 at 3:00 a.m. local time

(&)

IS
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Communications Instructions

Network Read and Network Write Instructions

Instruction
Wizard

The Network Read instruction (NETR) initiates a

- . SIMATIC ¢ [EC 1131
communications operation to gather data from a remote

device through the specified port (PORT), as defined by the LAD FED
table (TBL). The Network Write instruction (NETW) initiates ETR ETR
a communications operation to write data to a remote den ok | de Eo b
device through the specified port (PORT), as defined by the d7mL
table (TBL). — TEL dpoRT
— PORT
Error conditions that set ENO = 0:
m 0006 (indirect address) METR METW
m |f the function returns an error and sets the E bit of table status
byte (see Figure 6-5)
SIMATIC
The Network Read instruction can read up to 16 bytes of STL
information from a remote station, and the Network Write METR  TEL.PORT

instruction can write up to 16 bytes of information to a METW  TEL.PORT

remote station.

You can have any number of Network Read and Network
Write instructions in the program, but only a maximum of
eight Network Read and Network Write instructions can be
activated at any one time. For example, you can have 4
Network Read and 4 Network Write instructions, or 2
Network Read and 6 Network Write instructions, active at
the same time in a given S7-200.

You can use the Network Read/Network Write Instruction Wizard to configure the counter. To start
the Network Read/Network Write Instruction Wizard, select the Tools > Instruction Wizard menu

command and then select Network Read/Network Write from the Instruction Wizard window.

Table 6-10  Valid Operands for the Network Read and Network Write Instructions

Inputs/Outputs Data Type Operands
TBL BYTE VB, MB, *VD, *LD, *AC
PORT BYTE Constant for CPU 221, CPU 222, CPU 224: 0

for CPU 224XP, CPU 226: Oor1
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Figure 6-5 describes the table that is referenced by the TBL parameter, and Table 6-11 lists the
error codes.

Byte D Done (function has been completed): 0=notdone 1 =done
Offset 7 0 A Active (function has been queued): 0 =not active 1 = active
0 D|A|E| 0] Erorcode| E Error (function returned an error): O=noerror 1 =error
1 Remote station address Remote station address: the address of the PLC whose data is to be

2 Pointer to the data accessed.
3 area in the Pointer to the data area in the remote station: an indirect pointer to
4 remote station the data that is to be accessed.
5 (I, Q, M, or V) Data length: the number of bytes of data that are to be accessed
6 Data length in the remote station (1 to 16 bytes).
7 Data byte 0 Receive or transmit data area. 1 to 16 bytes reserved for the data.
8 Data byte 1 For a Network Read instruction, stores the values that were read
: from the remote station when the instruction was executed.
22 Data byte 15 For a Network Write instruction, stores the values to be sent to the

remote station when the instruction is executed.

Figure 6-5 TBL Parameter for the Network Read and Network Write Instructions

Table 6-11  Error Codes for the TBL Parameter

Code Definition

0 No error.

1 Time-out error: Remote station not responding.

2 Receive error: Parity, framing, or checksum error in the response.

3 Offline error: Collisions caused by duplicate station addresses or failed hardware.

4 Queue overflow error: More than 8 Network Read or Network Write instructions have been activated.
5 Protocol violation: Attempt to execute a Network Read or Network Write instruction without enabling

the PPI Master Mode in SMB30 or SMB130.
llegal parameter: TBL parameter contains an illegal or invalid value.

No resource: Remote station is busy. (An upload or a download sequence is in process.)

o N o

Layer 7 error: Application protocol violation
9 Message error: Wrong data address or incorrect data length
AtoF  Notused. (Reserved)

Figure 6-6 shows an example to illustrate the utility of the Network Read and Network Write
instructions. For this example, consider a production line where tubs of butter are being filled and
sent to one of four boxing machines (case packers). The case packer packs eight tubs of butter
into a single cardboard box. A diverter machine controls the flow of butter tubs to each of the case
packers. Four S7-200s control the case packers, and an S7-200 with a TD 200 operator interface
controls the diverter.
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Case Packer #1 Case Packer #2 Case Packer #3 Case Packer #4 Diverter
Station 2 Station 3 Station 4 Station 5 Station 6 TD 200 Station 1
== == = = == =
D D ] R ” D C—o0o
 — d  — | |\mm o [fomem e .|
VB100 | Control VB100 | Control VB100 | Control VB100 | Control VB200 | Rev VB300 | Xmt
VW101 | Status VW101 | Status VW101 | Status VW101 | Status Buffers Buffers
VB100 | f | e | e | e | 0 | g | b | t | Control VB200 Receive buffer VB300 Transmit buffer
s VEE Station 2 Station 2
tatus
VB101 Number of . VB210 Receive buffer VB310 Transmit buffer
------------ Station 3 Station
VB102 cases packed E VB220 Receive buffer VB320 Transmit buffer
Station 4 Station 4
VB230 Receive buffer VB330 Transmit buffer
t  Out of butter tubs to pack; t=1, out of butter tubs Station 5 Station

b

Box supply is low; b=1, must add boxes in the

next 30 minutes

g

eee error code identifying the type of fault experienced
f Fault indicator; f=1, the case packer has detected an error

Gilue supply is low; g=1, must add glue in the next 30 minutes

Figure 6-6

Example of the Network Read and Network Write Instructions

Figure 6-7 shows the receive buffer (VB200) and transmit buffer (VB300) for accessing the data in
station 2. The S7-200 uses a Network Read instruction to read the control and status information

on a continuous basis from each of the case packers. Each time a case packer has packed 100

cases, the diverter notes this and sends a message to clear the status word using a Network Write

instruction.
Receive Buffer for reading from Transmit Buffer for clearing the count of
Case Packer #1 Case Packer #1
7 0
ve2o0 | D [A [ E [0 | ErrorCode ! °
| veaoo | D [A [E [0 [ ErrorCode
VB201 Remote station address = 2 "
- VB301 Remote station address = 2
VB202 Pointer to the -
VB302 Pointer to the
VB203 data area
- VB303 data area
VB204 in the -
VB205 Remote station = (&VB100) vBsos in the
— VB305 Remote station = (&VB101)
VB206 Data length = 3 bytes
VB306 Data length = 2 bytes
VB207 Control
VB307 0
VB208 Status (MSB)
VB308 0
VB209 Status (LSB)
Figure 6-7  Sample TBL Data for the Network Read/Write Example
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Example: Network Read and Network Write Instructions

Network 3
w2007

84

B30t

Metwork 1
aM0.1 WOV B
l
— | e Enof—
2dn_ outhsmezao
FILLN
BN ENof—)
i ouThvwizoo
Ba4n
Network 2
v200.7 Vw208 MOV
— | | =1} EN  ENO
+100
2 out
WMOV_DW
EN  ENO

EvB1014IM ouT

D302

MOY_B

EM EMNO

| 306

MO _A

EM EMNO

+041M ouT

RAAEI

METW
EM ENO

WB3004THL
04PORT

WEZOTAIM

MOV_8

p———en

EMNOD H

QUTEYB400

Network 1

LD
MOVB
FILL

Network 2

LD
AW=
MOVB
MOVD
MOVB
MOvVw
NETW

Network 3

LD
MOVB

//On the first scan, enable the
//PPI master mode
//and clear all receive and transmit buffers.

SMO.1
2, SMB30
+0, VW200, 68

//When the NETR Done bit (V200.7)
/lis set and 100 cases have been
/Ipacked:

/1. Load the station address of

1 case packer #1.

//2.  Load a pointer to the data in

Il the remote station.

//3.  Load the length of data to be
/l transmitted.

//4. Load the data to transmit.

//5.  Reset the number of cases packed
I by case packer #1

V200.7

VW208, +100

2, VB301
&VB101, VD302
2, VB306

+0, VW307
VB300, 0

//When the NETR Done bit is set,
//save the control data from
/Icase packer #1.

V200.7
VB207, VB400



S7-200 Instruction Set Chapter 6

Example: Network Read and Network Write Instructions , continued

Network 4 //If not the first scan and there are
Network 4 /Ino errors:
501 Y2006 v200.5 WMoY B /1. Load the station address of
! | 1} I 1} EN  ENO H /I case packer #1.
_| ! L L //2.  Load a pointer to the data in
24IN___ OUTFvB201 /l the remote station.
//3.  Load the length of data to
I be received.

MOY_Di //4. Read the control and status data
en  enol—) /| incase packer #1.
EVBT00-IM QUTRYD202 LDN SMO.1
AN V200.6
AN V200.5
D MOVB 2, VB201
EN  END % MOVD &VB100, VD202
MOVB 3, VB206
341N OUTFVBZ08 NETR VB200, 0
METR
BN ENof—)
WYH2Z00-THL

04FORT
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Transmit and Receive Instructions (Freeport)

The Transmit instruction (XMT) is used in Freeport mode to

- S SIMATIC f [EC 1121
transmit data by means of the communications port(s).
The Receive instruction (RCV) initiates or terminates the LAD FED
receive message function. You must specify a start and an HMT HMT
end condition for the Receive box to operate. Messages —EM EMG = | —{EM EMG =
received through the specified port (PORT) are stored in the | | | 7 TEL
data buffer (TBL). The first entry in the data buffer specifies drorT T FORT
the number of bytes received.
Error conditions that set ENO =0 HMT Ry
m 0006 (indirect address)
m 0009 (simultaneous Transmit/Receive on port 0) SINATIC
® 000B (simultaneous Transmit/Receive on port 1) STL
) ®MT  TEL,PORT
m Receive parameter error sets SM86.6 or SM186.6 RCY  TEL. PORT
m S7-200 CPU is not in Freeport mode

Table 6-12  Valid Operands for the Transmit and Receive Instructions

Inputs/Outputs Data Type Operands
TBL BYTE IB, QB, VB, MB, SMB, SB, *VD, *LD, *AC
PORT BYTE Constant for CPU 221, CPU 222, CPU 224: 0

for CPU 224XP, CPU 226: Oor1

For more information about using Freeport mode, see the section Creating User-Defined
Protocols with Freeport Mode on page 226 in Chapter 7.

Using Freeport Mode to Control the Serial Communications Port

You can select the Freeport mode to control the serial communications port of the S7-200 by
means of the user program. When you select Freeport mode, your program controls the operation
of the communications port through the use of the receive interrupts, the transmit interrupts, the
Transmit instruction, and the Receive instruction. The communications protocol is entirely
controlled by the ladder program while in Freeport mode. SMB30 (for port 0) and SMB130 (for port
1 if your S7-200 has two ports) are used to select the baud rate and parity.

The Freeport mode is disabled and normal communications are re-established (for example,
programming device access) when the S7-200 is in STOP mode.

In the simplest case, you can send a message to a printer or a display using only the Transmit
(XMT) instruction. Other examples include a connection to a bar code reader, a weighing scale,
and a welder. In each case, you must write your program to support the protocol that is used by
the device with which the S7-200 communicates while in Freeport mode.

Freeport communications are possible only when the S7-200 is in RUN mode. Enable the
Freeport mode by setting a value of 01 in the protocol select field of SMB30 (Port 0) or SMB130
(Port 1). While in Freeport mode, communications with the programming device are not possible.

Tip

Freeport mode can be controlled using special memory bit SM0.7, which reflects the current
position of the operating mode switch. When SMO0.7 is equal to 0, the switch is in TERM
position; when SMO0.7 = 1, the operating mode switch is in RUN position. If you enable Freeport
mode only when the switch is in RUN position, you can use the programming device to monitor
or control the S7-200 operation by changing the switch to any other position.
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Changing PPl Communications to Freeport Mode

SMB30 and SMB130 configure the communications ports, 0 and 1 respectively, for Freeport
operation and provide selection of baud rate, parity, and number of data bits. Figure 6-8 describes
the Freeport control byte. One stop bit is generated for all configurations.

MSB LsB
! 9 bbb: Freeport baud rate
|P|P|d|b|b|b|m|m| 000= 38,400 baud
SMB30 = Port 0 001 = 19,200 baud
SMB130 = Port 1 010 = 9,600 baud
011 = 4,800 baud
100 = 2,400 baud
pp: Parity select 101 = 1,200 baud ; .
00 = no parity 110=  115.2 kbaud’ Requires S7-200
01= even parity 111 = 57.6 kbaud! CPUs version 1.2
10= no parity mm: Protocol selection or later
1= odd parity 00 = PPI/slave mode
d: Data bits per character 01= Freeport protocol
0= 8 bits per character 10 = PPl/master mode
1= 7 bits per character 1= Reserved (defaults to PPI/slave mode)

Figure 6-8 SM Control Byte for Freeport Mode (SMB30 or SMB130)

Transmitting Data

The Transmit instruction lets you send a buffer of one or more characters, up to a maximum of
255.

Figure 6-9 shows the format of the
Transmit buffer.

Count M E S S A G E

. o | Characters of the message |
If an interrupt routine is attached to the L a

transmit compllete evenF, the S7-200 Number of bytes to transmit (byte field)
generates an interrupt (interrupt event 9
for port 0 and interrupt event 26 for port
1) after the last character of the buffer is
sent.

Figure 6-9  Format for the Transmit Buffer

You can make transmissions without using interrupts (for example, sending a message to a
printer) by monitoring SM4.5 or SM4.6 to signal when transmission is complete.

You can use the Transmit instruction to generate a BREAK condition by setting the number of
characters to zero and then executing the Transmit instruction. This generates a BREAK condition
on the line for 16-bit times at the current baud rate. Transmitting a BREAK is handled in the same
manner as transmitting any other message, in that a Transmit interrupt is generated when the
BREAK is complete and SM4.5 or SM4.6 signals the current status of the Transmit operation.

Receiving Data
The Receive instruction lets you receive a buffer of one or more characters, up to a maximum of
255.

End
Char

Start
Char

Figure 6-10 shows the format of the
Receive buffer.

Count |M|E|S|S|A|G|E|

. L \ Charact f the message |
If an interrupt routine is attached to the I

receive message complete event, the
S7-200 generates an interrupt (interrupt
event 23 for port 0 and interrupt event 24
for port 1) after the last character of the
buffer is received.

Number of bytes received (byte field)

Figure 6-10 Format for the Receive Buffer
You can receive messages without using interrupts by monitoring SMB86 (port 0) or SMB186

(port 1). This byte is non-zero when the Receive instruction is inactive or has been terminated. It is
zero when a receive is in progress.
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As shown in Table 6-13, the Receive instruction allows you to select the message start and
message end conditions, using SMB86 through SMB94 for port 0 and SMB186 through SMB194
for port 1.

Tip

@ The receive message function is automatically terminated in case of an overrun or a parity error.
You must define a start condition and an end condition (maximum character count) for the
receive message function to operate.

Table 6-13  Bytes of the Receive Buffer (SMB86 to SMB94, and SM1B86 to SMB194)

Port 0 Port 1 Description
SMB86 SMB186 Receive message M;Q'B L%B
status byte
[n]rlefofJoftfeler]
n: 1= Receive message function terminated: user issued
disable command.
r 1= Receive message function terminated: error in input
parameters or missing start or end condition.
e: 1= End character received.
t: 1= Receive message function terminated: timer expired.
c: 1= Receive message function terminated: maximum
character count achieved.
p 1= Receive message function terminated: a parity error.
SMB87 SMB187 Receive message M;Q'B L%B

control byte -
|en |sc |ec | il |c/m|tmr| bk| 0 |

en: 0 =Receive message function is disabled.
1 =Receive message function is enabled.
The enable/disable receive message bit is checked each time
the RCV instruction is executed.

sc: 0 =Ignore SMB88 or SMB188.

1 =Use the value of SMB88 or SMB188 to detect start of message.
ec: 0 =Ignore SMB89 or SMB189.

1 =Use the value of SMB89 or SMB189 to detect end of message.
il 0=Ignore SMW90 or SMW190.

1 =Use the value of SMW90 or SMW190 to detect an idle line condition.
¢/m: 0 =Timer is an inter-character timer.

1 =Timer is a message timer.
tmr: 0 =Ignore SMW92 or SMW192.

1 =Terminate receive if the time period in SMW92 or

SMW192 is exceeded.

bk: 0 =Ignore break conditions.

1 =Use break condition as start of message detection.

SMB88 SMB188 Start of message character.
SMB89 SMB189 End of message character.
SMW90 SMW190 Idle line time period given in milliseconds. The first character received after idle

line time has expired is the start of a new message.

SMw92 SMw192 Inter-character/message timer time-out value given in milliseconds. If the time
period is exceeded, the receive message function is terminated.

SMB94 SMB194 Maximum number of characters to be received (1 to 255 bytes). This range must
be set to the expected maximum buffer size, even if the character count
message termination is not used.
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%

Start and End Conditions for the Receive Instruction

The Receive instruction uses the bits of the receive message control byte (SMB87 or SMB187) to
define the message start and end conditions.

Tip

If there is traffic present on the communications port from other devices when the Receive
instruction is executed, the receive message function could begin receiving a character in the
middle of that character, resulting in a possible parity error and termination of the receive
message function. If parity is not enabled the received message could contain incorrect
characters. This situation can occur when the start condition is specified to be a specific start
character or any character, as described in item 2. and item 6. below.

The Receive instruction supports several message start conditions. Specifying a start condition
involving a break or an idle line detection avoids this problem by forcing the receive message
function to synchronize the start of the message with the start of a character before placing
characters into the message buffer.

The Receive instruction supports several start conditions:

1. Idle line detection: The idle line condition is defined as a quiet or idle time on the
transmission line. A receive is started when the communications line has been quiet or idle
for the number of milliseconds specified in SMW90 or SMW190. When the Receive
instruction in your program is executed, the receive message function initiates a search for
an idle line condition. If any characters are received before the idle line time expires, the
receive message function ignores those characters and restarts the idle line timer with the
time from SMW90 or SMW190. See Figure 6-11. After the idle line time expires, the receive
message function stores all subsequent characters received in the message buffer.

The idle line time should always be greater than the time to transmit one character (start bit,
data bits, parity and stop bits) at the specified baud rate. A typical value for the idle line time
is three character times at the specified baud rate.

You use idle line detection as a start condition for binary protocols, protocols where there is
not a particular start character, or when the protocol specifies a minimum time between

messages.
Setup: il=1,sc =0, bk =0, SMW90/SMW190 = idle line timeout in milliseconds
Characters Characters
A A
Restarts the idle time First character placed in the
message buffer
Receive instruction is executed: Idle time is detected:
starts the idle time starts the Receive Message function

Figure 6-11  Using Idle Time Detection to Start the Receive Instruction

2. Start character detection: The start character is any character which is used as the first
character of a message. A message is started when the start character specified in SMB88
or SMB188 is received. The receive message function stores the start character in the
receive buffer as the first character of the message. The receive message function ignores
any characters that are received before the start character. The start character and all
characters received after the start character are stored in the message buffer.

Typically, you use start character detection for ASCII protocols in which all messages start
with the same character.

Setup: il=0,sc =1, bk =0, SMW90/SMW190 = don’t care, SMB88/SMB188 = start
character
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Idle line and start character: The Receive instruction can start a message with the
combination of an idle line and a start character. When the Receive instruction is executed,
the receive message function searches for an idle line condition. After finding the idle line
condition, the receive message function looks for the specified start character. If any
character but the start character is received, the receive message function restarts the
search for an idle line condition. All characters received before the idle line condition has
been satisfied and before the start character has been received are ignored. The start
character is placed in the message buffer along with all subsequent characters.

The idle line time should always be greater than the time to transmit one character (start bit,
data bits, parity and stop bits) at the specified baud rate. A typical value for the idle line time
is three character times at the specified baud rate.

Typically, you use this type of start condition when there is a protocol that specifies a
minimum time between messages, and the first character of the message is an address or
something which specifies a particular device. This is most useful when implementing a
protocol where there are multiple devices on the communications link. In this case the
Receive instruction triggers an interrupt only when a message is received for the specific
address or devices specified by the start character.

Setup: il=1,sc =1, bk=0, SMW90/SMW190 > 0, SMB88/SMB188 = start
character

Break detection: A break is indicated when the received data is held to a zero value for a
time greater than a full character transmission time. A full character transmission time is
defined as the total time of the start, data, parity and stop bits. If the Receive instruction is
configured to start a message on receiving a break condition, any characters received after
the break condition are placed in the message buffer. Any characters received before the
break condition are ignored.

Typically, you use break detection as a start condition only when a protocol requires it.

Setup: il=0,sc=0,bk=1, SMW90/SMW190 = don’t care, SMB88/SMB188 =
don’t care

Break and a start character: The Receive instruction can be configured to start receiving
characters after receiving a break condition, and then a specific start character, in that
sequence. After the break condition, the receive message function looks for the specified
start character. If any character but the start character is received, the receive message
function restarts the search for an break condition. All characters received before the break
condition has been satisfied and before the start character has been received are ignored.
The start character is placed in the message buffer along with all subsequent characters.

Setup: il=0,sc=1,bk=1, SMW90/SMW190 = don't care,
SMB88/SMB188 = start character

Any character: The Receive instruction can be configured to immediately start receiving any
and all characters and placing them in the message buffer. This is a special case of the idle
line detection. In this case the idle line time (SMW90 or SMW190) is set to zero. This forces
the Receive instruction to begin receiving characters immediately upon execution.

Setup: il=1,sc =0, bk =0, SMW90/SMW190 = 0, SMB88/SMB188 = don’t care

Starting a message on any character allows the message timer to be used to time out the
receiving of a message. This is useful in cases where Freeport is used to implement the
master or host portion of a protocol and there is a need to time out if no response is
received from a slave device within a specified amount of time. The message timer starts
when the Receive instruction executes because the idle line time was set to zero. The
message timer times out and terminates the receive message function if no other end
condition is satisfied.

Setup: il=1,sc =0, bk =0, SMW90/SMW190 = 0, SMB88/SMB188 = don’t care
¢/m =1, tmr = 1, SMW92 = message timeout in milliseconds
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The Receive instruction supports several ways to terminate a message. The message can be
terminated on one or a combination of the following:

1.

End character detection: The end character is any character which is used to denote the
end of the message. After finding the start condition, the Receive instruction checks each
character received to see if it matches the end character. When the end character is
received, it is placed in the message buffer and the receive is terminated.

Typically, you use end character detection with ASCII protocols where every message ends
with a specific character. You can use end character detection in combination with the
intercharacter timer, the message timer or the maximum character count to terminate a
message.

Setup: ec =1, SMB89/SMB189 = end character

Intercharacter timer: The intercharacter time is the time measured from the end of one
character (the stop bit) to the end of the next character (the stop bit). If the time between
characters (including the second character) exceeds the number of milliseconds specified
in SMW92 or SMW192, the receive message function is terminated. The intercharacter
timer is restarted on each character received. See Figure 6-12.

You can use the intercharacter timer to terminate a message for protocols which do not
have a specific end-of-message character. This timer must be set to a value greater than
one character time at the selected baud rate since this timer always includes the time to
receive one entire character (start bit, data bits, parity and stop bits).

You can use the intercharacter timer in combination with the end character detection and
the maximum character count to terminate a message.

Setup: c¢/m =0, tmr =1, SMW92/SMW192 = timeout in milliseconds

]

Characters Characters
‘ 1
Restarts the intercharacter The intercharacter timer expires:
timer Terminates the message and generates the

Receive Message interrupt

Figure 6-12  Using the Intercharacter Timer to Terminate the Receive Instruction

Message timer: The message timer terminates a message at a specified time after the start
of the message. The message timer starts as soon as the start condition(s) for the receive
message function have been met. The message timer expires when the number of
milliseconds specified in SMW92 or SMW192 have passed. See Figure 6-13.

Typically, you use a message timer when the communications devices cannot guarantee
that there will not be time gaps between characters or when operating over modems. For
modems, you can use a message timer to specify a maximum time allowed to receive the
message after the message has started. A typical value for a message timer would be
about 1.5 times the time required to receive the longest possible message at the selected
baud rate.

You can use the message timer in combination with the end character detection and the
maximum character count to terminate a message.

Setup: c¢/m =1, tmr=1, SMW92/SMW192 = timeout in milliseconds
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Characters Characters

‘ 1

Start of the message: The message timer expires:

Starts the message timer Terminates the message and generates the
Receive Message interrupt

Figure 6-13  Using the Message Timer to Terminate the Receive Instruction

4. Maximum character count: The Receive instruction must be told the maximum number of
characters to receive (SMB94 or SMB194). When this value is met or exceeded, the receive
message function is terminated. The Receive instruction requires that the user specify a
maximum character count even if this is not specifically used as a terminating condition.
This is because the Receive instruction needs to know the maximum size of the receive
message so that user data placed after the message buffer is not overwritten.

The maximum character count can be used to terminate messages for protocols where the
message length is known and always the same. The maximum character count is always
used in combination with the end character detection, intercharacter timer, or message
timer.

5. Parity errors: The Receive instruction is automatically terminated when the hardware
signals a parity error on a received character. Parity errors are only possible if parity is
enabled in SMB30 or SMB130. There is no way to disable this function.

6. User termination: The user program can terminate a receive message function by executing
another Receive instruction with the enable bit (EN) in SMB87 or SMB187 set to zero. This
immediately terminates the receive message function.

Using Character Interrupt Control to Receive Data

To allow complete flexibility in protocol support, you can also receive data using character interrupt
control. Each character received generates an interrupt. The received character is placed in
SMB2, and the parity status (if enabled) is placed in SM3.0 just prior to execution of the interrupt
routine attached to the receive character event. SMB2 is the Freeport receive character buffer.
Each character received while in Freeport mode is placed in this location for easy access from the
user program. SMB3 is used for Freeport mode and contains a parity error bit that is turned on
when a parity error is detected on a received character. All other bits of the byte are reserved. Use
the parity bit either to discard the message or to generate a negative acknowledgement to the
message.

When the character interrupt is used at high baud rates (38.4 kbaud to 115.2 kbaud), the time
between interrupts is very short. For example, the character interrupt for 38.4 kbaud is

260 microseconds, for 57.6 kbaud is 173 microseconds, and for 115.2 kbaud is 86 microseconds.
Ensure that you keep the interrupt routines very short to avoid missing characters, or else use the
Receive instruction.

Tip

SMB2 and SMB3 are shared between Port 0 and Port 1. When the reception of a character on
Port O results in the execution of the interrupt routine attached to that event (interrupt event 8),
SMB2 contains the character received on Port 0, and SMBS3 contains the parity status of that
character. When the reception of a character on Port 1 results in the execution of the interrupt
routine attached to that event (interrupt event 25), SMB2 contains the character received on
Port 1 and SMB3 contains the parity status of that character.
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Example: Transmit and Receive Instructions

M
A
|
N

_|

Network 1
SM0.1

—

[ SmMBa0

-

FSMBaT

4

FSMBag

—

F SnyEn

MOV_B
EN  ENO
16#084IN___ OUT
MOV_B
EN  ENO
1648041 QUT
MOY_B
EN  ENO
16#0A4IN___ OUT
MOV_W
EN  ENO
+54IN_ oUT
MOV_B
EN  ENO
10041

4

¥l OUTFSMBA4

INT_0-
234

ATCH
EM  ENO

=
5

EVNT

INT_2 4
'

ATCH
EM  ENO

EVINT

—{( emi)

WE100

RCY
EM  ENO

TBL
PORT

-

Network 1

LD
MOVB

MOVB

MOVB

MOvVwW

MOVB

ATCH

ATCH

ENI

RCV

/[This program receives a string of characters
/until a line feed character is received.

/[The message is then transmitted back

/fto the sender.

SMO0.1 //On the first scan:

16#09, SMB30 //1. Initialize Freeport:
/I - Select 9600 baud.
/| - Select 8 data bits.
/I - Select no parity.

16#B0, SMB87 //2. Initialize RCV message control byte:

/- RCV enabled.

/- Detect end of message character.
/- Detect idle line condition
1 as the message start condition.

16#0A, SMB89 //3. Set end of message character
/| tohex OA (line feed).

+5, SMW90 //4. Set idle line timeout
//  to5ms.

100, SMB94 //5.  Set maximum number of characters
/l  to100.

INT_O, 23 //6. Attach interrupt O
/I to the Receive Complete event.

INT_2,9 /[7. Attach interrupt 2
/| to the Transmit Complete event.

//8.  Enable user interrupts.

VB100, 0 //9. Enable receive box with
Il buffer at VB100.
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Example: Transmit and Receive Instructions, continued

94

| Network 1 Network 1 //[Receive complete interrupt routine:
N SMBBE MoV B /1. If receive status shows receive of
T -6l EN  ENO ) /I end character, then attach a
0 16#2'0 /I 10 ms timer to trigger a transmit and return.
10dm ouTksmEza //2. If the receive completed for any other reason,
/| then start a new receive.
LDB= SMB86, 16#20
ATCH MOVB 10, SMB34
EN  ENoF—|  ATCH  INT 1,10
CRETI
INT_14INT NOT
T04EYNT RCV VB100, 0
—(RETI)
RCW
—not—en  enol—)
wB1004TBL
D4PORT
I Metwork 1 Network 1 //10-ms Timer interrupt:
N sMO0 OTon /1. Detach timer interrupt.
1 . i .
T _| | EN  ENO %' //2. Transmit message back to user on port
1 LD SM0.0
104EVNT DTCH 10
XMT VB100, 0
HMT
EN  ENO—)
wB1004TBL
04PORT
| Network 1 Network 1 /[Transmit Complete interrupt:
N SMO.0 ETen /[Enable another receive.
T4 b———m =o— WD SM0.0
2 RCV  VB100,0
wB1004TBL
D4PORT
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Get Port Address and Set Port Address Instructions

The Get Port Address instruction (GPA) reads the station

address of the S7-200 CPU port specified in PORT and SIMATIC £ (ECTTST

places the value in the address specified in ADDR. LAD FED
The Set Port Address instruction (SPA) sets the port station GET_ADDR GET_ADDR
address (PORT) to the value specified in ADDR. The new | EM EMG = | —EM BRI =
address is not saved permanently. After a power cycle, the dioor ] Egﬂ
affected port returns to the last address (the one that was JdpoRT
downloaded with the system block).
Error conditions that set ENO = 0: AULRIBE: S hlel:
m 0006 (indirect address)
m 0004 (attempted to perform a Set Port Address instruction in an SIMATI
interrupt routine)
STL
GPA  ADDR, PORT
SPA  ADDR, PORT

Table 6-14  Valid Operands for the Get Port Address and Set Port Address Instructions

Inputs/Outputs Data Type Operands
ADDR BYTE IB, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant

(A constant value is valid only for the Set Port Address instruction.)
PORT BYTE Constant for CPU 221, CPU 222, CPU 224: 0

for CPU 224XP, CPU 226: Oor1
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Compare Instructions

Comparing Numerical Values P ] EC 1131

The compare instructions are used to compare two values:

IN1 =IN2 IN1 >=IN2

IN1 > IN2 IN1 < IN2

Compare Byte operations are unsigned.
Compare Integer operations are signed.

LAD FED

IN1 <= IN2 i
IN1 <> IN2 —=sf | ]

<= <= == =R

Compare Double Word operations are signed. #=B ==l ==D ==R
Compare Real operations are signed. <=k a=l  ==D =R
=k =| =0 =R

For LAD and FBD: When the comparison is true, the < <k <R

Compare instruction turns on the contact (LAD) or output

(FBD)- SimATIC  TEC 1131

For STL: When the comparison is true, the Compare LA FED:

instruction Loads, ANDs, or ORs a 1 with the value on the

top of the stack (STL). B 1 =
—{EM ouT

When you use the IEC compare instructions, you can use i

various data types for the inputs. However, both input A inz

values must be of the same data type.

Notice

E@ ME GE LE aoT LT

SIMATIC
The following conditions are fatal errors and cause your
S7-200 to immediately stop the execution of your STL
roqram: LDE= M1, IMZ
program: AB= IN1,IM2
m |llegal indirect address is encountered (any Compare OB= N1, IN2
instruction) LDE=  LOW= LOD= LDR=
. == = = ==
m |llegal real number (for example, NAN) is encountered tgg} tgﬁ} tgg} tgﬁ}

(Compare Real instruction)

LDE== LDW-== LDD== LDR=<=
LDB== LDW-== LDD== LDR==

To prevent these conditions from occurring, ensure that LDE>= LDWs= LDD== LDR>=
you properly initialize pointers and values that contain real AR= A= A= AR=
numbers before executing compare instructions that use AE-< A= AL AR

these values.

AE>  AW>  AD>  AR-
fE<> A< AD<+  AR<=

Compare instructions are executed regardless of the state AB<=  AW== AD== HAR<=

of power flow.

AE== A== A== AR==

B= o= b= =
B el etk el
OB= el O R
OB OW-== QD<= OR<=
OB== OWe= OD== OR==
OB== OWe= ODe= ORE=

Table 6-15  Valid Operands for the Compare Instructions

Inputs/Outputs Type

Operands

IN1, IN2 BYTE
INT

DINT
REAL

Output (or OUT) BOOL

96

IB, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant

W, QW, VW, MW, SMW, SW, T, C, LW, AC, AIW, *VD, *LD, *AC,
Constant

ID, QD, VD, MD, SMD, SD, LD, AC, HC, *VD, *LD, *AC, Constant
ID, QD, VD, MD, SMD, SD, LD, AC, *VD, *LD, *AC, Constant
1,Q,V,M, SM, S, T, C, L, Power Flow
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Example: Compare Instructions

Hetwork 1

0.0 SmB2a Qn.0
()

SMB2E Q01

()

140

Network 2

0.1 MOV_
I EN  ENO

-300004IM QuT

AN

MO DAY
EM  ENO

-20000000041M QuT

VD2

Mov_R
EM  ENO

1.012E-0064IM QUT

FvDE

Network 3

0.2 MOV_
I EM  ENO

+30000+4

I QUT

[ AND

O _ Dy
EM  ENO

-1000000004

I QUT

FvD2

MY_R
EM  ENO

2141593

I QUT

FvDE

Hetwork 4
0.3 WIND
— ()
+10000

-150000000 Qo3

5.001E-006

Network 1

LD
LPS
AB<=

LPP
AB>=

Network 2

LD
MOvVw
MOVD
MOVR

Network 3

LD
MOvw
MOVD
MOVR

Network 4

LD
LPS
AW>

LRD
AD<

LPP
AR>

/[Turn analog adjustment potentiometer O

/to vary the SMB28 byte value.

//Q0.0 is active when the SMB28 value
/fis less than or equal to 50.

//Q0.1 is active when the SMB28 value
/lis greater than or equal to 150.

/[The status indicator is on when

/[the comparison is true.

10.0

SMB28, 50
Q0.0

SMB28, 150
Q0.1

//Load V memory addresses with

//low values that make the comparisons
/ffalse and that turn

/[the status indicators off.

10.1

-30000, VWO
-200000000, VD2
1.012E-006, VD6

//Load V memory addresses with
//high values that make the
//lcomparisons true and that turn
/[the status indicators on.

10.2

+30000, VWO
-100000000, VD2
3.141593, VD6

/[The Integer Word comparison tests
/fto find if VWO > +10000 is true.
//Uses program constants to show the
// different data types. You can also
//lcompare two values

/[stored in programmable memory
/like: VWO > VW100

10.3

VWO, +10000
Qo0.2

-150000000, VD2
Q0.3

VD6, 5.001E-006
Q0.4
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Compare String

The Compare String instruction compares two strings of
ASCII characters:

IN1 = IN2 INT <> IN2

When the comparison is true, the Compare instruction turns
the contact (LAD) or output (FBD) on, or the compare
instruction Loads, ANDs or ORs a 1 with the value on the
top of the stack (STL).

Notice

The following conditions are fatal errors and cause your
S7-200 to immediately stop the execution of your
program:

m |llegal indirect address is encountered (any compare
instruction)

m A string with a length greater than 254 characters is
encountered (Compare String instruction)

m A string whose starting address and length are such
that it will not fit in the specified memory area
(Compare String instruction)

To prevent these conditions from occurring, ensure that
you properly initialize pointers and memory locations that
are intended to hold ASCII strings prior to executing
compare instructions that use these values. Ensure that
the buffer reserved for an ASCII string can reside
completely within the specified memory area.

Compare instructions are executed regardless of the state
of power flow.

Table 6-16  Valid Operands for the Compare String Instructions

IIEC1131]

SIMATIC
LAD " FED
_|==5|_ 1 = B
[
== ==5
SIMATIC IEC1131]
LAD FED
EQ S 1 EQS »
—EM QUTE || T
=M1
— Mz
EQ_S ME_S
SIMATIC
sTL
LDS= M1, M2
AS= 1M1, M2
%= M1, M2
LO5== M1, M2
AS=> M1, IM2
Q5= M1, M2

Inputs/Outputs Type Operands

IN1 STRING VB, LB, *VD, *LD, *AC, constant

IN2 STRING VB, LB, *VD, *LD, *AC

Output (OUT) BOOL 1,Q,V,M, SM, S, T, C, L, Power Flow
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Conversion Instructions

Standard Conversion Instructions stonmic | ec 1131
Numerical Conversions e =
The Byte to Integer (BTI), Integer to Byte (ITB), Integer to E_I E_I
Double Integer (ITD), Double Integer to Integer (DTI), e o b | e e
Double Integer to Real (DTR), BCD to Integer (BCDI) and i olUT
Integer to BCD (IBCD) instructions convert an input value IN o L ouT =
to the specified format and stores the output value in the
memory location specified by OUT. For example, you can B_I BCD_I
convert a double integer value to a real number. You can I-E I BD
also convert between integer and BCD formats. I[§|D: ﬁ'gb'r':g
Round and Truncate LIk sEq
The Round instruction (ROUND) converts a real value IN to
a double integer value and places the rounded result into cATIc  [EC 1131
the variable specified by OUT.
) ) LAD FEL:
The Truncate instruction (TRUNC) converts a real number ETo ] ETo ]
IN into a double integer and places the whole-number din ~ el | din ol
portion of the result into the variable specified by OUT. Ji AUT
M ouT
Segment
The Segment instruction (SEG) allows you to generate a bit BTo| T
pattern that illuminates the segments of a seven-segment e e
display. I_Te_Dl TRUMC
) LI_To_| SEG
LI_TO_R
R_To_DI
SIMATIC
STL
BTl IN.oUT  BCDI oUT
ITE  M.2UT  |gp @UT
T M, 2UT  TRUMC M, QUT
CTI I, 9UT  ROUMD M, QUT
DTR IM,OUT  SEG M, CUT

Table 6-17  Valid Operands for the Standard Conversion Instructions

Inputs/Outputs Data Type Operands

IN BYTE IB, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant
WORD, INT | IW, QW, VW, MW, SMW, SW, T, C, LW, AIW, AC, *VD, *LD, *AC, Constant
DINT ID, QD, VD, MD, SMD, SD, LD, HC, AC, *VD, *LD, *AC, Constant
REAL ID, QD, VD, MD, SMD, SD, LD, AC, *VD, *LD, *AC, Constant

ouT BYTE IB, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC

WORD, INT | IW, QW, VW, MW, SMW, SW, T, C, LW, AC, *VD, *LD, *AC
DINT, REAL | ID, QD, VD, MD, SMD, SD, LD, AC, *VD, *LD, *AC
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Operation of the BCD to Integer and Integer to BCD Instructions

The BCD to Integer instruction (BCDI) converts the Error conditions that set ENO =0
binary-coded decimal value IN to an integer value and loads m SM1.6 (invalid BCD)

the result into the variable specified by OUT. The valid range -

for IN is O to 9999 BCD. m 0006 (indirect address)

The Integer to BCD instruction (IBCD) converts the input
integer value IN to a binary-coded decimal and loads the
result into the variable specified by OUT. The valid range for
IN is 0 to 9999 integer.

SM bits affected:
m SM1.6 (invalid BCD)

Operation of the Double Integer to Real Instruction

The Double Integer to Real instruction (DTR) converts a Error conditions that set ENO =0
32-bit, signed integer IN into a 32-bit real number and places = 0006 (indirect address)
the result into the variable specified by OUT.

Operation of the Double Integer to Integer Instruction

The Double Integer to Integer instruction (DTI) converts the  Error conditions that set ENO = 0
double integer value IN to an integer value and places the = SM1.1 (overflow)
result into the variable specified by OUT. = 0006 (indirect address)

If the value that you are converting is too large to be
represented in the output, then the overflow bit is set and the
output is not affected.

SM bits affected:
= SM1.1 (overflow)

Operation of the Integer to Double Integer Instruction

The Integer to Double Integer instruction (ITD) converts the  Error conditions that set ENO = 0
integer value IN to a double integer value and places the m 0006 (indirect address)

result into the variable specified by OUT. The sign is

extended.

Operation of the Byte to Integer Instruction

The Byte to Integer instruction (BTI) converts the byte value  Error conditions that set ENO = 0
IN to an integer value and places the result into the variable = 0006 (indirect address)
specified by OUT. The byte is unsigned, therefore there is

no sign extension.

Operation of the Integer to Byte Instruction

The Integer to Byte instruction (ITB) converts the word value Error conditions that set ENO = 0
IN to a byte value and places the result into the variable m SMi1.1 (overflow)
specified by OUT. Values 0 to 255 are converted. All other = 0006 (indirect address)
values result in overflow and the output is not affected.
SM bits affected:

= SM1.1 (overflow)

Tip
@ To change an integer to a real number, use the Integer to Double Integer instruction and then
use the Double Integer to Real instruction.
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Operation of the Round and Truncate Instructions

The Round instruction (ROUND) converts the real-number  Error conditions that set ENO = 0
value IN to a double integer value and places the resultinto = SM1.1 (overflow)
the variable specified by OUT. If the fraction portion is 0.5 or

greater, the number is rounded up. = (0006 (indirect address)

The Truncate instruction (TRUNC) converts a real-number ~ SM bits affected:
value IN into a double integer and places the result into the = SM1.1 (overflow)
variable specified by OUT. Only the whole number portion of

the real number is converted, and the fraction is discarded.

If the value that you are converting is not a valid real number or is too large to be represented in
the output, then the overflow bit is set and the output is not affected.

Example: Standard Conversion Instructions

Network 1 Network 1 /[Convert inches to centimeters:
0o oI /[1. Load a counter value (inches) into AC1.
1 EN - END ;l /2. Convert the value to a real number.
_| | //3. Multiply by 2.54 (convert to centimeters).
/l4. Convert the value back to an integer.
1041 OUTEACT LD 10.0
ITD C10, ACH
DTR AC1, VDO
DI_R MOVR VDO, VD8
EM END ﬁ *R VD4, VD8
ROUND VD8, VD12
ACTAIM OUTEDO
Network 2 //Convert a BCD value to an integer
LD 10.3
WMUL R BCDI ACO
EN  ENo|—)
WOO4IN1T  OUTEYDE
WA IM2
ROUND
EN  ENOF—)
WOEAIM OUTEFD12
Network 2
0.3 BCO_|
—| |7 EN  ENO %
ACOAIM OUTFACD
Double Word Integer to Real and Round BCD to Integer
C10 Count = 101 inches ACO
VDO 101.0 | Count (as a real number) BCDI
VD4 2.54 constant (inches to centimeters) ACO
VD8 256.54 | 256.54 centimeters as real number
VD12 257 | 257 centimeters as double integer
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Operation of the Segment Instruction

To illuminate the segments of a seven-segment display, the Segment instruction (SEG) converts
the character (byte) specified by IN to generate a bit pattern (byte) at the location specified by
OUT.

The illuminated segments represent the character in the Error conditions that set ENO =0
least significant digit of the input byte. Figure 6-14 shows the = 0006 (indirect address)
seven-segment display coding used by the Segment

instruction.
(IN) | Segment (OUT) (IN) Segment (OUT)
LSD | Display -gfe dcba LSD Display | -gfe dcba
0 i 0011 1111 8 - 0111 1111
1 : 0000 0110 g 9 o 0110 0111
2 2 0101 1011 flglb A A 0111 0111
3 - 0100 1111 el_lc B - 0111 1100
4 - 0110 0110 —_ c D 0011 1001
5 5 0110 1101 - D - 0101 1110
6 - 0111 1101 E - 0111 1001
7 o 0000 0111 F - 0111 0001
Figure 6-14  Coding for a Seven-Segment Display
Example: Segment Instruction
Network 1 Network 1 SEG
1.0 5EG LD